# Table of contents

1 Getting started .................................................................................................................................................................................. 4
   1.1 What is a wiki? ........................................................................................................................................................................ 6
   1.2 Login ....................................................................................................................................................................................... 8
   1.3 User profile ............................................................................................................................................................................ 9
   1.4 BlueSpice layout ............................................................................................................................................................... 11
2 Personalization ............................................................................................................................................................................. 31
   2.1 User preferences ................................................................................................................................................................. 31
   2.2 Privacy center ...................................................................................................................................................................... 45
   2.3 Personal navigation ............................................................................................................................................................. 51
3 Concepts ....................................................................................................................................................................................... 57
   3.1 Pages .................................................................................................................................................................................... 57
   3.2 Namespaces .......................................................................................................................................................................... 60
   3.3 Wikitext .................................................................................................................................................................................. 65
   3.4 Magic words .......................................................................................................................................................................... 69
4 Structuring content ......................................................................................................................................................................... 73
   4.1 Categories ............................................................................................................................................................................. 76
   4.2 Subpages ............................................................................................................................................................................... 80
   4.3 Templates ............................................................................................................................................................................... 84
      4.3.1 Infobox ........................................................................................................................................................................ 87
      4.3.2 Translate ....................................................................................................................................................................... 93
   4.4 Page templates .................................................................................................................................................................... 95
5 Working with pages ........................................................................................................................................................................... 105
   5.1 Create a page ....................................................................................................................................................................... 105
   5.2 Edit a page ........................................................................................................................................................................... 111
   5.3 Rename/move a page .......................................................................................................................................................... 115
   5.4 Delete a page ....................................................................................................................................................................... 121
   5.5 Link files and pages .......................................................................................................................................................... 124
      5.5.1 Interwiki links ............................................................................................................................................................ 130
   5.6 VisualEditor ......................................................................................................................................................................... 134
      5.6.1 Images ........................................................................................................................................................................ 142
      5.6.2 Files .............................................................................................................................................................................. 150
      5.6.3 Tables ........................................................................................................................................................................ 155
      5.6.4 Embed video ............................................................................................................................................................. 160
      5.6.5 Hide page title .......................................................................................................................................................... 168
   5.7 Tag cloud ............................................................................................................................................................................... 171
   5.8 Diagrams ............................................................................................................................................................................... 176
   5.9 Visual version comparison .................................................................................................................................................. 180
   5.10 PDF export ......................................................................................................................................................................... 181
6 Books ............................................................................................................................................................................................ 189
7 Quality assurance ............................................................................................................................................................................ 202
   7.1 Page information ............................................................................................................................................................... 210
   7.2 Page assignments ............................................................................................................................................................... 213
   7.3 Reminders ............................................................................................................................................................................... 217
   7.4 Review workflows ............................................................................................................................................................ 221
   7.5 Expiry ................................................................................................................................................................................... 223
   7.6 Acceptance .......................................................................................................................................................................... 227
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.7</td>
<td>Category check</td>
<td>237</td>
</tr>
<tr>
<td>7.8</td>
<td>Read confirmation</td>
<td>240</td>
</tr>
<tr>
<td>7.9</td>
<td>Page signatures</td>
<td>244</td>
</tr>
<tr>
<td>7.10</td>
<td>Watchlist</td>
<td>247</td>
</tr>
<tr>
<td>7.11</td>
<td>QR Codes</td>
<td>253</td>
</tr>
<tr>
<td>8</td>
<td>Maintenance</td>
<td>254</td>
</tr>
<tr>
<td>8.1</td>
<td>Special pages</td>
<td>257</td>
</tr>
<tr>
<td>8.2</td>
<td>Redirects</td>
<td>258</td>
</tr>
<tr>
<td>8.3</td>
<td>WikiExplorer</td>
<td>263</td>
</tr>
<tr>
<td>9</td>
<td>Social wiki</td>
<td>272</td>
</tr>
<tr>
<td>9.1</td>
<td>Overview</td>
<td>272</td>
</tr>
<tr>
<td>9.2</td>
<td>Blog</td>
<td>277</td>
</tr>
<tr>
<td>9.3</td>
<td>Microblog</td>
<td>287</td>
</tr>
<tr>
<td>9.4</td>
<td>Attachments</td>
<td>289</td>
</tr>
<tr>
<td>9.5</td>
<td>Page ratings</td>
<td>294</td>
</tr>
<tr>
<td>9.6</td>
<td>Track user actions</td>
<td>297</td>
</tr>
<tr>
<td>10</td>
<td>Search</td>
<td>311</td>
</tr>
<tr>
<td>10.1</td>
<td>Extended search</td>
<td>311</td>
</tr>
<tr>
<td>10.2</td>
<td>Inline search</td>
<td>321</td>
</tr>
<tr>
<td>11</td>
<td>Appendix A: Extensions</td>
<td>324</td>
</tr>
<tr>
<td>12</td>
<td>Appendix B: Tags</td>
<td>326</td>
</tr>
</tbody>
</table>
1 Getting started

More than just a wiki

Your BlueSpice wiki is based on MediaWiki, the software that also runs the Wikipedia online encyclopedia. Just like Wikipedia, BlueSpice empowers people to share and find information quickly and efficiently. In addition to the typical and robust collaboration features of MediaWiki, BlueSpice includes important quality management and maintenance tools that enable large and small companies and organizations to use the wiki for a variety of important business functions. As a flexible knowledge base and documentation platform, your wiki will support your efforts to collaboratively grow and distribute all information that is important to you.

What this user manual covers

The MediaWiki community has written extensive support documentation. A lot of the questions you have around using your wiki's features are answered right at mediawiki.org. This user manual focuses mainly on the functionality that is part of the BlueSpice distribution of the MediaWiki software and on important concepts that you need for making decisions around organizing and managing your content.

Who should read this user manual?

The audience for this user manual are mainly wiki maintainers, also known as "wiki gardeners". These are the users who are responsible for ensuring that the quality of the content and the ease of use meet the expectations of both their users and their wiki owners. These users usually have reviewer rights in the wiki, but are not registered as system administrators.

Since anyone who contributes to the wiki can also see the most important wiki reports, wiki editors are also invited to read this user manual. With that in mind, we included some information that focuses on the editing process, such as working with wiki pages.

Questions?

If you have questions that go beyond the information in the user manual, you can join the BlueSpice community at sourceforge.net.
1.1 What is a wiki?

The idea

A wiki is a web-based tool that allows people to easily add, modify, or delete the content of a web page simply by using a web browser.

Wikiwiki is Hawaiian and means quick. It describes the idea of creating and sharing content easily and, obviously, very quickly.

In public wikis such as Wikipedia, visitors don’t even need a user account to make changes to a page that other people have created or edited before. Have you ever updated a Wikipedia page yourself? You should definitely try!

Wikis use specialized wiki software and are often created in a very collaborative environment. The content is typically non-linear. In order to find relevant information, a powerful search function becomes very important. There are, however, many ways to organize a wiki so that users can navigate to content without relying only on the search function of their wiki.

History

The first wiki (named WikiWikiWeb) was invented by Ward Cunningham in 1995.

Cunningham became impatient with existing text processing programs and was looking for a new documentation system that was adapted to fit the needs of programmers. He wanted to develop a simple software that would allow programmers to work collaboratively on source code and to publish it immediately. Also, the new program should document all editing steps automatically to track all changes that have been made. In the end, the first wiki was put online and is still working.

Wikis are for good reasons a popular technology to this day and have become very mature and feature-rich. They are a great tool for collaborating on information of any kind.

Basic functions

Editing: Every wiki page has a clearly visible editing link or button. This should encourage page visitors to immediately contribute to the content if information is missing or simply wrong. Companies should be careful when limiting the edit options on a page – they will surely miss out on important knowledge transfer opportunities.

Linking: To make it easy for users to find related information, it is very easy to insert links anywhere in the wiki, even to a page that does not yet exist!
**History:** With the history function, it is possible to trace every change that anyone has ever made to a page. Losing versions of important content is a thing of the past.

**Recent changes:** All recent changes in the entire wiki are clearly visible. Nobody wastes any time looking for the most important and most up-to-date information.

**Examples for public wikis**

There are large and small wiki communities that use MediaWiki to collaborate. Some examples of public wikis:

- **Wikipedia:** Free online encyclopedia
- **FileZilla Wiki:** Help site of the popular FTP software
- **Joomla! Documentation:** Help documentation of the popular CMS software
- **MoodleDocs:** Documentation of the learning platform Moodle
- **Antwiki:** Where ant scientists share their information

**Literature**

1.2 Login

Login

To work with your BlueSpice wiki, you need to log in. Click on the login button in the top right corner of the screen.

In the following window, enter your user name and password. Click Log in and you're ready to go.

By the way: if you want to stay logged in permanently, just check the box Keep me logged in. That way you don't need to re-enter your data every time you login. Your login is stored in a browser cookie on your system. If you delete your browser cookies, you have to provide your login information next time you want to use the wiki.

Setting your user preferences

Once you are logged in, you can change your personal user preferences. Keep in mind that you can change these settings at any time, and that other users are not affected by your configuration. You can access your user preferences via the profile menu in the main toolbar.
1.3 User profile

BlueSpiceSocialProfile provides the SocialEntity of type profile. Furthermore, the user page is converted into a complete user profile.

**User profile info**

The first part of the profile page contains elements related to the user's profile info.

(1) **Watchlist:** The profile page is by default on the user's watchlist to send notifications about any changes to the page.

(2) **Actions menu:** In the edit menu, users can edit their profile description (5) below their profile picture, update their user image and enter their profile data (3).

(3) **Profile data:** Users can enter their profile details, such as department and phone number.

(4) **User image:** The user image can be uploaded from the actions menu. For users without a user image, an avatar image is displayed instead.

(5) **Description:** The edit link in the Actions menu allows to edit the page content itself. This content is displayed directly below the profile box.

**Social timeline**

Below the user profile information, a timeline of the user contributions is shown in the form of social entities. A filter allows all users to change what types of actions are displayed in the list.
Timeline of user actions

Related info

- Blog
- Discussions and Attachments
- Discussion topics
- Microblog
- Social comments
- Reference:BlueSpiceSocial
1.4 BlueSpice layout

Contents

1 BlueSpice Layout .............................................................................................................................................. 12
2 Custom menu ................................................................................................................................................ 12
3 Main toolbar ............................................................................................................................................... 13
4 Navigation .................................................................................................................................................. 14
5 Content ...................................................................................................................................................... 15
6 Page tools .................................................................................................................................................... 16
BlueSpice Layout

Your wiki is divided into several unique areas that group the features of the wiki in a meaningful way. Here we give you an overview so that you can easily find the functionality that you are looking for.

**Note:** Some features are disabled by default in your wiki or only visible to specific user groups such as administrators.

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Custom menu</td>
<td>A wiki administrator can create custom navigation to pages inside and outside the wiki.</td>
</tr>
<tr>
<td>2-Main toolbar</td>
<td>Contains important elements such as the logo area, the search field and access to the user profile.</td>
</tr>
<tr>
<td>3-Navigation</td>
<td>The &quot;heart&quot; of the page organization. From here, users can access all pages, depending on their permissions. Many navigation elements can be customized.</td>
</tr>
<tr>
<td>4-Content area</td>
<td>Here you create and edit all wiki content. Discussions are also located in this space.</td>
</tr>
<tr>
<td>5-Page tools</td>
<td>Powerful page management features. This includes important tools for the quality management of a page.</td>
</tr>
</tbody>
</table>

**Custom menu**

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Custom</td>
<td>With the extension BlueSpiceCustomMenu, a wiki administrator can create individual</td>
</tr>
<tr>
<td>Layout area</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>menu</td>
<td>navigation to pages inside and outside the wiki.</td>
</tr>
</tbody>
</table>

### Main toolbar

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Logo area</td>
<td>The BlueSpice logo can be exchanged via the <a href="#">Config Manager</a> with a company logo.</td>
</tr>
<tr>
<td>2-Search field</td>
<td>You will <a href="#">search pages and files</a> with a full-text and title search, as well as a fuzzy search. With search filter and search in the metadata.</td>
</tr>
<tr>
<td>3-Edit page</td>
<td>A button that switches a page into edit mode. Only active for users with write access.</td>
</tr>
<tr>
<td>4-Create page</td>
<td>A button for creating a new page or uploading a file. Only active for users with write access.</td>
</tr>
<tr>
<td>5-User menu</td>
<td>Users manage their own settings and notifications here. The avatar icon indicates when unread notifications are waiting for the user.</td>
</tr>
<tr>
<td>6-Language selector</td>
<td>In multilingual wikis, you can switch between the language versions of a page.</td>
</tr>
<tr>
<td>7-Fullscreen toggle</td>
<td>Hides the navigation and page tools at the same time.</td>
</tr>
<tr>
<td>8-Custom menu toggle</td>
<td>Here you can hide and show the top menu.</td>
</tr>
</tbody>
</table>
Navigation

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1- Main navigation</td>
<td>This is the general navigation. It can be customized by the administrator for the whole wiki.</td>
</tr>
<tr>
<td>2- Books (optional)</td>
<td>If you use the bookshelf extension, users can go to all general and individual books to which they have access.</td>
</tr>
<tr>
<td>3- My pages</td>
<td>This is your custom navigation bar. They can be adapted to your needs.</td>
</tr>
<tr>
<td>4- Global actions</td>
<td>Direct links to many special pages and administration pages (for administrators).</td>
</tr>
<tr>
<td>5- Navigation toggle</td>
<td>Shows and hides the navigation.</td>
</tr>
</tbody>
</table>
## Content

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Title section</td>
<td>In the title section of a page, the most important page information and page functions are put together in a user-friendly way.</td>
</tr>
<tr>
<td>2-Work area</td>
<td>In the workspace, users create and edit all page content. VisualEditor simplifies the editing process.</td>
</tr>
<tr>
<td>3-Footer</td>
<td>The footer contains links to legal information as well as to external MediaWiki websites.</td>
</tr>
</tbody>
</table>
# Page tools

<table>
<thead>
<tr>
<th>Layout area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Page tools</td>
<td>Sets of page actions and information related to this page can be found here.</td>
</tr>
<tr>
<td>(a) Menu</td>
<td>Lots of page actions and information related to this page can be found here.</td>
</tr>
<tr>
<td>(i) Menu header</td>
<td>Lots of page actions and information related to this page can be found here.</td>
</tr>
<tr>
<td>(ii) Menu link</td>
<td>Lists all the important tools to manage the life cycle of a page, such as reminders and page reviews.</td>
</tr>
<tr>
<td>2-QM tools</td>
<td>A switch to hide and show the page tools.</td>
</tr>
</tbody>
</table>
2 Personalization

Contents

1 What are user preferences? .............................................................. 33
2 User profile .............................................................................. 33
  2.1 Basic Information ............................................................. 33
  2.2 Internationalisation .......................................................... 34
  2.3 Signature ........................................................................... 34
  2.4 Email options ................................................................. 34
3 Appearance .............................................................................. 34
  3.1 Skin ................................................................................. 34
  3.2 Reading preferences ......................................................... 34
  3.3 Date format ....................................................................... 34
  3.4 Time offset ....................................................................... 34
  3.5 Files .................................................................................. 35
  3.6 Diffs .................................................................................. 36
  3.7 Advanced options ............................................................ 36
  3.8 Context menu ................................................................. 37
  3.9 Dashboards ...................................................................... 37
  3.10 Player .............................................................................. 38
  3.11 Timeline ......................................................................... 38
  3.12 BlueSpice Calumma settings ............................................ 38
4 Editing ..................................................................................... 39
  4.1 General options ............................................................... 39
  4.2 Editor ............................................................................... 39
  4.3 Preview .............................................................................. 40
  4.4 Reminder .......................................................................... 40
  4.5 Timeline ............................................................................ 41
5 Recent changes ...................................................................... 41
  5.1 Display options ............................................................... 41
  5.2 Advanced options ............................................................ 41
  5.3 Edit review ....................................................................... 41
6 Watchlist ................................................................................. 41
  6.1 Edit watchlist ................................................................. 41
  6.2 Display options ............................................................... 42
  6.3 Advanced options ............................................................ 42
  6.4 Token ............................................................................... 42
7 Notifications ........................................................................... 42
  7.1 Email options ................................................................. 42
  7.2 Notify me about these events .......................................... 43
  7.3 New message indicator ................................................... 43
  7.4 Notifications on namespace events ................................. 43
  7.5 Notifications on categories .............................................. 43
  7.6 Review .............................................................................. 43
What are user preferences?

As a BlueSpice user, you can customize a lot of settings to make your wiki experience more personal and more efficient.

For example, you may want to show a real photo of yourself or maybe you prefer a randomly generated image. You can also set when and how you want to be notified about changes that are happening on your wiki. To find content tailored to your needs, you can even exclude entire namespaces from your search results if you only need information from particular areas of your wiki.

Just remember that all settings only affect your own wiki experience (except for your profile information, of course, which is visible to all users).

To access your preferences:

1. **Click** on the user menu.
2. **Click Preferences**. This opens the preferences page with multiple tabs.

Alternatively, you can access the page `Special:Preferences` directly.

User profile

Basic Information

- **Real name**: This name is shown throughout the wiki. When users hover over your real name, your profile picture and contact information is shown.
- **Change password**: If your wiki is not connected with the central authentication system of your company, you can manage your password here.
- **User image**:
  - **User image** text field: Enter the webaddress of a picture on another website and click **Save** at the bottom of the page. The profile picture points directly to the external image:
  - **Change profile picture** link: Upload an image to the wiki. Click **Browse** and then **Upload** to create a new profile image. If you click **Generate new avatar**, the system generates a graphic instead.
Privacy policy acceptance checkbox: Select and save this checkbox setting to confirm that your accept the privacy policy. Administrators can review this setting for all users on the page Special:Privacy_Admin.

Internationalisation

- **Language**: Users can change their personal language that is used in the layout and menus. BlueSpice currently supports de-formal-German (formal), de-German and en-English.
- **How do you prefer to be described?** Option for setting your gender preferences.

Signature

- **Your existing signature**: shows a preview of your current signature including your profile info when you hover over the link.
- **New signature**: Enter a new name for your signature and save the Preferences page.
- **Treat signautre as wikitext**: Your signature will be shown as text-only.

Email options

If you provide an email adress, you can specify to receive email notifications in addition or in place of wiki notifications. As long as the email adress is not confirmed, the system will not send emails. This also affects the settings in the Notifications tab.

If you want to exclude minor page edits from email notifications, you need to set it under the email options here.

Appearance

Skin

If your wiki has more than one skin, you can choose the layout of your wiki here. It only affects your view of the wiki. All other users see the skin that is selected in their preferences.

Reading preferences

You can set if you want to see quick summaries of a page before you click on a link. This requires that the page has some intro text before the first heading on a page.

Date format

You can set how you would like to see the timestamp on wiki pages, for example the timestamp of a user signature on a discussion page.

<table>
<thead>
<tr>
<th>Date format example</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Rodrigue (talk)</em> 09:10, 3 December 2019 (CET)</td>
</tr>
</tbody>
</table>

Time offset

- **Server time**: Shows the server time so that you can compare it to your local time.
- **Local time**: Shows the time set in the time zone setting.
- **Time zone**: When you select a time zone, your local time will be shown throughout the wiki wherever there is a timestamp.

### Files

- **Image size limit**: Sets the maximum size of the preview image on the file description page.

![Image size on file page](image-size-on-file-page.jpg)

- **Thumbnail size**: Sets the size of the thumbnail image on a page if no custom size is specified in the image settings.
- **Enable Media Viewer**: If this checkbox is not selected, image links on a page will load the file description page rather than the media viewer overlay.
Diffs

- **Do not show the page content below diffs**: Turns off the VisualDiff view as well as the wikitext view of revisions. Revisions are only shown in classic view.
- **Don't show diff after performing a rollback**:

Advanced options

- **Link underlining**:
  - **Always**: Underlines all links in the content area of a page, even if the selected skin specifies no underlining. The table of contents is not affected by this setting.
  - **Never**: Never underlines links in the content area of a page, even if the selected skin specifies...
Never: Never underlines links in the content area of a page, even if the selected skin specifies underlining.

Skin or browser default: Keeps the link settings as specified in the skin.

• **Threshold for stub link formatting:** Determines when the target page is considered short enough to change the link color to a page that fits the threshold criteria. If you choose 50 bytes, a link to a page with less than 50 characters (including wikitext), will be marked as a stub link and be shown in a different color. This only works if your wiki skin has a separate color value for stub links defined.

• Show hidden categories:

• **Auto-number headings:** Adds heading numbers to the page headings

---

### Context menu

Page links in the content area of the wiki show a context menu that allows to perform actions on the target page without having to go to the target page first. You can set whether you want to show the context menu with `right-click` or with `right-click + Strg`.

---

### Dashboards

By default, the logo of your wiki links to the main page. You can change this and link to your user dashboard instead.
**Player**

When a page contains a video, you can set it to autoplay when you load a page.

**Timeline**

You can set the timestamp on the timeline entries in date format or as age.

**Note:** It can take up to 24 hours for all timeline entries to show the new timestamp format. When you create a new entry, you should see the changed format immediately.

**BlueSpice Calumma settings**

- **Automatically hide main menu:** Hides the main menu every time you load a new page.
- **Automatically hide tool menu:** Hides the tool menu every time you load a new page.
Editing

General options

- **Enable section editing by right clicking on section titles:** Right-clicking a section title with the mouse sets the page in edit mode. The specified section can be edited immediately.
- **Editing pages by double clicking (JavaScript):** Double-clicking on the page sets the page in edit mode. The double-click needs to be inside the text area of the page. Clicking in the title section of a page will not set the page into edit mode.
- **Show the pending changes diff when editing pages:**

Editor

- **Edit area font style:** Displays source code in monospace, serif, or sans-serif font.
- **Mark all edits minor by default:** This automatically sets the minor flag in the save dialog. It can be selected or deselected in the save dialog on the page itself:

![Edit area font style](image)

marking a minor edit

**Note:** Note: The 'Watch this page' checkbox in the save dialog can be activated or deactivated by default under the preferences tab *Watchlist* under *Advanced options: Add pages and files I edit to my watchlist.*

- **Prompt me when entering a blank edit summary:** Displays a text message when you click *Save changes* reminding you to enter a summary description. If you do not enter a description after that, the page will save without the summary the next time you click *Save changes.*
Warn me when I leave an edit page with unsaved changes: When you reload or leave a page with unsaved edits, a warning message is displayed. You can confirm to leave the page or stay on the page and save your changes.

Show edit toolbar: Disables VisualEditor in visual editing mode. Disabling is not recommended, as this reverts the editor back to a previous version of MediaWiki editor.

Temporarily disable the visual editor while it is in beta: You can disable visual editor while it is in Extension:VisualEditor|beta mode. We recommend you do not disable VisualEditor unless you prefer to work with a previous visual editor version.

Preview

These preview settings are only applied if you have temporarily disabled VisualEditor and the edit text area is on the same page as the page preview. In BlueSpice 3.1+ you can generally ignore these settings.

Show preview on first edit: The preview of the article is displayed when you click on "Edit"

Show preview before edit box: If this option is deactivated, the preview will be shown under the edit form

Show previews without loading the page:

Reminder

Default reminder period: Prefills the date field for reminders with current date + x days specified here.
• **Set reminder on page creation:** When you create a new page, a reminder for that page is automatically created based on the default reminder period you entered.

• **Do not create reminder for the following namespaces:** Excludes namespaces from the automatic reminder on page creation.

**Timeline**

• **Warn me when I leave an edit of an entry with unsaved changes:** If unchecked, any unsaved changes to a social entity (such as blog entry, comment, microblog or discussion topic) will be automatically lost if you navigate to a different page or reload the page before saving your changes.

• **Skip dialog on discussion creation:** Automatically creates a discussion page when a user adds a discussion directly on a page and the discussion page for the entry does not yet exist. If this checkbox is unchecked, the user has to create the discussion page first before the discussion topic can be posted.

**Recent changes**

**Display options**

• **Days to show in recent changes:** You can set how many results are displayed on the page Recent changes.

• **Number of edits to show in recent changes,...:**

**Advanced options**

• **Group changes by page in recent changes and watchlist:**

• **Hide minor edits from recent changes:** Hide minor changes from appearing on your Recent changes page. This is useful if pages are saved a lot by a single user without major differences between the edits.

**Edit review**

• **Basic interface**

• **When to show the stable version...: Here you can set to 'Always show the latest version** for each page. This setting is only useful if the FlaggedRevs feature is active in a namespace. It is a useful settings for users with review permissions who can accept draft versions. Without this setting, the last stable version of a page is shown by default.

• **Show the pending changes diff when viewing the latest pending version:**

**Watchlist**

**Edit watchlist**

• **Edit entries on your watchlist:**
  • *View and remove titles on your watchlist:* Links to the page Special:EditWatchlist where you can manage your watchlist entries. The watchlist is organized by namespaces.
  • *Edit raw watchlist:* Links to the page Special:EditWatchlist/raw where you can remove pages by page name from a textbox. This list is also organized by namespaces.
  • *Clear watchlist:* Links to the page Special:EditWatchlist/clear where you can empty your watchlist with the click of a button.
Display options

- **Days to show in watchlist**: Presets the value in the selection menu Period of time to display on the page *Special:Watchlist*.
- **Maximum number of changes to show in watchlist**: Limits the number of changes that are displayed in your watchlist.

This example shows a default setting of 8 days and 20 changes.

![Watchlist options](image)

Advanced options

Here, you select all the criteria for automatically adding pages and files to your watchlist and for showing certain changes on your watchlist.

Token

- **Watchlist token**: The token can be used to create a public RSS feed to your watchlist. Anyone who knows this token can access the feed. The syntax for the feed URL is: `https://[YourWikiDomain]/w/api.php?action=feedwatchlist&wllowner=[USERNAME]&wltoken=[TOKEN]`.

Notifications

Here you can set how and when you would like to receive notifications in email and/or in the notifications area of your user profile (Web notifications). If you haven't received email notifications yet, make sure that your email address has been verified. This information is available in the *User profile* tab, under the section *Email options*.

To view your Web notifications, go to your User profile menu and select Notifications.

The user profile image in the main toolbar and the *Notifications* menu item show the number of new notifications. Notifications can set for a variety of events, such as new assignments or reminders. You can also select to be notified about changes only in certain namespaces or categories.
To configure which notifications you want to get, click on *Preferences* in the *Settings* menu (3).

**Email options**

You can specify how often you receive emails: *never, immediately, daily,* or *weekly.*

![Email options](image)

If you unexpectedly don't receive emails for notifications, check under the *User profile* tab to make sure that you have already confirmed your email account.

![Email confirmation](image)

**Notify me about these events**

Notifications can be displayed in the Notifications page of the wiki. This functionality is provided by the MediaWiki extension *Echo.*

**New message indicator**

This setting currently has no effect in BlueSpice. It is a configuration setting for the MediaWiki extension `Extension:Echo|Echo` (echo-show-alert).

**Notifications on namespace events**

Select for which namespaces you want to receive notifications.

**Notifications on categories**

Select for pages in which categories you want to receive notifications.

**Review**

- **Notify me about changes if I am the owner of a review:** Select if you want to be notified in email of any workflow changes of a review workflow if you are the owner of the review.
- **Notify me about changes if I am the reviewer of a review:** Select if you want to be notified in email of any workflow changes of a review workflow if you are the owner of the review.

Under the settings for *Notify me about these events*, you can set if and how you want to be notified if someone assigns a review task to you.
Extended Search

Here you can set which namespaces you want to include in your search results. This can be useful if you work in only some areas of the wiki or if you are looking for information in a few areas of your wiki only.

Semantic MediaWiki

These user preferences are provided by Semantic MediaWiki. If you would like to change these settings, you can visit the corresponding help page.

Resetting all preferences

If you click *Restore all default settings (in all sections)*, all your customizations on all tabs are reset to their default settings. Since this could affect lots of customized settings, a warning page appears before the reset.

You can use this page to reset your preferences to the site defaults. This cannot be undone.

*Restore all default settings (in all sections)*

restoring default settings

Use the browser’s back button if you do not want to restore the default settings.
2.1 User preferences

Contents

1 What are user preferences? ................................................................. 33
2 User profile .................................................................................... 33
2.1 Basic Information ........................................................................ 33
2.2 Internationalisation ...................................................................... 34
2.3 Signature ...................................................................................... 34
2.4 Email options ............................................................................... 34
3 Appearance ..................................................................................... 34
3.1 Skin .............................................................................................. 34
3.2 Reading preferences ....................................................................... 34
3.3 Date format ................................................................................... 34
3.4 Time offset ................................................................................... 34
3.5 Files ............................................................................................. 35
3.6 Diffs .............................................................................................. 36
3.7 Advanced options .......................................................................... 36
3.8 Context menu ................................................................................. 37
3.9 Dashboards .................................................................................. 37
3.10 Player .......................................................................................... 38
3.11 Timeline ...................................................................................... 38
3.12 BlueSpice Calumma settings ......................................................... 38
4 Editing ............................................................................................. 39
4.1 General options ............................................................................. 39
4.2 Editor ............................................................................................ 39
4.3 Preview .......................................................................................... 40
4.4 Reminder ....................................................................................... 40
4.5 Timeline ........................................................................................ 41
5 Recent changes ................................................................................ 41
5.1 Display options ............................................................................ 41
5.2 Advanced options ......................................................................... 41
5.3 Edit review .................................................................................... 41
6 Watchlist ........................................................................................ 41
6.1 Edit watchlist ............................................................................... 41
6.2 Display options ............................................................................ 42
6.3 Advanced options ......................................................................... 42
6.4 Token ............................................................................................. 42
7 Notifications ..................................................................................... 42
7.1 Email options ............................................................................... 42
7.2 Notify me about these events ......................................................... 43
7.3 New message indicator ................................................................. 43
7.4 Notifications on namespace events ................................................. 43
7.5 Notifications on categories ............................................................ 43
7.6 Review ......................................................................................... 43
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 Extended Search</td>
<td>44</td>
</tr>
<tr>
<td>9 Semantic MediaWiki</td>
<td>44</td>
</tr>
<tr>
<td>10 Resetting all preferences</td>
<td>44</td>
</tr>
</tbody>
</table>
What are user preferences?

As a BlueSpice user, you can customize a lot of settings to make your wiki experience more personal and more efficient.

For example, you may want to show a real photo of yourself or maybe you prefer a randomly generated image. You can also set when and how you want to be notified about changes that are happening on your wiki. To find content tailored to your needs, you can even exclude entire namespaces from your search results if you only need information from particular areas of your wiki.

Just remember that all settings only affect your own wiki experience (except for your profile information, of course, which is visible to all users).

To access your preferences:

1. Click on the user menu.
2. Click Preferences. This opens the preferences page with multiple tabs.

Alternatively, you can access the page Special:Preferences directly.

User profile

Basic Information

- **Real name**: This name is shown throughout the wiki. When users hover over your real name, your profile picture and contact information is shown.
- **Change password**: If your wiki is not connected with the central authentication system of your company, you can manage your password here.
- **User image**:
  - *User image* text field: Enter the webadress of a picture on another website and click *Save* at the bottom of the page. The profile picture points directly to the external image:
  - *Change profile picture* link: Upload an image to the wiki. Click *Browse* and then *Upload* to create a new profile image. If you click *Generate new avatar*, the system generates a graphic instead.
- **Privacy policy** acceptance checkbox: Select and save this checkbox setting to confirm that you accept the privacy policy. Administrators can review this setting for all users on the page `Special:Privacy_Admin`.

### Internationalisation

- **Language**: Users can change their personal language that is used in the layout and menus. BlueSpice currently supports de-formal-German (formal), de-German and en-English.
- **How do you prefer to be described?** Option for setting your gender preferences.

### Signature

- **Your existing signature**: shows a preview of your current signature including your profile info when you hover over the link.
- **New signature**: Enter a new name for your signature and save the `Preferences` page.
- **Treat signature as wikitext**: Your signature will be shown as text-only.

### Email options

If you provide an email address, you can specify to receive email notifications in addition or in place of wiki notifications. As long as the email address is not confirmed, the system will not send emails. This also affects the settings in the `Notifications` tab.

If you want to exclude minor page edits from email notifications, you need to set it under the email options here.

### Appearance

#### Skin

If your wiki has more than one skin, you can choose the layout of your wiki here. It only affects your view of the wiki. All other users see the skin that is selected in their preferences.

#### Reading preferences

You can set if you want to see quick summaries of a page before you click on a link. This requires that the page has some intro text before the first heading on a page.

#### Date format

You can set how you would like to see the timestamp on wiki pages, for example the timestamp of a user signature on a discussion page.

```
Rodrigue (talk) 09:10, 3 December 2019 (CET)
```

**date format example**

### Time offset

- **Server time**: Shows the server time so that you can compare it to your local time.
• **Local time:** Shows the time set in the time zone setting.

• **Time zone:** When you select a time zone, your local time will be shown throughout the wiki wherever there is a timestamp.

**Files**

• **Image size limit:** Sets the maximum size of the preview image on the file description page.

  ![Image size on file page](image)

• **Thumbnail size:** Sets the size of the thumbnail image on a page if no custom size is specified in the image settings.

• **Enable Media Viewer:** If this checkbox is not selected, image links on a page will load the file description page rather than the media viewer overlay.
**Diffs**

- **Do not show the page content below diffs:** Turns off the VisualDiff view as well as the wikitext view of revisions. Revisions are only shown in classic view.
- **Don't show diff after performing a rollback:**

**Advanced options**

- **Link underlining:**
  - **Always:** Underlines all links in the content area of a page, even if the selected skin specifies no underlining. The table of contents is not affected by this setting.
Never: Never underlines links in the content area of a page, even if the selected skin specifies underlining.

Skin or browser default: Keeps the link settings as specified in the skin.

- **Threshold for stub link formatting:** Determines when the target page is considered short enough to change the link color to a page that fits the threshold criteria. If you choose 50 bytes, a link to a page with less than 50 characters (including wikitext), will be marked as a stub link and be shown in a different color. This only works if your wiki skin has a separate color value for stub links defined.

- Show hidden categories:

- **Auto-number headings:** Adds heading numbers to the page headings

---

**Context menu**

Page links in the content area of the wiki show a context menu that allows to perform actions on the target page without having to go to the target page first. You can set whether you want to show the context menu with right-click or with right-click + Strg.

---

**Dashboards**

By default, the logo of your wiki links to the main page. You can change this and link to your user dashboard instead.
Player

When a page contains a video, you can set it to autoplay when you load a page.

Timeline

You can set the timestamp on the timeline entries in date format or as age.

Note: It can take up to 24 hours for all timeline entries to show the new timestamp format. When you create a new entry, you should see the changed format immediately.

BlueSpice Calumma settings

- **Automatically hide main menu**: Hides the main menu every time you load a new page.
- **Automatically hide tool menu**: Hides the tool menu every time you load a new page.
Editing

**General options**

- **Enable section editing by right clicking on section titles:** Right-clicking a section title with the mouse sets the page in edit mode. The specified section can be edited immediately.
- **Editing pages by double clicking (JavaScript):** Double-clicking on the page sets the page in edit mode. The double-click needs to be inside the text area of the page. Clicking in the title section of a page will not set the page into edit mode.
- **Show the pending changes diff when editing pages:**

**Editor**

- **Edit area font style:** Displays source code in monospace, serif, or sans-serif font.
- **Mark all edits minor by default:** This automatically sets the minor flag in the save dialog. It can be selected or deselected in the save dialog on the page itself:

![Edit area font style](image)

**Note:** Note: The 'Watch this page' checkbox in the save dialog can be activated or deactivated by default under the preferences tab *Watchlist* under *Advanced options: Add pages and files I edit to my watchlist.*

- **Prompt me when entering a blank edit summary:** Displays a text message when you click *Save changes* reminding you to enter a summary description. If you do not enter a description after that, the page will save without the summary the next time you click *Save changes.*
• **Warn me when I leave an edit page with unsaved changes**: When you reload or leave a page with unsaved edits, a warning message is displayed. You can confirm to leave the page or stay on the page and save your changes.

• **Show edit toolbar**: Disables VisualEditor in visual editing mode. Disabling is not recommended, as this reverts the editor back to a previous version of MediaWiki editor.

• **Temporarily disable the visual editor while it is in beta**: You can disable visual editor while it is in [Extension:VisualEditor|beta mode](https://mediawiki.org/wiki/Extension:VisualEditor). We recommend you do not disable VisualEditor unless you prefer to work with a previous visual editor version.

**Preview**

These preview settings are only applied if you have temporarily disabled VisualEditor and the edit text area is on the same page as the page preview. In BlueSpice 3.1+ you can generally ignore these settings.

• **Show preview on first edit**: The preview of the article is displayed when you click on "Edit"

• **Show preview before edit box**: If this option is deactivated, the preview will be shown under the edit form

• **Show previews without loading the page**:

**Reminder**

• **Default reminder period**: Prefills the date field for reminders with *current date + x days* specified here.

![Reminder window](https://via.placeholder.com/150)
- **Set reminder on page creation:** When you create a new page, a reminder for that page is automatically created based on the default reminder period you entered.
- **Do not create reminder for the following namespaces:** Excludes namespaces from the automatic reminder on page creation.

**Timeline**

- **Warn me when I leave an edit of an entry with unsaved changes:** If unchecked, any unsaved changes to a social entity (such as blog entry, comment, microblog or discussion topic) will be automatically lost if you navigate to a different page or reload the page before saving your changes.
- **Skip dialog on discussion creation:** Automatically creates a discussion page when a user adds a discussion directly on a page and the discussion page for the entry does not yet exist. If this checkbox is unchecked, the user has to create the discussion page first before the discussion topic can be posted.

**Recent changes**

**Display options**

- **Days to show in recent changes:** You can set how many results are displayed on the page *Recent changes.*
- **Number of edits to show in recent changes,**

**Advanced options**

- **Group changes by page in recent changes and watchlist:**
- **Hide minor edits from recent changes:** Hide minor changes from appearing on your *Recent changes* page. This is useful if pages are saved a lot by a single user without major differences between the edits.

**Edit review**

- **Basic interface**
- **When to show the stable version**...: *Here you can set to ‘Always show the latest version* for each page. This setting is only useful if the **FlaggedRevs** feature is active in a namespace. It is a useful settings for users with review permissions who can accept draft versions. Without this setting, the last stable version of a page is shown by default.
- **Show the pending changes diff when viewing the latest pending version:**

**Watchlist**

**Edit watchlist**

- **Edit entries on your watchlist:**
  - **View and remove titles on your watchlist:** Links to the page Special:EditWatchlist where you can manage your watchlist entries. The watchlist is organized by namespaces.
  - **Edit raw watchlist:** Links to the page Special:EditWatchlist/raw where you can remove pages by page name from a textbox. This list is also organized by namespaces.
  - **Clear watchlist:** Links to the page Special:EditWatchlist/clear where you can empty your watchlist with the click of a button.
Display options

- **Days to show in watchlist**: Presets the value in the selection menu Period of time to display on the page Special:Watchlist.
- **Maximum number of changes to show in watchlist**: Limits the number of changes that are displayed in your watchlist.

This example shows a default setting of 8 days and 20 changes.

```
<table>
<thead>
<tr>
<th>Watchlist options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Below are the last 20 changes in the last 192 hours, as of 3 December 2019, 13:40.</td>
</tr>
<tr>
<td>Period of time to display: 8 days</td>
</tr>
<tr>
<td>watchlist display options</td>
</tr>
</tbody>
</table>
```

Advanced options

Here, you select all the criteria for automatically adding pages and files to your watchlist and for showing certain changes on your watchlist.

Token

- **Watchlist token**: The token can be used to create a public RSS feed to your watchlist. Anyone who knows this token can access the feed. The syntax for the feed URL is: https://[YourWikiDomain]/w/api.php?action=feedwatchlist&wlowner=[USERNAME]&wltoken=[TOKEN].

Notifications

Here you can set how and when you would like to receive notifications in email and/or in the notifications area of your user profile (Web notifications). If you haven't received email notifications yet, make sure that your email address has been verified. This information is available in the User profile tab, under the section Email options.

To view your Web notifications, go to your User profile menu and select Notifications.

The user profile image in the main toolbar and the Notifications menu item show the number of new notifications. Notifications can set for a variety of events, such as new assignments or reminders. You can also select to be notified about changes only in certain namespaces or categories.
To configure which notifications you want to get, click on *Preferences* in the *Settings* menu (3).

**Email options**

You can specify how often you receive emails: *never*, *immediately*, *daily*, or *weekly*.

If you unexpectedly don't receive emails for notifications, check under the *User profile* tab to make sure that you have already confirmed your email account.

**Notify me about these events**

Notifications can be displayed in the Notifications page of the wiki. This functionality is provided by the MediaWiki extension *Echo*.

**New message indicator**

This setting currently has no effect in BlueSpice. It is a configuration setting for the MediaWiki extension *Extension:Echo|Echo* (echo-show-alert).

**Notifications on namespace events**

Select for which namespaces you want to receive notifications.

**Notifications on categories**

Select for pages in which categories you want to receive notifications.

**Review**

- **Notify me about changes if I am the owner of a review:** Select if you want to be notified in email of any workflow changes of a review workflow if you are the owner of the review.
- **Notify me about changes if I am the reviewer of a review:** Select if you want to be notified in email of any workflow changes of a review workflow if you are the owner of the review.

Under the settings for *Notify me about these events*, you can set if and how you want to be notified if someone assigns a review task to you.
**Extended Search**

Here you can set which namespaces you want to include in your search results. This can be useful if you work in only some areas of the wiki or if you are looking for information in a few areas of your wiki only.

**Semantic MediaWiki**

These user preferences are provided by Semantic MediaWiki. If you would like to change these settings, you can visit the corresponding help page.

**Resetting all preferences**

If you click *Restore all default settings (in all sections)*, all your customizations on all tabs are reset to their default settings. Since this could affect lots of customized settings, a warning page appears before the reset.

You can use this page to reset your preferences to the site defaults. This cannot be undone.  

Restore all default settings (in all sections)

Use the browser's back button if you do not want to restore the default settings.
2.2 Privacy center

BlueSpicePrivacy is an extension that enables users to control the way their data is collected and used by the wiki. Users interact with this extension through the Privacy center page, which is accessible by clicking Privacy center in the user menu.

Contents

1 Cookie consent ............................................................................................................................................. 46
2 Privacy Center ........................................................................................................................................... 46
  2.1 Anonymization ........................................................................................................................................ 47
  2.2 Delete your account ............................................................................................................................... 47
  2.3 Transparency ........................................................................................................................................... 48
  2.4 Privacy policy consent ........................................................................................................................... 48
3 Requesting actions ..................................................................................................................................... 49
4 Reviewing user requests ............................................................................................................................ 50
5 Related info ................................................................................................................................................. 50
Cookie consent

Users are presented with a prompt to accept the cookies that the wiki collects. This prompt appears when a user visits the wiki for the first time or after deleting the browser cookies.

![Cookie consent](image)

Here, users have the option to accept all cookies or to manage each group of cookies separately. This is done by opening *Cookie consent settings* and then using the toggle-switches in the prompt. There are different types of cookies, based on the function they perform:

- **Necessary cookies**: Cookies that are needed for the user to be able to use the wiki (cookies for keeping session information, user ID data, and so on).
- **Convenience cookies**: Cookies that provide a more comfortable wiki experience (saving the state of components of the interface, some user preferences, and more)
- **Matomo** (visible only if the necessary plugin is installed and activated): Cookies that are used for site analytics.

By default, accepting at least the necessary cookies is mandatory before using the wiki for the first time.

Cookie settings can be changed afterwards at any point by clicking on "Change cookie consent" in the wiki footer links or on the page [Special:PrivacyCenter](https://example.com/Special:PrivacyCenter).

Privacy Center

The privacy center is the hub for a user's privacy settings. It is located in the profile menu (by clicking on user image in the top right corner) or by navigating directly to the page [Special:PrivacyCenter](https://example.com/Special:PrivacyCenter).
This special page consists of a number of "modules". Each module performs a privacy-related function.

**Anonymization**

In this section, users can anonymize their account on the wiki. This means that users can change their username on the wiki. The new username appears wherever the username is used, including comments, page histories and logs. All traces of previous user information including profile information and profile data is removed or renamed.

To anonymize their account, users pick the new username (a random anonymized username is offered by default) and click "Anonymize my account". After confirmation, the process of anonymization starts, and the user receives a notification upon completion.

**Important!** Changes made in the Privacy center, for example anonymization, can take up to 24 hours to be effective (until the cache expires).

**Delete your account**

Users can delete all traces of their account from the wiki by clicking the "Delete your account" button. After confirmation, the user account is deleted. In case there is an error in the process, users will be notified of the failed deletion process.

By deleting their account, users will remove all references to their user account anywhere on the wiki. All of the user's contributions are then attributed to "Deleted user", which will appear instead of the original username.
Transparency

This module allows users to view and export all data the wiki has collected about them. To only view the data, without exporting it, a user can click on the button *Show all data*. This opens a dialog containing all of the user's data. The data is grouped by:

- **Mentions in content**: Snippets of the page content where the user's name is mentioned.
- **Working data**: Data from extensions - reminders, page assignments, etc.
- **Personal data**: Profile data, personal information and the user's status on the wiki.
- **Action data**: Log data for users actions - edits, page deletions, page moves and administrative actions.

To export the data, the user selects the groups to export and the export format (HTML or CSV). After clicking *Export data*, the user can download the compiled file.

**Privacy policy consent**

In this section, users can change their consent to the wiki's privacy policy. Further options may appear based on a specific wiki configuration. Users can also change their cookies consent (as described above).
Requesting actions

The wiki can be configured so that users are not allowed to directly execute certain privacy-related actions. They need to request that operation first.

Requesting actions applies to:
- Anonymization
- Delete your account

Requests can be enabled for the wiki by setting $bsgPrivacyEnableRequests = true; in LocalSettings.php
Once enabled, users will be presented with a request form in the affected sections. In this form, users can click *Request anonymization* and *Request account deletion* respectively. For account deletion, users can enter an optional comment explaining the reason for the request.

All submitted requests are sent to wiki admins for review.

After submitting the request, a user sees a *Request pending* notice in the Privacy center. If the request is denied, the user is notified with a comment from the wiki administrator. If the user's request is approved, the user also receives a notification.

### Reviewing user requests

Wiki admins (users with "admin" role) can access the *Privacy Admin* page located in *Global actions > Management* or by navigating to *Special:PrivacyAdmin*.

This page lists the submitted requests. Administrators can review and approve or deny them.

In addition, administrators can see the status of the *Privacy policy consent* for every user on the wiki on this page.

### Related info

- Reference: BlueSpicePrivacy
2.3 Personal navigation

The extension UserSideBar lets users create their personal sidebar navigation.

Contents

1 Accessing the personal navigation ................................................................. 52
2 Default content ........................................................................................................ 52
3 Customizing the sidebar ......................................................................................... 52
4 Related info ............................................................................................................. 53
Accessing the personal navigation

![Personal navigation](image)

Every logged-in user has their own UserSidebar. It is located in the left navigation as the Personal navigation tab (clipboard icon).

### Default content

Initially, for users who haven't customized their personal sidebar, the navigation shows the following widgets:

- Pages visited (widget PAGESVISITED)
- My edits (widget YOUREDSITS)
- Watchlist (widget WATCHLIST)

These widgets can be removed individually when a user customizes the sidebar.

### Customizing the sidebar

To customize the content of this sidebar, click on Edit sidebar at the bottom of the sidebar after hovering over any menu item. This opens the page User:<username>/Sidebar.

The syntax used to define the sidebar corresponds to the main MediaWiki sidebar (MediaWiki: Sidebar). Entries starting with a single star ("*) are considered menu headings or sections while entries with two stars ("**") are considered menu items.

<table>
<thead>
<tr>
<th>* My favourite pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>** [[Wiki_Page1</td>
</tr>
<tr>
<td>** [External_Page2 Label]</td>
</tr>
</tbody>
</table>
The sidebar can contain multiple sections. Also, users can use widgets to display predefined lists of pages, as described above. Widgets should be inserted as sections (with one star), like:

* WATCHLIST
* My custom section
** [[Page1]]
...

Related info

- Reference:BlueSpiceUserSidebar
3 Concepts

Each installed instance of a wiki is made up of different types of pages. Each page type serves a specific role in the wiki and, therefore, contains different elements which are described here.

Contents

1 Wiki instance ................................................................................................................................... 58
2 Wiki pages ....................................................................................................................................... 58
3 The pages modell ............................................................................................................................ 58
3.1 Content page ............................................................................................................................... 58
3.2 Wiki page .................................................................................................................................... 58
3.3 Special page .................................................................................................................................. 59
3.4 Category page / file description page ......................................................................................... 59
4 Related info ..................................................................................................................................... 59
Wiki instance

A wiki instance has the following main characteristics:

- it has its own configuration
- it has its own data storage with
  - its own database (for pages, users, user<->groups, user settings, ...)
  - its own file repo (for uploaded files)
- it can be part of a wiki farm

Wiki pages

The pages model

Content page

Content pages are all editable wiki pages. They can be wiki pages that are created by all users with the goal to share information on the wiki. Category pages are created when a page was added to a category and a user subsequently saves the necessary category page. A file description page is created when a file is uploaded to the wiki.

Wiki page

Wiki pages are the actual "content pages" that users create when they add information to a wiki. They can be "blank" at the beginning or based on a page template that already contains some content with a predefined structure.

Characteristics:

- content is added by users
- revisioned and has a version history
Special page

Each wiki contains a large number of special pages. These pages are built-in and not editable. All special pages are located in the pseudo-namespace "Special" and are listed on the page Special:SpecialPages. Merkmale:

- automatically created content
- overview pages or administrative tools

Types of special pages:

- **Maintenance reports** (e.g., broken redirects, uncategorized pages, wanted pages)
- **Lists of pages** (e.g., all pages, categories, forms, templates, high-use pages)
- **User admin pages** (e.g., active users list, blocked users, user rights)
- **BlueSpice special pages** (e.g., category manager, namespace manager, privacy admin)
- and many others

If you want to create your own special page, you can find the necessary information at Mediawiki.org.

Category page / file description page

To display all pages that share a category tag, a category page has to be created. Otherwise, users won't have a list of pages that are in a particular category.

When a file (e.g. image or PDF) is uploaded to the wiki, a corresponding description page is created. This page shows all necessary file information and provides access to important file management tools.

Characteristics:

- hybrid page between special and wiki page
- editable/deletable like a wiki page
- automatically generated content like a special page

Related info

- mediawiki.org/wiki/Manual:Special_pages
3.1 Pages

Each installed instance of a wiki is made up of different types of pages. Each page type serves a specific role in the wiki and, therefore, contains different elements which are described here.

Contents

1 Wiki instance ........................................................................................................................................ 58
2 Wiki pages ........................................................................................................................................ 58
3 The pages modell ................................................................................................................................ 58
3.1 Content page .................................................................................................................................... 58
3.2 Wiki page ....................................................................................................................................... 58
3.3 Special page .................................................................................................................................... 59
3.4 Category page / file description page ............................................................................................... 59
4 Related info .......................................................................................................................................... 59
Wiki instance

A wiki instance has the following main characteristics:

- it has its own configuration
- it has its own data storage with
  - its own database (for pages, users, user<->groups, user settings, ...)
  - its own file repo (for uploaded files)
- it can be part of a wiki farm

Wiki pages

The pages model

Content page

Content pages are all editable wiki pages. They can be wiki pages that are created by all users with the goal to share information on the wiki. Category pages are created when a page was added to a category and a user subsequently saves the necessary category page. A file description page is created when a file is uploaded to the wiki.

Wiki page

Wiki pages are the actual "content pages" that users create when they add information to a wiki. They can be "blank" at the beginning or based on a page template that already contains some content with a predefined structure.

Characteristics:

- content is added by users
- revisioned and has a version history
Special page

Each wiki contains a large number of special pages. These pages are built-in and not editable. All special pages are located in the pseudo-namespace "Special" and are listed on the page Special:SpecialPages:

- automatically created content
- overview pages or administrative tools

Types of special pages:
- Maintenance reports (e.g., broken redirects, uncategorized pages, wanted pages)
- Lists of pages (e.g., all pages, categories, forms, templates, high-use pages)
- User admin pages (e.g., active users list, blocked users, user rights)
- BlueSpice special pages (e.g., category manager, namespace manager, privacy admin)
- and many others

If you want to create your own special page, you can find the necessary information at Mediawiki.org.

Category page / file description page

To display all pages that share a category tag, a category page has to be created. Otherwise, users won’t have a list of pages that are in a particular category.

When a file (e.g. image or PDF) is uploaded to the wiki, a corresponding description page is created. This page shows all necessary file information and provides access to important file management tools.

Characteristics:

- hybrid page between special and wiki page
- editable/deletable like a wiki page
- automatically generated content like a special page

Related info

- mediawiki.org/wiki/Manual:Special_pages
3.2 Namespaces

Contents

1 What is a namespace? ................................................................. 61
2 Characteristics of a namespace ................................................ 61
3 Reasons for using namespaces .................................................. 61
4 BlueSpice standard namespaces .............................................. 62
5 Accessing pages in a namespace ............................................. 63
6 Creating a new namespace ...................................................... 63
7 Organizing content without namespaces .................................. 64
8 Viewing all pages of a namespace .......................................... 64
9 Related info ............................................................................. 64
What is a namespace?

A **namespace** defines an area in a wiki. You can recognize a namespace by the namespace prefix in the page title:

```
<namespace>:Page title
```

In a wiki, you will find predefined namespaces. In addition, wiki administrators can create custom namespaces as needed.

There are certain aspects of namespaces that are important to consider before creating a namespace. It is therefore important to understand the characteristics of namespaces and the reasons for using a custom namespace.

**Characteristics of a namespace**

- **Rights management**: Each namespace can contain its own user rights/roles assignments. However, we recommend flat user hierarchies for wikis.

- **Search function**: Search can be limited to individual namespaces.

- **Design**: Namespaces can be styled differently.

- **Flat structure**: Namespaces cannot contain other namespaces.

- **One namespace per page**: The same page name in a different namespace creates a new page.

- **Special namespaces**:
  - Main (Pages) - No namespace prefix in page titles
  - Special pages (Special)
  - Images (File)
  - Documents (Media)
  - Discussions (Talk)

**Reasons for using namespaces**

- **Rights management**: To assign different user permissions to separate content. For example, a company's HR department can use its own namespace to grant only Human Resources personnel access to the pages in that namespace. Here, rights management is the main reason for creating namespaces. However, flat hierarchies are recommended for wikis.

- **Search function**: To exclude pages and files from the search.

- **Design**: To format pages in different wiki areas differently.
We often use the example of cupboards to make clear the principle of namespaces. There are shelves and everyone can look at them and work on something. There are glass cupboards with a lock that you can look into, but only some people have the key to change the contents. Then there are closed wooden cabinets with locks and only selected people can look inside and work in them. And each of these cupboards can look differently.

**Note:** While users cannot view the pages or files in a namespace for which they have no access rights, they will still see the pages and files listed on the wiki's special pages. They will also see the page names in the search results if the namespace has not been excluded from the search.

### BlueSpice standard namespaces

BlueSpice uses, among others, the 15 standard and the two so-called pseudo namespaces from MediaWiki:

<table>
<thead>
<tr>
<th>ID</th>
<th>Namespace</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media</td>
<td>Pseudo-namespace for uploaded images and files. Will be replaced by path of the files.</td>
<td></td>
</tr>
<tr>
<td>special</td>
<td>Pseudo-namespace for special pages.</td>
<td></td>
</tr>
<tr>
<td>0 (pages)</td>
<td>These are given without a prefix.</td>
<td></td>
</tr>
<tr>
<td>1 Talk</td>
<td>talk page. Is created in addition to each article (also in the following namespaces) to speak about its contents. Additional tab (+).</td>
<td></td>
</tr>
<tr>
<td>2 User</td>
<td>User page. Will be created for every logged in user.</td>
<td></td>
</tr>
<tr>
<td>3 User talk</td>
<td>Cf. talk</td>
<td></td>
</tr>
<tr>
<td>4 [Wiki-Name]</td>
<td>Information about the wiki or the current project. Here: BlueSpice.</td>
<td></td>
</tr>
<tr>
<td>5 [Wiki-Name] _Talk</td>
<td>Cf. talk</td>
<td></td>
</tr>
<tr>
<td>6 Image</td>
<td>Description of a picture and other files. Is automatically supplemented with version information and information about the occurrence of the file</td>
<td></td>
</tr>
<tr>
<td>7 File_Talk</td>
<td>Cf. talk</td>
<td></td>
</tr>
<tr>
<td>8 MediaWiki</td>
<td>system messages. A complete list can be found under Special: AllMessages. Can only be changed by registered users.</td>
<td></td>
</tr>
<tr>
<td>9 MediaWiki_Talk</td>
<td>Cf. talk</td>
<td></td>
</tr>
<tr>
<td>10 Template</td>
<td>Templates can be integrated into other pages.</td>
<td></td>
</tr>
<tr>
<td>11 Template_talk</td>
<td>Cf. talk</td>
<td></td>
</tr>
<tr>
<td>12 Help</td>
<td>Help pages describe how to perform actions in the wiki. No clear separation from the [wiki name] namespace.</td>
<td></td>
</tr>
</tbody>
</table>
Standard namespace: A page is assigned to the "Main" namespace, as long as no other namespace is specified.

Pseudo namespaces: The two pseudo namespaces (Media, Special) are used like normal namespaces, but you cannot edit them or add pages to them.

Most pages in the namespaces are created automatically:

- Special pages are generated by the system during installation.
- Media and image pages are created during file upload.
- User pages are created whenever a user acts on the wiki.
- Discussion pages are also created with the corresponding pages.

This leaves only the default namespaces (Main), [wiki name], Template, Help and Category namespaces where pages can be freely created.

Note: In the default MediaWiki, the names of these areas are "hard-coded". This means that they have been set in the source code of the MediaWiki and cannot be changed by users.

Accessing pages in a namespace

To access or create a page in a specific namespace, its name is simply placed in front of the page title and separated by a colon:

```
[[Setup:Installation]]
```

In the example, the pipe symbol (straight line) was also added. It has the effect that the namespace won’t be displayed for the link label.

If you provide a namespace that is not known to the wiki, the page is created in the standard namespace Main. The portion of the reference specified as the namespace is then added to the title of the item instead and is not recognized as a namespace label.

Creating a new namespace

You can create additional namespaces by using the Namespace manager under Global actions > Management > Namespace manager. The menu item "Category manager" loads the page Special:NamespaceManager.
Organizing content without namespaces

If you simply want to group pages in your wiki without the need for controlling access rights, you can use the syntax of the namespaces to simulate a namespace in the namespace Main. Simply prefix the pages that belong to a group with a name and a colon. If no namespace with this name exists, the prefix simply becomes part of the page name.

That way, it is possible to use pages with the same name in the main namespace and thus let different groups work on content "sets". Since these own "namespace" prefixes are part of the page name, you can now display all pages in a simulated namespace by searching for the prefix in the search field.

Since you can also organize pages with categories and subpages, you should start by planning how you would like to organize the content in your wiki.

After installing your wiki, you can visualize this with the BlueSpice draw.io Plugin directly in your wiki and discuss it with your team.

Viewing all pages of a namespace

You can view all pages in a namespace:
1. Go to the Special page "All Pages"
2. Leave the input field empty
3. Select a namespace from the Namespace drop-down menu
4. Click "Go"

Related info

- Namespace CSS manager
- Namespace manager
### 3.3 Wikitext

Wikitext is a simplified markup language that is used to format and structure text and other data.

While HTML is the most common markup language for web pages, Wikitext is used in wiki systems. Like HTML, it uses tags to mark parts of text or other data.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 How do I use Wikitext? ................................................................. 66</td>
</tr>
<tr>
<td>2 Examples of Wikitext ................................................................. 66</td>
</tr>
<tr>
<td>2.1 Text formatting ................................................................. 66</td>
</tr>
<tr>
<td>2.2 Structuring ................................................................. 66</td>
</tr>
<tr>
<td>2.3 Links / Embedded files ............................................................ 67</td>
</tr>
<tr>
<td>2.4 Magic words ................................................................. 67</td>
</tr>
<tr>
<td>3 Related info ................................................................. 68</td>
</tr>
</tbody>
</table>
How do I use Wikitext?

When you edit a page, you can switch between visual editing and source editing using the editor toolbar.

Wikitext can be entered in source editing mode. When you are in visual editing mode, VisualEditor inserts Wikitext "behind the scenes". If VisualEditor doesn't format elements on a page correctly, you can always switch to source editing to correct the issues directly in Wikitext.

Examples of Wikitext

Here are some typical examples of Wikitext:

Text formatting

- This is '''bold'''
- This is ''italic''
- This is <u>underlined</u>

Structuring

- This is a ===Heading===
- This is an *unordered list element
- Table:

```markdown
{| class="wikitable"
|- !header 1 !header 2
|- |row 1, cell 1 |row 1, cell 2
|- |row 2, cell 1 |row 2, cell 2
|}
```
Links / Embedded files

Link to internal wiki page

[[Wikipedia|Label]]
[[Pancake|Best Pancake]]

Link to external website

[url label]
[https://wikipedia.org Wikipedia]

'Link with parameters

<span class="plainlinks">[[fullurl:{{FULLPAGENAME}}|action=edit}} Edit this page]<span>

This link opens the referenced page in edit mode in a new tab.

Embed image/file

- [[Datei:image-or-pdf-name.png]] — Image/PDF is embedded on page
  - the wiki checks, if a preview can be generated (e.g., for "png", "jpeg", "gif", "svg") and embeds the preview
  - otherwise, a link to the file description page is created
  - can be embedded: PDF, Tiff (with extension)
  - cannot be embedded: Microsoft Office- und Libre Office-Dateien; Shell-Skripte, ...
- [[Media:image-or-pdf-name.png]] — Links to image / PDF
- [[:Datei:image-or-pdf-name.png]] — Links to file description page

Magic words

<table>
<thead>
<tr>
<th>Type of Wikitext</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special character</td>
<td>ã → à</td>
</tr>
<tr>
<td></td>
<td>ç → ç</td>
</tr>
<tr>
<td>UTF-8 is possible</td>
<td></td>
</tr>
</tbody>
</table>
### Table of contents

<table>
<thead>
<tr>
<th>Type of Wikitext</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>&lt;!-- unnoticed --&gt;</td>
</tr>
<tr>
<td>No &quot;wiki translation&quot;</td>
<td>&lt;nowiki&gt; and &lt;/pre&gt;</td>
</tr>
<tr>
<td>Table of contents</td>
<td><strong>TOC</strong> and <strong>NOTOC</strong></td>
</tr>
<tr>
<td>Signature</td>
<td>~~~</td>
</tr>
<tr>
<td>Redirect</td>
<td>#REDIRECT [[targetpage]]</td>
</tr>
<tr>
<td>Template</td>
<td>{{template name}}</td>
</tr>
</tbody>
</table>

### Related info

- [meta.wikimedia.org/wiki/Help:Wikitext_examples](meta.wikimedia.org/wiki/Help:Wikitext_examples)
- [Magic words](meta.wikimedia.org/wiki/Help:Wikitext_examples)
3.4 Magic words

A "magic word" is a string of text that is recognized by the MediaWiki software. It triggers the software to return the value of a function, such as dates, website statistics or page names.

Contents

1 Types of magic words .................................................................................................................. 70
2 The 4 types of MagicWords ......................................................................................................... 70
  2.1 Behavior switch ...................................................................................................................... 70
  2.1.1 Characteristics of a behavior switch .................................................................................. 70
  2.1.2 Description ....................................................................................................................... 70
  2.2 Variable .................................................................................................................................. 70
  2.2.1 Characteristics of a variable ............................................................................................. 70
  2.2.2 Description ....................................................................................................................... 70
  2.3 Parser Function ..................................................................................................................... 70
  2.3.1 Characteristics of a parser function ................................................................................... 70
  2.3.2 Description ....................................................................................................................... 70
  2.4 Tag ......................................................................................................................................... 71
  2.4.1 Characteristics of a tag ..................................................................................................... 71
  2.4.2 Description ....................................................................................................................... 71
3 How to add a magic word ............................................................................................................. 71
4 Related info .................................................................................................................................. 72
Types of magic words

- **Behavior switch** (or "Double underscore"): __TOC__
- **Variable**: {{FULLPAGENAME}}
- **Tag**: <gallery>
- **Parser function**: {{#ifeq:x|y|true|false}}

The 4 types of MagicWords

**Behavior switch**

Characteristics of a behavior switch

- **Purpose**: controls the layout or behavior of the page
- **Syntax**: __NOTOC__

**Description**

A behavior switch includes or omits certain elements of the page. It is also known as "double underscore". Behavior switches can be put anywhere in the source code of the designated page (usually at the end of the page). The behavior switch __TOC__ produces as output the table of contents exactly where it was inserted on the page.

**Variable**

Characteristics of a variable

- **Purpose**: returns information about the page, wiki, or date
- **Syntax**: {{PAGENAME}}

**Description**

Variables contain (simple) dynamic data. If a template name conflicts with a variable, the variable is used. For example, you have the variable {{PAGENAME}}. In that case, you have to transclude the template with the same name as {{Template:PAGENAME}}.

**Parser Function**

Characteristics of a parser function

- **Purpose**: simple "programming language" for page content (mainly in templates)
- **Syntax**: {{#if:{{field|}} | {{field|}} | N/A }}

**Description**

Parser functions are similar to variables, but take one or more parameters. Example:
They are used for simple logic only, since they are hard to read and to maintain on a larger scale. If complex logic is required, consider Lua scripts in the "Module" namespace (mediawiki.org/wiki/Extension:Scribunto) and invoke using `{{#invoke:...}}`

Parser functions can also be "tag-like", e.g. `{{#ask:...}}` from SemanticMediaWiki. For more information, refer to the MediaWiki help pages mediawiki.org/wiki/Help:Extension:ParserFunctions and mediawiki.org/wiki/Help:Magic_words#Parser_functions.

**Tag**

**Characteristics of a tag**

- **Purpose**: often used for custom development to process dynamic content
- **Syntax**: `<smartlist />`

**Description**

Tags are implemented in PHP as part of a MediaWiki extension. Tags with "bs:" prefix come from BlueSpice (see Reference:BlueSpiceTagSearch). All others come from MediaWiki or from third-party extensions, e.g. the extension SyntaxHighlight.

**How to add a magic word**

Magic words are inserted directly in the source code. Some frequently used magic words can also be added directly with the VisualEditor *Insert > Magic word* menu item:
Related info

- mediawiki.org/wiki/Help:Magic_words
- Extension:BlueSpiceInsertMagic
4 Structuring content

A guiding principle in a wiki environment is: All users can easily and immediately share their knowledge and collaborate on content. For this to happen, it is not necessarily important that users know how the wiki is organized.

Initially, a page can be created anywhere in the wiki, wherever a user has write access. It is, first of all, important that the information is shared. Where the resulting wiki page ultimately lives and how it is found does not have to be decided right away.

In practice, however, there are many relationships between the individual pages. In addition, there are often different target groups for different types of content.

Therefore, it is important for administrators to set up the wiki so that the content can be meaningfully organized. There are important areas to consider:

- User roles and permissions
- Elements for structuring content:
  - namespaces
  - categories
  - pages and subpages

The following is a simple example for content organization:
To clarify how these wiki functions can be used efficiently for a single wiki or wiki farm, a content organization and management concept should be developed. Consider the following areas:

1. **Content strategy:**
   1. What types of content do you share on the wiki?
   2. Who creates which content?
   3. Is there a need for pre-structured content formats?

2. **Information architecture**
   1. How do I organize content, navigation paths and search capabilities to provide user-friendly access to existing information?
   2. Who has what kind of access to the content?
   3. What are the target groups for the different content areas?

3. **Quality management**
   1. Which content must be checked and by whom?
   2. Do you have content with a predefined life cycle?
   3. Is all content meaningfully categorized?

If you don't have a content strategy or an information architecture and ideas about quality management in place when setting up a new wiki, don't hesitate to start using the wiki. Collect and create content as soon as the wiki is technically available. Just make sure that data protection aspects are clarified in advance and communicated accordingly when sharing company information. Through the search function and various special pages, the content can easily be searched and retrieved.

As the content grows, administrators can take inventory and structure the content based on that information and determine policies, processes and the information architecture. The most important decisions should be written down in a formal governance document. From then on, content will be created and organized according to the policies, processes and architecture decisions that are specified in this document.
4.1 Categories

You can assign several categories to a page. Categories can be organized as top categories with subcategories. Therefore, it is possible to create a tree structure and thus to build a hierarchical structure.

Contents

1 What are categories? ................................................................. 77
2 Characteristics ........................................................................ 77
3 Create and assign categories .................................................. 77
   3.1 In the title section of the page .......................................... 77
   3.2 With Visual Editor .............................................................. 78
   3.3 In Source code .................................................................. 78
3 Links to category pages ............................................................. 78
4 Displays of categories ................................................................. 78
5 Category manager ..................................................................... 78
6 Related info ............................................................................ 79
What are categories?

Categories work like keywords or tags. Adding categories to a page makes it easier to find the page in the wiki. All pages of the same category are automatically shown on the corresponding category page. For each category that has not been assigned before, the wiki will automatically create a redlink. Once the page has been created by clicking on the redlink, all pages and subcategories are automatically listed on the category page.

Categories are usually created by users. However, in special cases, MediaWiki also assigns auto-generated categories (for example, pages with broken links).

Characteristics

- **Tagging**: Categories tag pages.
- **Multiple categories per page**: A page can be assigned to several categories.
- **Main categories**: Categories can be organized under main categories.
- **Independent of namespaces**: Categories are not contained in namespaces, but are shared wiki-wide.

Create and assign categories

To create a category or assign a page to an existing category, there are multiple options:
1. In the title area (view mode)
2. Via the options menu in the visual editor (visual editing mode)
3. With Wikitext (source editing mode)
4. In the "Page Information"ayout of the quality management tools

In the title section of the page

The **title section** contains the category assignment field. Any user with edit rights can click on the edit link to add or remove categories from the page. To view all existing categories with subcategories, you can click on the tree icon. Once you are done, the categories are confirmed with the check mark.

Assigning categories to a page
With Visual Editor

In the page options menu of VisualEditor, you can access a Categories menu item. Here you can add and remove category assignments form the page and also add a sortkey to the category.

In Source code

To add a category in source code, the namespace Category is added before the page name.

[[Category:Sales]]

Note: On category pages, umlauts are generally sorted all the way to the back, e.g., "Märchen" after "Muh". You can therefore use the variable {{DEFAULTSORT:sortkey}} to specify an alternative title to be used for sorting (e.g., {{DEFAULTSORT:Maerchen}}).

Links to category pages

Links to a category require a colon before the namespace.

Example: [[:category:new_page]]

If this colon is missing, the article will not be linked to the category page, but the article will be assigned to the corresponding category.

Displays of categories

You can view a list of all wiki categories on the page Special:Categories.

On the page Category:category_name, you will find a list of all the pages and media associated with a particular category.

If you have accessed a previously unavailable (redlinked) category page, you can add a category description to the page. That way, users understand the purpose of the category.

Category manager

The easiest way to manage categories and sub-categories is with the Category manager page (Special:Category_manager). You can navigate to the Category manager via Global actions.
Related info

- Category Manager
- https://www.mediawiki.org/wiki/Help:Categories
## 4.2 Subpages

### Contents

1. What is a subpage? ................................................................. 81
2. Characteristics of a subpage .................................................. 81
3. Creating a subpage ............................................................... 81
4. Reasons for using subpages .................................................. 82
5. Creating a list of subpages .................................................... 82
6. Related info ........................................................................ 83
What is a subpage?

To structure wiki content, you can create subpages for a page. This is useful if you have a larger topic and you want to break this topic down into manageable chunks of information. For example, if you have a page about a car, you could have subpages about major car components such as Brakes and Transmission. Subpages can have subpages of their own.

Subpages are automatically displayed in the breadcrumb navigation of the page:

![Breadcrumb navigation example]

Characteristics of a subpage

- **Syntax-based**: A slash in the page title creates a subpage (e.g., Installation Guide/System Preparation).
- **Navigation**: A subpage creates navigation points (breadcrumb).
- **Hierarchy**: Enables "strongly associated" page hierarchies.
- **Language versions**: Management of language versions of a page.

Creating a subpage

To create a subpage, it is simply appended to the page name with a slash without spaces. Subpages can in turn have subpages:

- Installation Guide/System Preparation
- Installation Guide/System Preparation/Windows
- Installation Guide/System Preparation Windows/IIS
Note: Since MediaWiki interprets slashes as subpages, you should not use slashes in page names.

Reasons for using subpages

Typical applications for subpages are:

- **To create modular pages:** For a larger topic, you can create a main page and link it to individual detail pages. The advantage is that the detail pages can then be specifically linked from other pages.
- **To maintain archives:** If the discussions on the user discussion page become too long, file them in a subpage.
- **To translate a page:** If the content of a page should be available in other languages. You can create a subpage in German for an English page, for example.
- **To document a template:** If you have a very complex template, you can document its functionality in subpages of the template.

Creating a list of subpages

To list the subpages of the current page, add the following tag to the source text of the page:

```markdown
{{Special:PrefixIndex/{{FULLPAGENAME}}/}}
```

Example:

To display the subpages of the page *VisualEditor* in the namespace Manual without showing the namespace or the main page name in the results and without including redirected pages, the syntax is:

```markdown
{{Special:PrefixIndex/Manual:VisualEditor/|hideredirects=1|stripprefix=1}}
```

Output:

- Files
- Images
- Tables
- Tables/Examples
- Version comparison

The correct display of the subpages is only visible in read-mode after saving the page. The list is displayed automatically in a multi-column layout and cannot be adjusted.

For more flexibility in the output of subpages, you can work with the extension DPL 3 which is included in BlueSpice.
Related info

- Creating page lists
4.3 Templates

Contents

1 What is a template? .......................................................................................................................... 85
2 Characteristics of a template .......................................................................................................... 85
3 Creating and including a template ................................................................................................. 85
4 Editing a template .......................................................................................................................... 86
5 Built-in variables .............................................................................................................................. 86
6 Further notes ................................................................................................................................... 86
7 Related info ..................................................................................................................................... 86
What is a template?

A template is a type of reusable content that can be integrated into other pages of the wiki. It can be content-based (text template) or structure-based (layout template) or a combination of both.

A simple example is a notification box that looks identical on all pages, but contains different content on each page where it is used (layout template).

A template can also be used as the source for a page template.

Characteristics of a template

- allows inserting reusable content with a placeholder
- is usually located in the namespace "Template"
- can have parameters
- often contains logic
- used to maintain a "look and feel"

Creating and including a template

A new template is created like a regular page, but in the namespace Template.

Example:  Simple template for a notification box

A template is then included in a page by putting the name of the template (i.e., the title of the template page without the namespace prefix "Template:" in two curly brackets:

```{{NotificationBox}}```

Note: Template names are case-sensitive.
Editing a template

Changes to a template affect all pages that include this template. Before existing templates are changed, it is recommended that you check which pages use the template. To find these pages, you can go to Page tools > Toolbox > What links here.

Built-in variables

Each MediaWiki has a number of built-in variables that are not pages in the "template:" namespace, but are still used as templates.

For example, the variable {{CURRENTTIME}} returns the current UTC time.

Further notes

- The use of a template is basically a transclusion. It is also possible to use pages as templates that are not in the Template namespace. However, this is to be done wisely, since some functions require that the pages are in the template namespace.
- Templates can also be used to define the output of semantic query. For more information, go to Semantic MediaWiki. (This is an example where the pages must necessarily be in the template namespace.)
- The complete list of all pages of the wiki that are located in this namespace can be found on the page Special:Templates.

Related info

- meta.wikimedia.org/wiki/Help:Template
### 4.3.1 Infobox

To emphasize text passages, it is common to use a type of notification box. In this example, we create a notification box that can be used to show a warning, a tip or a note.

**Note:** Sie können eine Infobox-Vorlage auch direkt in ihr Wiki importieren. Hierzu gibt es eine [Download-Datei](#).  

---

#### Contents

1. Template example: Notification box ........................................................................................................ 88
2. Creating the template .......................................................................................................................... 88
3. Creating the template styles ............................................................................................................... 89
4. Using the template ............................................................................................................................ 90
Template example: Notification box

The color of the box and the box label change automatically depending on the type of box a user selects.

Creating the template

1. **Create** the page *Template:Box Note*
2. **Add** the template content and **save** the page:

   ```
   <div class="infobox notification-{{{boxtype}}}">
     <span class="boxlabel">
       {{#switch: {{{boxtype}}}
         | note = Hinweis:
         | tip = Tipp:
         | warning = Achtung:
         | example = Beispiel:
         | important = Wichtig!
         | backgroundbox =
         | #default = Hinweis:
       }
       {{{Note text}}}
     </span>
   </div>
   ```

   What this code does:
   - The container (`<div>...</div>` is used for styling the box. It has the style classes `infobox` and `{{boxtype}}`. The boxtype parameter provides the actual value the user chooses when using the template.
   - The `<span>...</span>` contains the label for the box. It displays the label for the box type the user chooses. It has the style class `boxlabel` which is used to format the label.
   - `{{{Note text}}}` is the placeholder for the actual text the user creates on a particular page.

   To make it easy for users to insert and use this template in visual editing mode, we include a `<templatedata>` section in the template. It is wrapped in a `<nowiki><nowiki>` tag to ensure that this part of the template is not transcluded in the target page that uses the actual template. This template sections function is to describe the parameters of the template. It also populates the form for visual editing:
What this code does:

- It lists the two parameters (`boxtype` and `Note text`), separated by a comma.
- It lists the parameter objects (optional): description, example, type, etc. For a full list of template data objects, see [www.mediawiki.org/wiki/Extension:TemplateData#Param_object](www.mediawiki.org/wiki/Extension:TemplateData#Param_object)
- It describes the purpose of the template (`description`) so that users can distinguish it from similar templates.

### Creating the template styles

To style the notification box, we have assigned three style classes:

- `infobox`: Container for the infobox. We can specify layout properties such as border, background or padding
- `notification-{{{boxtype}}}`: Used for color-coding the box based on what type of box a user wants to insert on a page.
- `boxlabel`: Styling of the box label.

Since we want to load the styles only when this template is used on a page, we create the stylesheet page as a subpage of the template.

**To create the stylesheet:**

1. Create the stylesheet page: `Template:Box Note/styles.css`
2. Add the styles and save the page:
/* Box Note*/
.infobox {
  padding: 1em;
  margin: 2em 0;
  border:1px solid #ccc;
}
.infobox p {
  padding: 0;
  margin: 0;
}
.boxlabel {
  font-weight:bold;
  padding-right:0.5em;
}
.notification-note {
  border-left: solid 4px #3498db;
}
.notification-tip {
  border-left: solid 4px #f2c412;
}
.notification-warning {
  border-left: solid 4px #c23c2b;
}
.notification-backgroundbox {
  background:#ffd67f;
  padding:12px;
}
.notification-backgroundbox .boxlabel {
  display:none;
}

Now, add the reference to the stylesheet at the top of the template page (Template:Box Note) and save the template again:

<templatestyles src="Template:Box Note/styles.css" />
<div class="infobox notification-{{{boxtype}}}">
  ....
</div>

Your template is now ready to use.

Using the template

To create a notification box on a page:

1. **Select** Insert > Template in visual editing mode:
2. Select the template *Box Note* and click **Add template**:

![Add a template](image1)

3. Enter the name for the type of box you want to create, for example *note*:

![Box Note](image2)

4. Click **Add more information**

5. Click *Note text* and enter the text for your notification box:

![Box Note](image3)

6. Click **Insert**. The notification box is now included on your page:
Save the page if you have no further edits to make.

To later edit the notification in visual editing mode, simply double-click the notification and the template dialog window opens.
4.3.2 Translate

If you maintain different language versions as subpages on a single wiki, you can use a template to show country flags anywhere on the page to switch between the different language versions.

To switch from an English main page to its German subpage, you can use the following template.

```html
{{#if: {{{1|}}}| {{DISPLAYTITLE:{{{1}}} }} |}}
<div>
{{#switch: {{SUBPAGENAME}}
|de=[[[File:De-active.png|link=]]] [[File:En.png|link={{NAMESPACE}}:{{BASEPAGENAME}}}]]
|[[[File:De.png|link={{ARTICLEPAGENAME}}/de]]] [[File:En-active.png|link=]]
}}
</div>
<br/>
<br/>
```

On the English main page and the German subpage, include the template reference with the main page name in source editing mode at the top of the pages:

```
{{Translate|Pagename_here}}
```

The page switch then inserts the links as language flags:

You can download the images here and upload them to the main namespace on your wiki:

- File:De.png
- File:En.png
- File:De-active.png
- File:En-active.png
4.4 Page templates

A page template applies a predefined content structure and layout to new pages. That way, certain page types can be applied during page creation to produce consistent sets of related pages.

Contents

1 When to use page templates ................................................................. 96
1.1 Characteristics of a page template ..................................................... 96
2 Creating a page template .................................................................. 96
2.1 Template fields .............................................................................. 97
3 Using page templates ....................................................................... 97
4 Configuration .................................................................................... 98
5 Related info ...................................................................................... 98
When to use page templates

Page templates are useful for frequently used content formats such as meeting minutes, reference pages, product descriptions, or short manuals.

When a page is created with a page template, the page becomes "detached" from the original page template. This means that subsequent changes to the template will not affect pages that have originally been created with that page template. This distinguishes page templates from regular templates.

Characteristics of a page template

- can be created by administrators
- can only be used for new pages
- based on templates in the Template namespaces
- can be limited to certain namespaces
- substitution of variables is possible
- can integrate with the extension Page Forms

Creating a page template

Administrators can create new page templates, as well as edit and remove existing ones in the Page templates manager, located under Global actions.
Note: Every page template depends on an actual page in the namespace Template. This template must exist before creating a page template.

A new page template can be created by clicking the "Plus" button above the template list.

**Template fields**

When creating or editing a page template, the following information needs to be provided before the page template can be saved:

- **Name** - the name of the page template
- **Description** - a short description of the page template
- **Namespace** - a list of the namespace where the template is active. If the template should be available on all pages, select *(all)* from the list.
- **Template** - page in the *Template* namespace from which to pull the content.

Using page templates

A list of available templates appears when a user creates a new page. It is usually shown below the "Empty page" default template. Selecting one of these page templates will create the new page that is pre-filled with the content from the actual template page.

There are two important settings:

- **Assigning namespaces (in the page templates administration):** Page templates can be linked to specific namespaces. If a namespace is not added here, the template will not be displayed in that namespace.
- **Namespace manager:** The PageTemplates option for a namespace must be activated in the Namespace manager so that the associated templates are automatically displayed when a new page is created in that namespace (e.g., if the "+" button is used to create the page).
A list of available templates to choose from is displayed below the default "Blank Page" template when a user creates a new page.

**Configuration**

In the Config manager, you can change the following settings:

- **Force target namespace:**
- **Hide default templates:** Hides the default Empty page template.

**Related info**

- Reference: BlueSpicePageTemplates
5 Working with pages

Contents

1 Together we know more ................................................................................................................ 106
2 How do I create a page? .................................................................................................................. 106
  2.1 Using the search field ............................................................................................................. 106
  2.2 Using the "New page" button .................................................................................................. 107
  2.3 Using a text link (redlink) ...................................................................................................... 107
  2.4 Using the web address ............................................................................................................. 108
3 Selecting a template ...................................................................................................................... 109
4 Tips ................................................................................................................................................ 109
5 Related info .................................................................................................................................. 110
Together we know more

An important aspect of the wiki principle is that information can be shared with other people quickly and without any "red tape". Every wiki user with edit rights should therefore be able to create and edit a page at least in the (Main) namespace without any prior knowledge or without special privileges to contribute to the company knowledge.

How do I create a page?

Ways to create a new page

There are four ways to create a new page in BlueSpice:

- using the search box
- using the "New Page" button
- using a text link (redlink)
- using the web address ("url")

Using the search field

Maybe information about your topic already exists. Before you create a new page, you can use the search to enter terms for your topic and check existing pages. If there is no page on your topic yet, click on the red link 'Create page [page name]' in the search results:
Using the "New page" button

Next to the search box is a button to create a page. This button is only activate if you are logged in and have write permissions on the wiki (or in a specific namespace):

Here you can create a page or a subpage of the current page. In addition, you can also upload a file (image, PDF, Word file, etc.) to the wiki.

Using a text link (redlink)

Let's say that you want to create the "Training" page. You can directly select any text on the current page and define it as a link to a new page. This creates a so-called redlink. From them on, the link exists, but there is no wiki page for it. The example page "Training" is thus also listed on the Special page WantedPages.

With VisualEditor: Click the Link button () or press Ctrl+K to create a page. Now enter the page name. If there is no page with this name, the page name is shown in red and the page icon shows a question mark. Click "Done" to create the redlink.
In the source text:

When editing the source code, enter the new page name as a link:

```markdown
[[Training]]
```

Since the page does not yet exist, the link is shown in red after saving:

Consulting and technology from a single source,
but adapts them helps with the Ko in addition.
Hello World offers training.

**Using the web address**

You can also create a page directly from the address bar of your web browser:
Simply exchange the current page name with a new one. Here, we create a page “Support” in the main namespace (Main) in the BlueSpice Helpdesk:

https://de.wiki.bluespice.com/wiki/Support

Selecting a template

When you create a page, you are always redirected to an overview page. There, select a page template:

Creating a new page in a namespace: To create a new page in a namespace, put the name of the namespace in front of it, followed by a colon. Example: Help:New_Article

Tips

- **Browser navigation**: When creating pages, try not to use the "back" button. You could lose content that you have not yet saved or that you want to edit again.
- **Redirects**: Do you have the impression that an article title is searched more often with a different synonym? Then create a new article with this name first. Then redirect the page.
- **Title choice**: In a wiki, titles are very important. In wikis with many entries, authors may make references to pages that they deem important in the context of their entry. The page title should, therefore, clearly communicate its content. Single words are very good, but even short sentences like "why wikis work" can be useful names. In addition, meaningful page titles also help readers find their way around when they search for an entry.
- **Spelling**: When linking to an already existing page you should pay attention to their exact spelling. If you e.g. typing a [[hello world]] instead of [[Hello World]] will create a new page as the links are spelled differently. Therefore, consider also capitalization and spaces. Only at the beginning of the letter does it make no difference whether you write a small or capital letter.
- **Namespaces**: If you want to create an article in a different namespace, the namespace must appear before article name. Example: [[namespace:article name]].
- **Special characters**: The following characters cannot be used in titles: { } & ? < > \ and ,. For more information, see mediawiki.org/wiki/Manual:Page_title.
- **Subpages**: The character / is used to create a subpage.
Related info

- Rename and move pages
- Redirects - Using Synonyms
- Creating and Using Page Templates
5.1 Create a page

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Together we know more</td>
<td>106</td>
</tr>
<tr>
<td>2 How do I create a page?</td>
<td>106</td>
</tr>
<tr>
<td>2.1 Using the search field</td>
<td>106</td>
</tr>
<tr>
<td>2.2 Using the &quot;New page&quot; button</td>
<td>107</td>
</tr>
<tr>
<td>2.3 Using a text link (redlink)</td>
<td>107</td>
</tr>
<tr>
<td>2.4 Using the web address</td>
<td>108</td>
</tr>
<tr>
<td>3 Selecting a template</td>
<td>109</td>
</tr>
<tr>
<td>4 Tips</td>
<td>109</td>
</tr>
<tr>
<td>5 Related info</td>
<td>110</td>
</tr>
</tbody>
</table>
Together we know more

An important aspect of the wiki principle is that information can be shared with other people quickly and without any "red tape". Every wiki user with edit rights should therefore be able to create and edit a page at least in the (Main) namespace without any prior knowledge or without special privileges to contribute to the company knowledge.

How do I create a page?

There are four ways to create a new page in BlueSpice:

- using the search box
- using the "New Page" button
- using a text link (redlink)
- using the web address ("url")

Using the search field

Maybe information about your topic already exists. Before you create a new page, you can use the search to enter terms for your topic and check existing pages. If there is no page on your topic yet, click on the red link 'Create page [page name]' in the search results:
Using the "New page" button

Next to the search box is a button to create a page. This button is only activate if you are logged in and have write permissions on the wiki (or in a specific namespace):

![New page button](image)

Here you can create a page or a subpage of the current page. In addition, you can also upload a file (image, PDF, Word file, etc.) to the wiki.

Using a text link (redlink)

Let's say that you want to create the "Training" page. You can directly select any text on the current page and define it as a link to a new page. This creates a so-called redlink. From them on, the link exists, but there is no wiki page for it. The example page "Training" is thus also listed on the Special page WantedPages.

With VisualEditor: Click the Link button () or press Ctrl+K to create a page. Now enter the page name. If there is no page with this name, the page name is shown in red and the page icon shows a question mark. Click "Done" to create the redlink.
In the source text:

When editing the source code, enter the new page name as a link:

```
[[Training]]
```

Since the page does not yet exist, the link is shown in red after saving:

Consulting and technology from a single source,
but adapts them, helps with the Ko in addition.
Hello World offers **training**.

**Using the web address**

You can also create a page directly from the address bar of your web browser:
Simply exchange the current page name with a new one. Here, we create a page “Support” in the main namespace (Main) in the BlueSpice Helpdesk:

https://de.wiki.bluespice.com/wiki/Support

**Selecting a template**

When you create a page, you are always redirected to an overview page. There, select a **page template**:

Creating a new page in a namespace: To create a new page in a namespace, put the name of the namespace in front of it, followed by a colon. Example: `Help:New_Article`

**Tips**

- **Browser navigation**: When creating pages, try not to use the "back" button. You could lose content that you have not yet saved or that you want to edit again.
- **Redirects**: Do you have the impression that an article title is searched more often with a different synonym? Then create a new article with this name first. Then redirect the page.
- **Title choice**: In a wiki, titles are very important. In wikis with many entries, authors may make references to pages that they deem important in the context of their entry. The page title should, therefore, clearly communicate its content. Single words are very good, but even short sentences like "why wikis work" can be useful names. In addition, meaningful page titles also help readers find their way around when they search for an entry.
- **Spelling**: When linking to an already existing page you should pay attention to their exact spelling. If you e.g. typing a `[[hello world]]` instead of `[[Hello World]]` will create a new page as the links are spelled differently. Therefore, consider also capitalization and spaces. Only at the beginning of the letter does it make no difference whether you write a small or capital letter.
- **Namespaces**: If you want to create an article in a different namespace, the namespace must appear before article name. Example: `[[namespace:article name]]`.
- **Special characters**: The following characters **cannot** be used in titles: `{ } & ? < > \ and ,. For more information, see mediawiki.org/wiki/Manual:Page_title.
- **Subpages**: The character `/` is used to create a subpage.
Related info

- Rename and move pages
- Redirects - Using Synonyms
- Creating and Using Page Templates
5.2 Edit a page

Contents

1 Enable edit mode ................................................................. 112
2 Editing ................................................................................ 112
3 Preview ............................................................................... 112
4 Elements of the "save" dialog ............................................ 112
5 Editing conflicts ................................................................. 113
6 Blocked pages ..................................................................... 114
7 Related info ........................................................................ 114
Enable edit mode

To edit an existing page, click the "edit" button.

Editing

You can now add and change content in the content area of the page.

Most users will edit page content using the VisualEditor toolbar. VisualEditor has many features that make page editing much easier.

However, special pages such as templates are edited directly in the source text. Therefore, a knowledge of the Wikitext syntax is necessary for these pages.

Preview

With the Preview button, you can check if you really want to save your changes. This way, you can gradually test small changes. Saving the page repeatedly after small editing steps will result in a large amount of entries in the article's version history. That does not always make sense.

The function SaferEdit automatically saves intermediate versions at defined time intervals while editing an article so that content is not lost if a page has not been saved for a while.

Elements of the "save" dialog

To save the page, click the "Save changes" button. The corresponding dialog window opens:
The following elements are part of the dialog window:

<table>
<thead>
<tr>
<th>Element</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>textarea</td>
<td>A brief description of the changes makes it easier to understand the changes in the version history.</td>
</tr>
<tr>
<td>This is a minor edit</td>
<td>checkbox</td>
<td>Spelling corrections or formatting changes are usually marked as such. Under Recent Changes, such changes are marked with the letter m (&quot;minor changes&quot;). This makes it easy to differentiate in which article version major changes have been made. In addition, the m affects the notification system. Wiki users can exclude notifications about minor changes.</td>
</tr>
<tr>
<td>Watch this page</td>
<td>checkbox</td>
<td>A check mark in this box causes the page to be included in the personal Watchlist.</td>
</tr>
<tr>
<td>Accept this unreviewed page</td>
<td>checkbox</td>
<td>This box will only be displayed if the revision function is activated in a namespace. A user with the corresponding rights of release can release the page design directly here.</td>
</tr>
<tr>
<td>Copyright notice</td>
<td>text</td>
<td>The slightly longer text between the article field and the page-save functions is the copyright notice.</td>
</tr>
<tr>
<td>Save changes</td>
<td></td>
<td>Clicking on this button saves the article with all changes made. The edit view will be closed.</td>
</tr>
<tr>
<td>Resume editing</td>
<td></td>
<td>This button returns directly to the page without saving the article. Editing is simply continued.</td>
</tr>
<tr>
<td>Show preview</td>
<td></td>
<td>The page opens in a preview window and can be saved from this window.</td>
</tr>
<tr>
<td>Review your changes</td>
<td></td>
<td>Shows a comparison of the article before editing and at the time of the current processing status with marking of the differences. The changes can be saved directly from this page</td>
</tr>
</tbody>
</table>

**Editing conflicts**
If you try to save a page that someone else is currently also working on, the system will report an editing conflict. Each author can compare the current changes and merge them as needed.

**Blocked pages**

Some pages can be protected and edited only by administrators. Instead of the edit option, a link to "View source code" appears. The cause is often obvious from the version history of the page. In this case, you can contact an administrator who can unlock the page.

**Related info**

- VisualEditor
- Insert images
- Insert tables
5.3 Rename/move a page

Contents

1 About moving pages .......................................................................................................................... 116
2 What happens when you move a page? .......................................................................................... 116
3 How do I move a page? .................................................................................................................. 117
  3.1 Move with redirect .................................................................................................................... 118
  3.2 Move without redirect ................................................................................................................ 118
4 Updating references to the page ................................................................................................... 119
5 Related info ................................................................................................................................... 120
About moving pages

A wiki page can only be renamed by moving it.

Moving is necessary, since the web address of the page changes during renaming. Normally, there are many links to a wiki page. It is therefore important that these links still work after renaming the page.

A page can be moved with or without redirecting the original page. Let's take a closer look at the differences.

What happens when you move a page?

When you move a page:

- you rename the page name and thus the page title
- the page content is displayed on the new page
- the version history of the original page is transferred to the new page

If you move from the original page to the new page, an additional page with the old page name will be created. This page then serves as a redirect to the new page. If you do not create a redirect, the original page is simply replaced. In this case, you should check and update the links to the old page on your wiki.

The following diagram shows how to rename an "Emobile" page to a page called "Electric Vehicles" page:
How do I move a page?

Go to the page tools menu item "Manage page> Move":

1. Click "Move":

2. The "Move page" dialog box opens:
3. Under New Title, select the namespace for your page and overwrite the original title:

4. **Reason**: Optionally provide a reason why it was necessary to move the page.

5. **Leave a redirect behind**: Depending on the linking status or purpose of a page, you now have to decide whether to move the page with or without forwarding.

6. **Watch source page and target page**: Specify whether you want to put the source and landing pages on your watch list when redirecting.

7. Click "Move page".

**Move with redirect**

It makes sense to create a redirect in the following cases:

- The original page is linked to many other sites (e.g., from other websites or other internal wiki sites).
- The title of the original page is sometimes used in the search and the page should be found either way.

**Move without redirect**

In these cases, it makes sense to move without forwarding:

- A spelling error is corrected in the title. There are only a few links to the page and they are easy to find and replace.
- The original title should not appear in the search.
- An unnecessary redirection via a forwarding page should be avoided.
**Updating references to the page**

After sucessfully moving the page, you will see a confirmation page. If you did not create a redirect, it is important to check if existing links to the original page exist in your wiki. These must then be adapted accordingly to the new page name, so that the page is newly networked. Use the link on the confirmation page to go to the "Special:Replace Text" page:

---

**Move succeeded**

"Template:Box Left" has been moved to "Template:Box Left 1"
A redirect has been created.
To also modify links to this page in other pages, go to Special:ReplaceText.

---

If you have not completed the check immediately after moving the page, you can always go to the special page at any time. Use the Replace Text page to find pages and content that contain the text of the original title.

Enter the original page title under "Existing text" and the new page title under "New text":

![Original text: Box left

Replacement text: Box left 1](image)

Select all wiki sections using the "All" button to find existing references to the original page:
If you click on "Continue" the text will not be replaced yet. First, an overview page with the results found will be displayed. Check which of the results you want to replace and check the box. Click "Replace" to perform the replacement:

Replace "Box Left 1" with "Box Left" in the text of the following page:

```
Template:Box Left - #REDIRECT [[Template:Box Left 1]]
```

Replace

The last page now confirms that the changes have been made:

"Box Left 1" will be replaced with "Box Left" in one page.

Return to form.

Your wiki is now correctly linked again and you have successfully moved your page.

**Related info**

- Redirecting pages
- Working with subpages
5.4 Delete a page

Users with edit rights can delete wiki pages. If a page is deleted, it can no longer be found using the search function. However, users have the option to restore a deleted page.
How to delete a page?

To delete the page, click *Page Tools > Manage page > Delete*.

Deleting a page

Before deleting the page, you can:

- Check the version history.
- Check which pages link to this page.
- Indicate the reason for the deletion: Since deleting a page can raise questions from other users, it makes sense to leave a short explanation here. This text is shown accordingly in the deletion log.
- Watch the page: If the page is restored by another user, you can receive a notification.

Mass-deleting pages

Admin users can mass-delete recently added pages from the special page *Special:Nuke*.

Which pages should be deleted?

You can use some pages under *Special:SpecialPages* to find candidates for deletion:

- **Special:ShortPages**: With short pages it can be expected that the content of the article is not relevant enough or is better dealt with as a paragraph in another article.
- **Special:LonelyPages**: Orphaned pages are characterized by a lack of transclusions or links to the page.
- **Special:NewPages**: Reviewing recently added pages is useful, for example, to detect spam in public wikis.
Where do I find information about deleted pages?

- [Special:Log/delete]: Search for and restore deleted pages.
- [Special:DeletedContributions]: Search for deleted posts of a specific user (or an IP address).

Recover deleted pages

Deleted pages can be restored using the Delete log which can be accessed from the page [Special:SpecialPages]. If the deleted page was linked to other wiki pages, the page can be restored directly via the redlink on that page.

Which pages shouldn't be deleted?

There are often more sensible alternatives for deleting:

- **Move**: If a page has an incorrect or incorrect title, the page can be moved.
- **Copy**: If the content does not match the page title, the content can be copied to another page
- **Redirect**: If the page content already exists on another page, the duplicate content can be deleted and a redirect can be created.
- **Obsolete**: The content is no longer current. You can mark the page as out of date and other wiki users can update the page later.

Related info

- Nuke: Extension for mass-deleting pages
- Redirects
- Deleting user accounts
### 5.5 Link files and pages

#### Contents

1. How do I create links? ......................................................................................................................... 125  
2. Link to a wiki page .......................................................................................................................... 125  
3. Link to an external website ........................................................................................................... 126  
4. Link to a file in the wiki .................................................................................................................. 126  
5. Link to a file in the local network ................................................................................................... 127  
6. Related info ...................................................................................................................................... 129
How do I create links?

Linking pages is an important feature of browser-based knowledge documentation. The links often differ in their function. Links connect wiki pages with:

- other wiki pages
- external websites
- files (images, PDF files, Word documents,...)
- files stored on other drives

Use the *Insert link* menu item in *VisualEditor* or use the shortcut *Ctrl+K*. In both cases, a dialog box opens.

![Insert link to a wiki page](image)

**Link to a wiki page**

Internal links connect related pages or other content that provides more information. Page names can exist multiple times in different namespaces. Therefore, under *Search pages*, enter the namespace if the destination page is not in the same namespace as the current page.

If you have selected some text on the page, you will find some page suggestions already listed in the *Search pages* tab. Here, you can adjust the search term accordingly or create a link to a new page.

Then click on *Done*. 
In the source text, links are created with the following structure:

- **Link to a wiki page**: `[[landing page name|caption]]`
- **Link to a wiki page in another namespace**: `[[namespace:landing page name|caption]]`
- **Link to a category page**: `[[:Category:category name|caption]]` To create a link to a category, the source code is preceded by a colon before the category name. In contrast, the link “Category: BlueSpice” would create a category called BlueSpice instead of linking to the category BlueSpice.
- **Interwiki link**: `[[Imdb:tt2709692]]` If your wiki links to other wikis, you can use the tab Search pages also to directly link to a page in a related wiki. For example, if your administrator maintains an interwiki link for the IMDb movie database, it can be typed in as in the example above. Ask your administrator which interwiki links are available in your wiki.

**Link to an external website**

To link to an external website, mark text on your page, e.g. the word "Wikipedia". Press Ctrl+K and switch to the tab **External link**. There you enter the web address. Then click **Insert**.

![Inserting an external link](https://en.wikipedia.org)

**Note:** To easily maintain external links on your wiki, use the page **Special:LinkSearch**. This page allows you to search for external links in your entire wiki. The page also contains a link to the associated Mediawiki help page.

**Link to a file in the wiki**

To link a file (for example, a picture or a PDF file) in the current page, go to the **Link to File** tab. There, you can search for a file or upload a new file.
• **Search for a file in the wiki and include it as a link:** Enter the file name and select the desired file. Then click on "Paste". A link to the file has been added to the page. You can then change the displayed link text.

• **Link file to a network drive:** If you want to connect to a file on your company network, enter the path under "Link to file" in the text field and activate "Network share path (URI)". The file path is entered using the following syntax - `[[file:///Z:/myfolder/vacatio]]`. This only works if your wiki has been configured to work with network files. This function also depends on your individual browser security settings.

**Link to a file in the local network**

If you want to link to a file on your company network, you can also use the *Link to file* tab.

**Important!** Links to network drives (UNC links) pose a security risk. Therefore, current browsers block these links by default.

It is also possible that your wiki has been configured to disable links to network files.
Talk to your IT department if you have any questions about guidelines related to your browser. If your IT department does not offer a solution, files linked in the wiki can still be copied by wiki users and pasted into the address bar of Windows Explorer.

For more info about UNC-Links, see: https://www.mediawiki.org/wiki/UNC_links.

**Insert a link to a local network file:**

1. Click *Insert link* in the visual editor.
2. Click on the tab *Link to file*.
3. **Activate the switch Netzwerkpfad (URI).** In the file search field (4) you now see the link symbol.
4. **Enter** the path to your file. You can get this path by right-clicking on the file properties in Windows Explorer. From the tab *Security* you can copy the object name and paste it into the wiki accordingly.
5. **Click Insert.** The link is automatically added in the correct format (`file://S:/7_Benutzer/...`). Whether the link can be directly followed through the browser, depends on your browser security settings and installed add-ons. Talk to your IT department to get help if the links are not active.

**Related info**

- Reference:BlueSpiceInsertLink
- Manual:VisualEditor
5.5.1 Interwiki links

Interwiki links are shortcodes for linking to other wikis. The extension InterWikiLinks allows creating abbreviations for various external wikis. The full URL only needs to be known when the interwiki link is defined and not every time it is used.

Contents

1 Interwiki links manager .................................................................................................................. 131
2 Interwiki link syntax ....................................................................................................................... 131
3 Using interwiki links on a page ..................................................................................................... 132
4 Special use case: multilingualism ................................................................................................. 132
5 Related info ................................................................................................................................... 133
Interwiki links manager

Interwiki links are managed from the page Special:InterwikiLinks. It can be loaded from the navigation item Global actions > Management > Interwiki links.

While all users with edit permissions can see this page, a user needs administrative rights to edit the interwiki links:

Interwiki link syntax

Admins can create and delete Interwikilinks with the Interwiki links manager. Existing links can be edited by clicking the "wrench" icon when the link is selected or deleted by clicking the "X" button.

The syntax for interwiki links is:

http://URL_OF_THE_WIKI/$1

$1 is the placeholder for the article title of the other wiki.
Using interwiki links on a page

In edit mode, links to other wikis are added just like links to local wiki pages, but with the interwiki prefix at the beginning.

For example:

The URL to the Wikipedia article "Tree house" is:

https://en.wikipedia.org/wiki/Tree_house

Wikipedia is a default entry in the Interwiki link manager:

prefix: wikipedia, url: https://en.wikipedia.org/wiki/$1

As a result, a link to any wikipedia page can be inserted by using the wikipedia prefix.

[[wikipedia:Tree_house|Wikipedia article about tree houses]]

Special use case: multilingualism

If you want to maintain multiple language versions of your wiki on separate wikis, you can use interwiki links to cross-reference related pages.

With BlueSpice, flag symbols are automatically inserted when the interwiki links with language abbreviations are set.

Linking the language versions:

1. Create interwiki links for the required languages and configure them in the Interwiki link manager (see above) of all language sites. The prefix must always be an ISO-3166 country code, e.g. de, en, fr.
2. Add the interwiki links at the bottom of the related pages to create the language switch. **Example:** In the English article “Tree”, insert the following interwiki links:

```
[ [en:{{FULLPAGENAME}} ] ]
[ [de:Baum ] ]
```

The result of setting the first link is that the English flag will be shown in the language selection of the page header toolbar. This is not necessary and can also be omitted. The second link connects the page with the related german page "Baum" in the German wiki and generates the German flag as a switch in the header toolbar:

To view a list of all pages on a wiki that don't have interwiki links, an administrator can review the page **Special:WithoutInterwiki**.

**Related info**

- Reference:InterWikiLinks
5.6 VisualEditor

BlueSpice uses the MediaWiki extension VisualEditor as editing tool. This sophisticated editor supports all common edit tasks that you can expect in a wiki environment.

Contents

1 What is VisualEditor? ........................................................................................................................................ 135
2 Text editing .................................................................................................................................................. 135
3 Pasting content from your clipboard (ctrl+shift+v) ........................................................................ 135
4 Shortcuts .................................................................................................................................................... 136
5 Inserting other content ......................................................................................................................... 136
6 Wiki-specific content .............................................................................................................................. 137
7 Switching between edit modes ........................................................................................................... 137
8 MediaWiki reference ............................................................................................................................. 137
9 Hints and tips ........................................................................................................................................... 137
9.1 Text formatting .................................................................................................................................... 138
9.2 Insert special content ......................................................................................................................... 138
10 Troubleshooting: Visual editing is disabled ....................................................................................... 141
What is VisualEditor?

The visual editor is optimized for editing wiki pages. Important characteristics and functions are:

1. **Page structuring** with headings.
2. Consistent **text formatting**.
3. **Linking** of contents.
4. **Inserting special content** (files/media, tables, templates, magic words)
5. Adjusting **page options**.

Text editing

Typical text formatting options such as **bold**, **italics**, or **text color** are available as a context menu. When you highlight text, a menu with common formatting elements appears. For example, you can apply a different text color.

![Text color menu](image)

Pasting content from your clipboard (ctrl+shift+v)

If you paste content from your clipboard (e.g., copied from MS Word or MS Excel), you usually also paste many unnecessary formatting tags from the original application. To avoid, this you should paste the content as plaintext.

If you already pasted text which resulted in undesirable formatting, you can use the undo function in VisualEditor to remove the content again if you have not yet saved the page or switched between visual and source editing mode.

To paste content as plain text instead, use the shortcut **ctrl+shift+v**.
Shortcuts

If you want to apply multiple formatting options at the same time, shortcuts are often the quickest way. For example, to show text in bold and italic, highlight the text and press Ctrl+B (for "bold") and Ctrl+I (for "italics"). Even a link can be quickly inserted by pressing Ctrl+k. Pressing Ctrl+b again will cancel the bold. Multiple formats can be removed after text selection with Ctrl+m.

All available keyboard shortcuts are marked accordingly in VisualEditor next to each menu item.

Note: For a list of all available shortcuts, click on "Keyboard shortcuts" in the Visual Editor help menu (the question mark menu item).

Inserting other content

Many typical page elements such as images, files and tables can be integrated into your page from the Insert menu.

- File formats with a preview option: jpg/jpeg, png, gif, pdf
- File formats without preview option are always inserted as links (e.g., Microsoft Office formats)
- Files can be connected with namespaces and categories

If you want to learn more about inserting these elements, go to the following help pages:

- Images
- Files (PDF, xls, doc, ...)
- Tables
- Templates
Wiki-specific content

Some functions in the "Insert" menu are little known from traditional word processing, but are quite typical for working with a wiki. Therefore, they are briefly introduced here. Find more information on the help pages here in the helpdesk or at mediawiki.org:

- **Comment**: Add comments to the page. These are only visible in the source code.
- **Gallery**: A simple picture gallery can support many process flows.
- **Magic word**: Wiki features such as signature, word counter, category tree or even process diagrams with draw.io can be integrated as a "magic word".
- **Your signature**: Only works on pages that allow signatures. Pages in the Namespace "Pages" are not included.
- **Codeblock**: Programming code is displayed here in clean code blocks, optionally with line numbers.
- **References list**:
- **Chemical formula**:  
- **Math formula**: An editor opens for entering a mathematical formula.

Switching between edit modes

When creating or editing a page, the page loads in visual editing mode. If you are familiar with the code language of MediaWiki ("Wikitext"), you can easily switch to source editing mode using the "Switch editor" button:

---

MediaWiki reference

Since VisualEditor is a standard MediaWiki extension, you can also read a documentation of functionality on MediaWiki. Here in the BlueSpice Helpdesk, we only give some hints and tips for using the editor.

Hints and tips

VisualEditor is optimized for editing web pages. That's why it has exactly the features that are often needed to create a wiki page. The consistent formatting of content supports the readability of your wiki content.
## Text formatting

| Text formatting |  
|-----------------|--------------------------------------------------|
| **Undo function** |  
| **Left arrow:** Undo last action (greyed out: there is no last action yet)  
| **Right arrow:** Restore last action (greyed out: there's nothing to restore yet)  
| **Format Paragraph** |  
| Here text can be defined as heading or specific paragraph type. *Note:* If you work in a table, the options will change accordingly (content cell and header cell):  
| **Style text** |  
| If no text has been selected before clicking on the "A" button and on a button, the text will be formatted from the current position of the cursor.  
| **Insert hyperlink** |  
| If no text was selected before the hyperlink dialog was opened, the link will be generated with a number:  
| [1] To subsequently change the hyperlink description, just click on the link to open the edit menu. In a table, you may need to double-click the cell first and then click the hyperlink again.  
| **cite** |  
| The citation menu is used to insert references (also called itemizations or footnotes) within the text.  
| **Structure** |  
| **Insert special content** |  
| **Paste Special Content** |  
| **Insert menu** |  

### Insert special content
<table>
<thead>
<tr>
<th><strong>Paste Special Content</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Insert" /></td>
<td>Use the &quot;insert&quot; menu to insert various media (images, videos) and text formats:</td>
</tr>
<tr>
<td><strong>media</strong></td>
<td>Inserting pictures and videos</td>
</tr>
<tr>
<td><img src="image" alt="Media" /></td>
<td>(Details on MediaWiki])</td>
</tr>
<tr>
<td><strong>templates</strong></td>
<td>Include a template in the page.</td>
</tr>
<tr>
<td><img src="image" alt="Template" /></td>
<td></td>
</tr>
<tr>
<td><strong>tables</strong></td>
<td>Tables are an important tool for formatting tabular page content.</td>
</tr>
<tr>
<td><img src="image" alt="Table" /></td>
<td></td>
</tr>
<tr>
<td><strong>comment</strong></td>
<td>Comments are not visible to readers, but only in edit mode. A comment can be inserted anywhere on a page. The comment can be edited by clicking on it.</td>
</tr>
<tr>
<td><img src="image" alt="Comment" /></td>
<td>And this is what a comment looks like:</td>
</tr>
<tr>
<td><img src="image" alt="Discuss" /></td>
<td></td>
</tr>
<tr>
<td><strong>Gallery</strong></td>
<td>With a &quot;magic word&quot; you can include certain variables or so-called behavioral switches in your page. For example, you can display the word count:</td>
</tr>
<tr>
<td><img src="image" alt="Gallery" /></td>
<td>Learn more about the functionMagic Word”.</td>
</tr>
<tr>
<td><strong>Magic word</strong></td>
<td>Overview of all Magic Words in the visual editor.</td>
</tr>
<tr>
<td><img src="image" alt="Magic" /></td>
<td></td>
</tr>
<tr>
<td><strong>Your signature</strong></td>
<td>This option can only be used in discussions. It allows to add a signature at any point of a discussion.</td>
</tr>
<tr>
<td><img src="image" alt="Signature" /></td>
<td></td>
</tr>
<tr>
<td><strong>Code block</strong></td>
<td>With code block various code examples can be entered, like e.g. in HTML syntax. The code is then displayed properly formatted:</td>
</tr>
</tbody>
</table>
| Code block | <span style="color: red">red text</span>
## Paste Special Content

<table>
<thead>
<tr>
<th>References list</th>
<th>It opens an editor for entering a mathematical formula.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chemical formula</td>
<td></td>
</tr>
<tr>
<td>Math formula</td>
<td>[info on MediaWiki]</td>
</tr>
<tr>
<td>Special Characters</td>
<td></td>
</tr>
</tbody>
</table>

### Page options

<table>
<thead>
<tr>
<th>Options menu</th>
<th>The options menu allows editing of all page settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>This button allows the page settings and page information to be updated simultaneously within a dialog box.</td>
</tr>
<tr>
<td>Categories</td>
<td>Here you assign the page to one or more categories Categories. The page will appear accordingly on all linked category pages.</td>
</tr>
<tr>
<td>Page redirection</td>
<td>Page redirection: When the page is redirected, the content of the page is no longer displayed, but the target page is loaded directly.</td>
</tr>
<tr>
<td>Page settings</td>
<td>This setting can also be used to display or remove the table of contents at the top of the page. The table of contents is automatically generated by the headings on the page. When a page has more than three headings, the table of contents appears automatically by default.</td>
</tr>
<tr>
<td>Advanced Settings</td>
<td></td>
</tr>
<tr>
<td><strong>Page Options</strong></td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Languages</td>
<td><img src="image" alt="Languages" /></td>
</tr>
<tr>
<td>Templates used</td>
<td><img src="image" alt="Templates used" /></td>
</tr>
<tr>
<td>View as right-to-left</td>
<td>Support for languages that are read from right to left. Clicking this button right-side formats the page text. Click again to set the text flush left.</td>
</tr>
<tr>
<td>Find and replace</td>
<td>Words or characters can be searched and replaced directly on the page. The &quot;Undo&quot; button can be used to cancel the change.</td>
</tr>
</tbody>
</table>

**Troubleshooting: Visual editing is disabled**

If you only see code editing, please contact an administrator of your wiki. The following settings must be checked in this case:

- Global settings via the configuration manager
- Namespace management settings
- Parsoid service on the server
5.6.1 Images

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  How to insert an image on a page</td>
<td>143</td>
</tr>
<tr>
<td>1.1 Details</td>
<td>144</td>
</tr>
<tr>
<td>1.2 General settings</td>
<td>145</td>
</tr>
<tr>
<td>1.3 Advanced settings</td>
<td>146</td>
</tr>
<tr>
<td>2  Images and namespaces</td>
<td>149</td>
</tr>
<tr>
<td>3  Changing an embedded image</td>
<td>149</td>
</tr>
</tbody>
</table>
How to insert an image on a page

In addition to text, images are probably the most important components of typical content pages. With VisualEditor, the images can be uploaded, inserted and formatted all in one step. Images are inserted via the menu item *Insert > Media*.

The dialog box *Media Settings* opens.

After uploading, you can edit the image settings: Details, General Settings, and Advanced Settings.
Here you can assign a namespace and categories to a picture.

- **Target namespace**: The picture can be assigned directly to a namespace. The access rights of the namespace are also applied to the image. This means that only users with access to the namespace can view the image on the wiki.
- **Name**: Choose a name that makes it easy to find the image later during an image search. Or simply leave the current file name.
- **Description**: The description is mainly useful for photos or infographics when the image name does not adequately describe the image content.
- **Categories**: Here, the picture can be assigned to categories.

**Note**: When uploading a new file, you should check the file/page name for unusual special characters (e.g., "", %, /, <, >, [ , ], { , }). Change the name to include only standard characters, since the server file system could have problems with them or since some characters have special meanings in MediaWiki. The special characters (, ), & , + can be used and are translated into their equivalent %-hex notation.

**Error message when saving**: If the image already exists, an error message is displayed. If you want to overwrite the existing file, you can click on the file name and overwrite the file via the image page in the wiki. This is done by clicking the "Upload a new version of this file" link in the "File Versions" section. In VisualEditor itself overwriting an image does not work.
General settings

In the general settings, the image descriptions are added.

**Caption:** The caption is shown with framed images and thumbnails. Note: If you change an image to frameless and then back to "framed", you need to re-enter the caption.
Alternate text: The alternate text should be entered for each image since it replaces the image in certain contexts. For example, this so-called "alt" text is used by users who work with screen readers. Screen readers are used by users with visual limitations, but search engines can also read this text. In some business areas, the indication of the "alt" text is also required by law. If you are not sure, ask your company accordingly.

Advanced settings

In the advanced settings, you can set the position and image size.

The following settings are possible:

- **Position:**
  - Wrap text around this item:
    - Left: The image is displayed on the left side of the text, starting on the first line of the current paragraph.
    - Center: The image is displayed centered over the current paragraph.
    - Right: The image is displayed to the right of the text, starting on the first line of the current paragraph.

- **Image type:** If you insert an image with VisualEditor, the image is usually linked to the Media Viewer. To suppress the link on an image, you must add an empty link attribute to the image tag in the source code:
  - frameless picture with link (standard): `[[File:adult-chair-company-380769.jpg|frameless]]`
  - frameless picture without link: `[[File:adult-chair-company-380769.jpg|frameless|link=]]`
<table>
<thead>
<tr>
<th>Image type</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thumbnail</td>
<td><img src="image_url" alt="Image" /> &lt;br&gt;<strong>This is the caption</strong>&lt;br&gt;The preview picture shows the image with a standard width of 300px. The width can be adjusted as required. In addition, the caption is displayed below the picture. A preview icon indicates that the image can be viewed in a larger size.</td>
<td></td>
</tr>
<tr>
<td>Frameless</td>
<td><img src="image_url" alt="Image" /> &lt;br&gt;<strong>This is the caption</strong>&lt;br&gt;The frameless version shows the picture without a frame. The width can be adjusted as required (here we set the example to 300px). The caption does not appear below the picture. By default, the image is inserted without text wrapping. It will break up</td>
<td></td>
</tr>
<tr>
<td>Image type</td>
<td>Output</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Frame</td>
<td><img src="image1.png" alt="Image" /></td>
<td>a sentence exactly where it is inserted. By default, the image is centered. However, the image size and position can be adjusted as needed.</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Image" /></td>
<td>The framed version is similar to the preview picture. Compared to the preview, the magnifying glass symbol is not displayed and the image is inserted on the page full-size. The size cannot be adjusted.</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Image" /></td>
<td>The basic version is like the frameless version. By default, text does not wrap, but the text is separated at the point where the image was inserted.</td>
</tr>
</tbody>
</table>
### Basic

The image is inserted in full width, while the frameless image is inserted in miniature image width (300px). The size can be adjusted.

<table>
<thead>
<tr>
<th>Image type</th>
<th>Output</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td><img src="image_url" alt="Basic Image" /></td>
<td>The image is inserted in full width, while the frameless image is inserted in miniature image width (300px). The size can be adjusted.</td>
</tr>
</tbody>
</table>

- **Image size:**
  - *Standard:* sets the image width to 300px (unless the standard width has been changed in the user preferences).
  - *Custom:* allows setting a custom size.
  - *Make full size:* resets the size to the actual image size.

### Images and namespaces

You can save pictures and files in the general namespace *(pages)*. If pictures should be accessible by all users, you can save these pictures in the main namespace if other namespaces have access restrictions. If you have created additional namespaces, you can also save images in these namespaces if you have the necessary access rights. Images are then only shown to users who have the necessary read permissions in these namespaces.

In the upload dialog, the namespace field always suggests the namespace of the current page for the image upload.

### Changing an embedded image

- **Different image:** In the editing mode of the page, it is possible to edit the image with a double-click. Use the "Change image" button to exchange the image with a different image.

- **Same image with different version:** If you want to use a new version of the same image, open the "Special:Upload file" page in a new browser tab (so that you don’t lose any changes on your wiki page). There, you can save already existing pictures with the same name again. The original image is kept as a version.
5.6.2 Files

Contents

1 How do I upload a file? .................................................................................................................. 151
2 Special features when including files .......................................................................................... 152
3 Maximum file size ....................................................................................................................... 153
4 Avoiding unusual file names ....................................................................................................... 153
5 Related info .................................................................................................................................. 153
How do I upload a file?

PDF, xls, docx, ... Files in common formats can easily be uploaded to your wiki with VisualEditor and at the same time inserted into a wiki page. You can find out which file types are allowed in your wiki on the page [Special:Upload] in your wiki.

In VisualEditor, select the menu item "Insert > Media":

The dialog window "Media Settings" opens. Here, you can connect files with namespaces and categories:

The system detects that it is not an image file and displays a corresponding paper clip as a file icon:

Now click "Upload":

09.01.2022

This document was created with BlueSpice

Page 151 of 331
The general and advanced settings are largely identical to image files. However, there are differences in the linking options, as, for example, a PDF file is not displayed as an image directly on the page.

**Special features when including files**

There are three ways to link a file on a page:

- **Link this file (1):** The inserted link opens the file.
• **Link file description page (2):** The link leads to the file page on the wiki. There, you can view the file details or upload a new version of the file.

• **Embed this file (3):** The link inserts a preview image. The preview image opens the file description page when clicked. This only works with PDF and .tiff files.

**General Settings:** An alternative text is required if you embed the file on the page. This is done via the corresponding "Embed this file" button. Since a preview image is created here, the alternative text should be used just like with images.

If you link to the file or the file description page, VisualEditor will in both cases inserts the same link text, even though the link will lead to different pages. However, the displayed link text can be changed directly on the page. Just click into the text and change it accordingly.

**Note:** If you place a file link directly on already selected text, VisualEditor will replace the selected text with the file information. It is therefore advisable to insert a file link via VisualEditor when the cursor is located at a blank space.

---

**Maximum file size**

The maximum allowed file size cannot be configured in the wiki itself. The maximum allowed limit is defined on the server in the php.ini file in the PHP installation. The actual (possibly smaller) limit, however, is set in the BlueSpice installation in LocalSettings.php or another configuration file in the settings.d folder. The default setting is 32 MB.

Contact your wiki administrator if you receive an error message when trying to upload a larger file.

**Avoiding unusual file names**

**Note:** When uploading a new file, you should check the file/page name for unusual special characters (e.g., "", %, /, <, >, [ ], { }, ). Change the name to include only standard characters, since the server file system could have problems with them or since some characters have special meanings in MediaWiki. The special characters ( ), &, + can be used and are translated into their equivalent %-hex notation.

---

**Related info**

• Manual:Extension/BlueSpiceInsertFile
5.6.3 Tables

Contents

1 Insert a table .................................................................................................................................. 156
2 Merge rows and columns ............................................................................................................. 157
3 Table properties .......................................................................................................................... 157
4 Table styles .................................................................................................................................. 158
**Insert a table**

In VisualEditor, choose "Insert > Tables" to insert a table in a page:

![Insert Tables Menu]

After entering the rows and columns, an empty table appears with the edit menu:

![Table Edit Menu]

When the mouse rests on a symbol, the respective function is displayed.

Double-click in the cells to insert text:

<table>
<thead>
<tr>
<th>Time</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:00</td>
<td>Emails</td>
<td></td>
<td>Home office</td>
</tr>
<tr>
<td>9:00</td>
<td></td>
<td>Team meeting</td>
<td></td>
</tr>
<tr>
<td>10:00</td>
<td>Phone calls</td>
<td>Phone calls</td>
<td></td>
</tr>
<tr>
<td>11:00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12:00</td>
<td>Lunch</td>
<td>Marketing plan</td>
<td></td>
</tr>
</tbody>
</table>
## Merge rows and columns

When you click in a row, an arrow appears at the left edge of the row and at the top of the column. To connect the cells in a row or a column, click on the respective arrow and then in the edit menu on "Merge":

![Table with arrows and merge options](image)

You can also connect individual cells. Hold down the Shift key and click in two or more adjacent cells. Then connect the cells. The cells must be adjacent in a row or in a column so that they can be connected.

## Table properties

In the menu item Properties, there are numerous settings to adjust the functionality and presentation of the table:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caption</td>
<td>Shows a header above the table:</td>
</tr>
<tr>
<td></td>
<td>In the example, a weekly plan is displayed:</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>8:00</td>
</tr>
<tr>
<td></td>
<td>After disabling the header, it is lost and must be reentered when re-enabled.</td>
</tr>
<tr>
<td>Sorted (wikitable)</td>
<td>Enables the default wiki look after table styles were previously selected.</td>
</tr>
<tr>
<td>Sortable</td>
<td>In the first row, a sort function is displayed:</td>
</tr>
<tr>
<td></td>
<td>Time</td>
</tr>
<tr>
<td></td>
<td>8:00</td>
</tr>
<tr>
<td></td>
<td>9:00</td>
</tr>
<tr>
<td></td>
<td>10:00</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>The current sorting is shown in the title bar. Only one of the two sort arrows will appear in the sorted column.</td>
</tr>
<tr>
<td>Collapsible</td>
<td>The table can be hidden on the page via a text link.</td>
</tr>
<tr>
<td>Collapsed</td>
<td>If the &quot;Collapsible&quot; property is active, this determines whether the table is visible or hidden when the wiki page is loaded. T</td>
</tr>
<tr>
<td>Initially</td>
<td></td>
</tr>
<tr>
<td>Exportable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The filter function is activated in the title bar and allows the following actions:</td>
</tr>
<tr>
<td></td>
<td>- Sort table (ascending or descending values of the active column)</td>
</tr>
<tr>
<td></td>
<td>- Hide table columns</td>
</tr>
<tr>
<td></td>
<td>- Filter column (only values from the current column are considered here)</td>
</tr>
<tr>
<td>Filterable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the filter is activated, the table styles are ignored and the table is displayed in &quot;Filter Style&quot;. After deactivating this function, the selected table style is displayed again.</td>
</tr>
<tr>
<td>Table style</td>
<td>Here you can load different style sheets for the table.</td>
</tr>
<tr>
<td>Use full width</td>
<td>The table uses the full width of the wiki page, regardless of the table contents.</td>
</tr>
<tr>
<td>for table</td>
<td></td>
</tr>
</tbody>
</table>

**Table styles**

The following style sheets can be selected in the Table Style menu. Click on a picture to start the gallery:
The visual editor makes it easy to format content as a table. The following alternatives for creating tables exist:

- Tables can also be inserted as a csv file on a page (just drag the CSV file onto the page in edit mode)
- Complex tables can alternatively be attached to the page as an xlsx file.
5.6.4 Embed video

BlueSpice integrates the MediaWiki extension EmbedVideo to embed video files from external video services such as YouTube or Vimeo. EmbedVideo supports more than 20 video services. In addition, you can also embed videos that have been uploaded to the wiki itself.
**Embedding external videos**

![External YouTube videos]

**Note:** These instructions are taken and adapted from the [Mediawiki help page](https://www.mediawiki.org/wiki/Manual:EmbedVideo) for EmbedVideo.

**Syntax**

Use the following parser tag to embed an external video in source editing mode:

```markdown
{{#evt:
  service=youtube
  |id=https://www.youtube.com/watch?v=MLIE2642neg
}}
```

You can add additional optional parameter (see list of attributes):

```markdown
{{#evt:
  service=youtube
  |id=https://www.youtube.com/watch?v=MLIE2642neg
  |dimensions=300
  |alignment=inline
  |description=ISS - Life on the space station <br/> 1:04:27
  |container=frame
  |urlargs=
  |autoresize=
  |valignment=
}}
```

A shortened syntax is available with the `#ev` tag:

```markdown
{{#ev:
  service|id|dimensions|alignment|description|container|urlargs|autoresize|valignment}}
```
Placeholders for unused arguments between two arguments have to remain empty and cannot be removed:

```{#ev:service|id|||description}```

The shortest option to embed a video is by specifying the service name and the video ID:

```{#ev:youtube|MLIE2642neg}```

Example with video description (- you can include a line break with the `<br/>` tag):

```{#ev:youtube|MLIE2642neg|||ISS - Life on the space station <br/> 1:04:27}```

### Attributes for parser tag `#evt`

<table>
<thead>
<tr>
<th>attribute</th>
<th>required</th>
<th>default</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>service=&quot;(see supported services below)&quot;</td>
<td>yes</td>
<td></td>
<td>The video service that is called when the player is created.</td>
</tr>
<tr>
<td>id=&quot;[id</td>
<td>url]&quot;</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>dimensions=&quot;[width</td>
<td>widthxheight</td>
<td>xwidth]&quot;</td>
<td>no</td>
</tr>
<tr>
<td>alignment=&quot;[left</td>
<td>center</td>
<td>right</td>
<td>inline]&quot;</td>
</tr>
<tr>
<td>attribute</td>
<td>required</td>
<td>default</td>
<td>description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>description=&quot;[wiki text]&quot;</td>
<td>no</td>
<td>none</td>
<td>Shows a description below the player container.</td>
</tr>
<tr>
<td>container=&quot;[frame]&quot;</td>
<td>no</td>
<td>none</td>
<td>Determines the container type for the player.</td>
</tr>
<tr>
<td>urlargs=&quot;modestbranding=1&amp;version=3&quot;</td>
<td>no</td>
<td>none</td>
<td>Allows adding additional URL-arguments to the embedded url. This is useful for settings that are only offered by an individual video service.</td>
</tr>
<tr>
<td>autosize=&quot;false&quot;</td>
<td>no</td>
<td>true</td>
<td>Automatically adjusts the video size if the video would extend beyond the size of the container.</td>
</tr>
<tr>
<td>valignment=&quot;[top</td>
<td>middle</td>
<td>bottom</td>
<td>baseline]&quot;</td>
</tr>
</tbody>
</table>

**Video container for multiple videos**

**The `<evlplayer>` tag**

Using the tag `<evlplayer>` and the parser function `#evl`, you can play multiple videos with one video player.

<evlplayer id="Player ID" w="width" h="height" class="class" style="style">defult content</evlplayer>
A default video can be loaded using `defaultid`:

```html
<evlplayer id="player1" w="480" h="360" service="youtube" defaultid="mCtmECVnrOM" />
```

### Attributes for tag `<evlplayer>`

<table>
<thead>
<tr>
<th>attribute</th>
<th>required</th>
<th>default</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>no</td>
<td>default</td>
<td>An optional unique identifier for this container.</td>
</tr>
<tr>
<td>w</td>
<td>no</td>
<td>800</td>
<td>Width to send to the embedded player when its generated.</td>
</tr>
<tr>
<td>h</td>
<td>no</td>
<td>16:9 ratio is achieved by the width setting</td>
<td>Height to send to the embedded player when its generated.</td>
</tr>
<tr>
<td>class</td>
<td>no</td>
<td></td>
<td>Additional CSS class to add to the container div.</td>
</tr>
<tr>
<td>style</td>
<td>no</td>
<td></td>
<td>Additional in-line CSS to apply to the container div.</td>
</tr>
<tr>
<td>defaultid</td>
<td>no</td>
<td></td>
<td>Video ID of default video, if you want a default video.</td>
</tr>
<tr>
<td>service</td>
<td>no</td>
<td></td>
<td>Service of default video, if you want a default video.</td>
</tr>
</tbody>
</table>

### Adding video links

Use the parser tag `{#evl}` to define the videos that should be passed to the player:

```html
{{#evl:<video id>|<Link text>|<video to play>|service=youtube|player=<player id>}}
```

Example:

```html
{{#evl:mCtmECVnrOM|Departure to Mars|player=example-player}}
```

In addition to the attributes for the tag `{#evl}`, there are some additional attributes available for the `{#evl}` tag.

### Attributes for parser tag `{#evl}`

<table>
<thead>
<tr>
<th>attribute</th>
<th>required</th>
<th>default</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>video id</td>
<td>yes</td>
<td>none</td>
<td>The ID of the video you would like to play.</td>
</tr>
<tr>
<td>link text</td>
<td>yes</td>
<td>none</td>
<td>The text to display inside the link.</td>
</tr>
<tr>
<td>player</td>
<td>no</td>
<td>'default'</td>
<td>Player container to load video in. <em>Note that the ID 'default' will only exist if you've defined a player with no ID.</em></td>
</tr>
</tbody>
</table>
### Embedding local videos

Videos that have been uploaded to the Wiki can also be embedded in source editing mode. This can also be done using the extension BlueSpicePlayer. BlueSpicePlayer has no functions to embed external videos, however.

The two extensions have the following differences when embedding local video files:

<table>
<thead>
<tr>
<th>Syntax / Parameter</th>
<th>EmbedVideo</th>
<th>BlueSpicePlayer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syntax</td>
<td>corresponds to the syntax of embedding image files:</td>
<td><a href="">bs:showtime</a>samplename.mp4&lt;/bs:showtime&gt;</td>
</tr>
<tr>
<td></td>
<td>[[File:samplename.mp4]]</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>Only the width can be defined. The video fills the entire width of the player container:</td>
<td>Width and height can be defined separatel width of the video is smaller than the video container, the canvas is filled in black.</td>
</tr>
<tr>
<td></td>
<td>[[File:samplename.mp4</td>
<td>600px]]</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="BlueSpicePlayer with 600px width" /></td>
<td></td>
</tr>
<tr>
<td>Loop</td>
<td>-</td>
<td>&lt;bs:showtime repeat=&quot;yes&quot;/&gt;</td>
</tr>
<tr>
<td>Autostart</td>
<td>-</td>
<td>&lt;bs:showtime autostart=&quot;yes&quot;/&gt;</td>
</tr>
<tr>
<td>Star/End</td>
<td>[[File:samplename.mp4</td>
<td>start=2</td>
</tr>
<tr>
<td>HTML-Output</td>
<td>embedded as &lt;video&gt; tag</td>
<td>embedded through nested &lt;div&gt; tags</td>
</tr>
<tr>
<td>Syntax /Parameter</td>
<td>EmbedVideo</td>
<td>BlueSpicePlayer</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Adjusts to mobile display</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>

### Player controls

<table>
<thead>
<tr>
<th>Feature</th>
<th>EmbedVideo</th>
<th>BlueSpicePlayer</th>
</tr>
</thead>
<tbody>
<tr>
<td>play button</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>progress bar</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>volume adjustment</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>fullscreen mode</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>picture-in-picture</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>download</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>speed adjustment</td>
<td>no</td>
<td>yes</td>
</tr>
</tbody>
</table>

## Supported video services

The following video services are supported by the extension EmbedVideo. In parentheses, you find the service names that are used with the tags `#evt` and `#ev`:

- Archive.org Videos (`archiveorg`), Bambuser (`bambuser`), Bing (`bing`), Blip.tv (`blip`), C3TV (`mediaccde`), CollegeHumor (`collegehumor`), Dailymotion (`dailymotion`), Disclose.tv (`disclose`), Daum TVPot (`tvpot`), Div Share (`divshare`), Facebook (`facebook`), FunnyOrDie (`funnyordie`), Gfycat (`gfycat`), Hitbox (`hitbox`), JW Player (`jwplayer`), Kickstarter (`kickstarter`), Metacafe (`metacafe`), Microsoft Stream (`microsoftstream`), Mixer (`mixer`), Nico Nico Video (`nico`), RuTube (`rutube`), SoundCloud (`soundcloud`), Spotify Album (`spotifyalbum`), Spotify Artist (`spotifyartist`), Spotify Song (`spotifytrack`), TeacherTube (`teachertube`), TED Talks (`ted`), Tubi TV (`tubity`), Tudou (`tudou`), Twitch (`twitch`), Videomaten (`videomaten`), Vimeo (`vimeo`), Vine (`vine`), Yahoo Screen (`yahoo`), YouTube (`youtube`), YouTube Playlist (`youtubeplaylist`), YouTube Video List (`youtubevideolist`), Youku (`youku`)

## Related info

- Mediawiki help page for the extension EmbedVideo
- Help page for the extension BlueSpicePlayer - only for video files that have been uploaded to the wiki
- Template to embed video using the Visual Editor toolbar
5.6.5 Hide page title

In some cases, it makes sense to hide the title of a page. For example, if you want to create a portal page. The extension *HideTitle* provides this feature for the wiki.

Contents

1 Usage ............................................................................................................................................. 169
2 Related info .................................................................................................................................... 170
Usage

In **VisualEditor**, go to *Page options > Advanced settings*.

![Setting the title visibility in VisualEditor](image)

Set the title visibility to *Hide* and Save the setting. This adds the magic word `__HIDETITLE__` in the source code, usually at the top of the page. After saving the page, the page title is hidden in view mode.
BlueSpice pro is your enterprise wiki for building a modern knowledge base: Open source, customizable and globally proven. Test our software for 30 days. We look forward to your feedback and questions.

You've got questions?
Florian Müller
sales@hallowelt.com
+49 (0)841 660 800

Webinars
Experience BlueSpice pro in a live demo.

Our webinars

Helpdesk
Application tips, orientation and help.

Go to helpdesk
5.7 Tag cloud

The extension TagCloud visualizes terms from your wiki based on importance. It can be included on any wiki page. The source for the tag cloud terms can be categories or searchstats.

<table>
<thead>
<tr>
<th>Profile information</th>
<th>User Handbook</th>
<th>Organization</th>
<th>QM-Document</th>
<th>Installation handbook</th>
<th>Technics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products</td>
<td>Staff Handbook</td>
<td>Wikissoftware</td>
<td>Work Instruction</td>
<td>Pages with broken links</td>
<td></td>
</tr>
<tr>
<td>Imported vocabulary</td>
<td>Quality management</td>
<td>Arbeitsanleitungen</td>
<td>Top Level</td>
<td>Pages with RSS feeds</td>
<td></td>
</tr>
</tbody>
</table>

Contents

1 Inserting a tag cloud ................................................................. 172
2 Configuration ................................................................. 172
  2.1 Common configuration ...................................................... 173
  2.2 Advanced configuration .................................................. 173
3 Examples ................................................................. 173
  3.1 Text ................................................................. 173
  3.2 3D canvas ................................................................. 174
  3.3 List ................................................................. 174
4 Related info ................................................................. 175
Inserting a tag cloud

A tag cloud can be inserted directly in source editing mode with the tag `<bs:tagcloud />`. To insert a tag cloud with VisualEditor, select Insert > Magic word > Tag cloud.

**Configuration**

If tag is added using VisualEditor, a configuration dialog appears. It shows configuration options in two tabs: Common and Advanced.
**Common configuration**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Display name</th>
<th>Description</th>
</tr>
</thead>
</table>
| renderer  | Type         | Mode of rendering the cloud  
  - List  
  - Text (font size depends on frequency)  
  - 3D: rotating, interactive view |
| width     | Width        | Part of the page width taken by the cloud in percent or pixels (e.g., 50%, 150px) |
| showcount | Show count   | Whether to show the numeric frequency of the term in the cloud |

**Advanced configuration**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Display name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>store</td>
<td>Store</td>
<td>Source of the data - category or searchstats</td>
</tr>
<tr>
<td>minsize</td>
<td>Min font size</td>
<td>Smallest possible font displayed in the cloud</td>
</tr>
<tr>
<td>maxsize</td>
<td>Max font size</td>
<td>Biggest possible font displayed in the cloud</td>
</tr>
<tr>
<td>exclude</td>
<td>Exclude pages</td>
<td>List of categories to exclude from the cloud, separated by comma - &quot;category1, category2, category3&quot;</td>
</tr>
</tbody>
</table>

**Examples**

**Text**

Tag parameters:

```html
<bs:tagcloud count="10" minsize="12" maxsize="34" exclude="Imported vocabulary, Project" />
```

Output:

Shows a tag cloud with the 10 (count) categories that have the most page associations. The smallest possible font-size is 12 pixels (minsize) and the largest possible font-size is 34 pixels (maxsize). The categories *Imported vocabulary* and *Project* have been excluded from the output. Since the data source *category* is the default for a tag cloud, it is not necessary to specify it in the tag.
**3D canvas**

Tag parameters:

```html
<bs:tagcloud renderer="canvas3d" store="category" count="15" minsize="12" maxsize="40" showcount="false" />
```

Output:

The renderer *canvas3d* produces an interactive tag cloud. The cloud rotates when the cursor hovers over the tag cloud. It shows the 15 (count) most tagged categories. It is important to set the count limit, since the default count is set to 40, which produces a 3D cloud where the results are hard to distinguish visually. The data source is set to category (store). This is optional, since category is the default store value. The font sizes range from 12 pixels (minsize) to 40 pixels (maxsize). How many pages and files are associated with each category is not shown (`showcount="false"`).

**List**

Tag parameters:

```html
<bs:tagcloud renderer="list" store="searchstats" count="5" />
```

Output:

The renderer type *list* produces a simple unordered list.
The tag cloud of type *list* ignores the following parameters: *minsize*, *maxsize*

**Related Info**

- Reference:BlueSpiceTagCloud
5.8 Diagrams

**Draw.io** offers extensive drawing possibilities for process flowcharts, infographics and other visualizations on a wiki page. Descriptive graphics like process chains or decision trees can be constructed directly on a wiki page.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Inserting a chart</td>
</tr>
<tr>
<td>2 Editing the drawing</td>
</tr>
<tr>
<td>3 About PNG and SVG files</td>
</tr>
<tr>
<td>4 Import of existing diagrams</td>
</tr>
<tr>
<td>4.1 Visio diagrams</td>
</tr>
<tr>
<td>4.2 SVG files</td>
</tr>
<tr>
<td>5 Using draw.io with image maps</td>
</tr>
<tr>
<td>6 Related info</td>
</tr>
</tbody>
</table>
Inserting a chart

To insert a drawing with VisualEditor:

1. Create or choose a page where you want to insert a drawing.
2. Select Insert > Magic word from the editor toolbar.
3. Choose drawio from the list of magic words.
4. Click Done. This opens a dialog box. Enter a name for your drawing.
5. Click Insert.

![Image of drawio editor](image)

This inserts the following tag in your source code:
```
{{#drawio:Name_of_the_flowchart}}
```

6. Save the page.

Editing the drawing

1. Click Edit on the saved page above the drawio placeholder to open the draw.io editor. For the best editing experience, set your wiki into full-screen mode using the toggle button in the main toolbar. You can now edit your drawing.

![Image of drawing editor](image)

2. Click Save in the draw.io window to save your drawing.
3. Click Exit next to the Save button in the draw.io window to close the draw.io editor.
About PNG and SVG files

In BlueSpice, draw.io diagrams are always saved in PNG format. It is currently not possible to save diagrams in SVG formats. If you have installed your wiki in-house (i.e., you are not working in the cloud), you can **activate SVG support via an additional extension**.

Import of existing diagrams

Visio diagrams

You can import files with the extension `.vsdx` directly into draw.io and edit them further. To do this, create an empty draw.io diagram on a wiki page. Save the empty diagram and then switch to draw.io's edit mode. From there, choose **File > Import From > Device**. You can then edit the imported diagram in draw.io.
SVG files

When you import an SVG file into the BlueSpice draw.io editor, it is automatically converted into PNG format and can, therefore, no longer be edited. It is also not saved as an SVG file in the wiki. As an alternative to importing it into draw.io, you should upload the SVG file to the wiki and embed it on a wiki page. The versioning of the file cannot be done directly in the wiki. The updated version of the SVG file would then have to be updated accordingly via the file page by uploading it again.

Using draw.io with image maps

Draw.io creates a versioned png-file in the File namespace. This means that every change of the flowchart creates a new, updated version of this png-file. You can integrate this file on another page in your wiki or create an image map.

**Note:** It is not possible to use an image map on the same page as a drawio-diagram.

Related info

- draw.io Website
- mediawiki.org/wiki/Extension:DrawioEditor
- Reference:DrawioEditor
5.9 Visual version comparison
5.10 PDF export

BlueSpiceUniversalExport allows exporting wiki pages to various formats. It incorporates various modules, each serving as exporter for a particular export type.

Contents

1 The export menu ....................................................................................................................................... 182
2 Modules .................................................................................................................................................. 182
3 Configuration ......................................................................................................................................... 182
4 Tags ....................................................................................................................................................... 183
   4.1 Manual page brea ............................................................................................................................ 183
   4.2 Landscape printing ........................................................................................................................... 184
   4.3 PDF-specific styling ....................................................................................................................... 185
   4.4 Exclude content from PDF export ................................................................................................. 186
5 Show content in PDF only ...................................................................................................................... 187
6 Display of email addresses .................................................................................................................... 187
7 Printing ................................................................................................................................................ 188
8 Related info .......................................................................................................................................... 188
The export menu

Every content page on the wiki can be exported. Export functions are located in the general page tools under the menu item Export. The available export options depend on your wiki configuration. Clicking one of the links downloads the page content in the selected format.

Modules

The extension BlueSpiceUniversalExport contains several modules:

- **BlueSpiceUEModulePDF**: module for exporting pages in PDF (.pdf) format. It downloads the current page (PDF single page), the current page including all its subpages (PDF page with subpages), or the current page and the pages that are linked from that page (PDF page with linked pages).
- **BlueSpiceUEModuleHTML**: module for exporting pages as an html zip-archive (option HTML single page).
- **BlueSpiceUEModuleBookPDF**: module for exporting books. This module is only available if BlueSpiceBookmaker is installed. It exports entire books in PDF format (available in the Book Manager).

Configuration

Configuration of UniversalExport (and its modules) can be done in the Config manager in the Export section. Available settings include:

- **Table of contents**: only applies to exporting books. Select how the ToC should be constructed (as a ToC for the entire book or for each page individually).
- **Hide namespace prefix in HTML**: removes namespace prefixes when displaying page titles in HTML exports.
- **Hide namespace prefix in PDF**: removes namespace prefixes when displaying page titles in PDF exports.
• **Metadata (standard, JSON)**: additional data to be passed to the rendering template in JSON format. This data will be available for usage in the template (advanced users).

• **Metadata (override, JSON)**: offers overriding standard data sent to the rendering template. Values that are set by default can be overridden by using this option (JSON format) (advanced users).

## Tags

If the following tags are included in a page, they are usually applied both to the PDF book export and to the PDF single page export unless otherwise noted.

### Manual page break

You can insert the following tag on a wiki page anywhere you want to force a manual page break in the PDF:

```
<bs:uepagebreak ></div>
```

In visual editing mode, a marker is displayed where the page breaks have been inserted.
Landscape printing

To print a PDF page in landscape format, the following tag can be inserted in the wiki page in source editing mode at any position:

```html
<bs:ueparams template="BlueSpice_Landscape" />
```

To make it easier for the user to add this tag with the visual editor, this tag can be added to a wikitext-template, for example, `{{LandscapeFormatExport}}`. The element can be inserted anywhere on the page.

**Note:** This tag only works for the PDF single page export.

Within a wiki page, individual areas can be marked separately (e.g. wide tables). This way, the output in the export can be landscape or extra-wide. This is possible using the following css classes:

- "bs-rotated" -> landscape format
- "bs-narrow" -> 0.33 x A4 portrait
- "bs-ultrawide" -> 2 x A4 landscape

These classes can also be combined. Example:

```html
<div class="bs-rotated bs-ultrawide">...
```

The start and end div tags can also be added to templates (e.g., `{{LandscapeStart}}` and `{{LandscapeEnd}}`) to allow users to insert the tags using the visual editor.

**Note:** Display of header and footer areas could be problematic when using these tags.

These css classes also work for the book export.
**PDF-specific styling**

**Important!** The tag is only taken applied in the single page export (including linked pages and subpages). The tag from individual pages is ignored in the book export. The tag can, however, be inserted on the corresponding book page in the *Book:* namespace and is then applied to all pages in the book.

To style classes or IDs only in the PDF output, you can include the following tag at the beginning of a page:

```xml
<bs:uemeta body-class=class-name-here/>
```
Example: **Changing background, header, and footer settings**

1. Insert the tag `<bs:uemeta body-class:bg-grey bg-yellow no-header-image no-footer-text/>` at the top of your wiki page.
2. To define the page background, add the following CSS to MediaWiki:Common.css (admin rights needed):

```css
/*PDF output*/
.bg-grey { background-color:#EDEDED !important; } /*sets the page background. There will be a white margin around it.*/
.bg-yellow .bs-page-content { background-color:#F7F0C6; padding:10px; } /*sets the background color for the content and adds padding*/
.no-header-image #bs-runningheaderfix { background:none; } /*removes the PDF header*/
.no-footer-text #bs-runningfooterleft, .no-footer-text #bs-runningfootercenter, .no-footer-text #bs-runningfooterright { display:none; } /*removes the text from the PDF footer*/
```

Compare the page before inserting the tag and after inserting the tag:

---

**Exclude content from PDF export**

To exclude the content of a page from the PDF export, it can be inserted via the visual editor under **Insert > No PDF**. The text is then marked accordingly in the source text:

`<bs:uenoexport>Dieser Text wird nicht ins PDF exportiert.</bs:uenoexport>`
Show content in PDF only

If content should only be displayed in the PDF, but not on the wiki page, this content can be marked manually via the source text. First, a wiki administrator needs to add the following code to the page MediaWiki: Common.css:

```css
.bs-page-content .no-pdf {
    display: none;
}
.bs-page-content div.only-pdf {
    display:block;
}
.bs-page-content span.only-pdf {
    display:inline;
}

.only-pdf {
    display: none;
}
```

A block element or an inline element can now be created for the PDF export. This content is not rendered on the wiki page in display mode. Source code examples:

```html
<div class="only-pdf">This block is only shown in the PDF.</div>
The adjective <span class="no-pdf">beautiful</span><span class="only-pdf">small</span>
is shown differently on the page and in the PDF.
```

Display of email addresses

If an email link has an additional label on a wiki page, the email address will be listed separately in the PDF after the link label.
Email

Contact us! (info@hallowelt.com)

PDF link in PDF output

Printing

MediaWiki, by default, provides a print view for the pages. This command is also available in the Export menu (option Print).

Related info

- Reference:BlueSpiceUniversalExport
- Reference:BlueSpiceUEModulePDF
- Reference:BlueSpiceUEModuleBookPDF
- Reference:BlueSpiceUEModuleHTML
- Creating books
6 Books

The extensions Bookshelf and BookshelfUI expand the BlueSpice distribution, combining wiki pages into a structured book with chapter navigation. These books can also be printed as a PDF file with a cover page and a clickable table of contents.

Contents

1 Characteristics of books ................................................................. 190
2 Book manager ........................................................................... 190
3 Creating a book ........................................................................ 191
  3.1 General books ................................................................. 192
  3.2 Own books ..................................................................... 192
  3.3 Temporary books ............................................................ 192
4 The book editor ........................................................................ 192
  4.1 Mass-adding pages ......................................................... 193
  4.2 Creating the chapter navigation ........................................... 194
5 Editing a book ........................................................................ 195
  5.1 Inserting meta data ............................................................ 196
  5.2 Adding a cover image ....................................................... 196
6 Exporting books .................................................................... 196
7 Configuration .......................................................................... 197
  7.1 Display options ............................................................... 197
    7.1.1 Export options ......................................................... 198
  7.2 Configuring the file size limits (server) .............................. 198
8 Deleting a book ....................................................................... 199
9 Duplicating a book ................................................................. 199
10 Permissions .......................................................................... 200
11 Tips for working with books .................................................. 200
12 Related info ........................................................................ 201
Characteristics of books

With BlueSpice Pro, you can assemble individual wiki pages into a book. In a book, you can read through a collection of pages in a linear fashion by moving through the book navigation. This is useful if you have lots of related pages that should be read in a particular order. And it makes it easy to write documentation and to comply with your documentation standards. All the books that are available on the wiki are accessible through the left navigation menu, tab "Books" with the book icon. Books are displayed as list or grid view. Clicking on a book opens the selected book. Once the book is opened, its chapter navigation appears in the left navigation.

Book manager

The menu item *Global Actions > Book manager* loads the page Special:BookshelfBookManager. Here, you can add a new book by clicking the *plus* button.
You can take the following actions on a book:

- **Editing a book** (1): Links to the Book editor where you can edit the book contents and metadata.
- **Duplicating a book** (3): Duplicates this book, including all the pages of the book.
- **Export** (4): Exports the wiki pages in this book to PDF.
- **Assign** (5): Assigns the book to designated users.

### Creating a book

To create a book:

1. **Go to** *Global actions > Book manager.*
2. **Select** the *Create (+)* button.
3. **Enter** a *Book title* and the *Type of the book*:
   - *General books*: Visible to all users. It should have a book navigation.
3. **Own books**: Books only visible to me.
4. Click **Done**.

### General books

General books are visible to all users and are usually characterized by their additionally generated book navigation.

### Own books

Own books are only visible in the book list to the book creator. You cannot create chapter navigation in the navigation bar for your own books. However, like general books, your own books can be exported as a PDF with a title page.

### Temporary books

This selection is available to wiki users who are logged in or not logged into the wiki. These books are only temporarily stored in the user's browser and not in the wiki itself. If the browser cache is deleted or the user switches to another browser, the book is no longer available. The main aim of temporary books is to enable users to print out a book as a PDF.

A chapter navigation cannot, therefore, be created for temporary books.

### The book editor

After that, the book editor opens. Here you can add pages to your book by clicking the **plus** button. A dialog opens, where you can select the pages you want to add to your book. You can also enter the name of a page that doesn't yet exist.
Mass-adding pages

After clicking "Mass add", a dialog is opened. It contains different criteria for page selection:

- All pages of a category
- All subpages of a certain page
- From a page collection - page collections are lists of pages located in the MediaWiki namespace. They are usually created from search results.
- By a semantic property - pages can be selected based on the value of a certain semantic property.

After adding your book pages click Save at the bottom of the page. Now you have created a page in the namespace Book. It contains the list of pages that have been added to the book.
Creating the chapter navigation

After saving a book page, you have created a wiki page in the namespace Book which contains a list of links to the wiki pages in the book. The chapter navigation is generated separately.

To add the chapter navigation, go back to the book page in the book manager. Clicking on the book title opens the book page in the book editor. Scroll down to the Save button and select the drop-down arrow. Click Save and add book navigation to each wiki page.

This adds a bookshelf tag in the source code of all wiki pages that are part of this book. The tag, therefore, defines which book this page belongs to:

```html
<bookshelf src="Book:EmployeeManual"/>
```

Bookshelf tag in the source code
**Note:** If you later add more pages to a book, you have to generate the chapter navigation again. Without this step, the newly added pages will not have a bookshelf tag and therefore not be shown in the chapter navigation of the book. If you only added one or two new pages, you can also add the bookshelf tag manually to the source code of these new pages.

**Important!** Each wiki page can only be added to one book. If a page later is added to another book with chapter navigation, the page always leads to the chapter navigation of the book that last generated or updated its chapter navigation.

**Editing a book**

After you have created the book, click on the name of the book. This opens the *Book Editor*.

Editing a book is is similar to creating a new book regarding adding pages to the book. Pages can also be removed from a book by right-clicking on the page name and selecting *Delete from book* (this will not delete the wiki page itself). Chapters - and the general book structure - can be re-arranged by dragging and dropping pages in the book structure. By dragging and dropping Page A over Page B, Page A will be placed underneath Page B in the book hierarchy.

**Book Editor: Employee Manual**

- **Book Manager** (1): Link to the main *Book manager* page (only up to v3.1).
- **Show source wikipage** (2): Opens the book navigation page in view mode (only up to v3.1).
- **Edit source wikipage** (3): Opens the book navigation page in edit mode (only up to v3.1).
- **Add page** (4): Button for adding a page.
- **Mass-add pages** (5): Button for adding a set of pages (by category, subpages of a page, page collection, or semantic property).
- **Remove page** (6): Removes the selected pages.
- **Manage metadata** (7): Add or remove metadata.
- **Export selection** (8): Exports the selected pages to a PDF file.
- **Book contents** (9): Shows all pages in the book hierarchy. Pages can be arranged by drag-and-drop. A multi-level organization is possible.
Inserting meta data

While editing a book (adding or removing pages), meta-data for the book can be added. To edit metadata, select top-most node of the book (first page) and click the wrench icon. A dialog will be opened where various meta-data can be added or removed. Some of the most important meta-data include:

- Title
- Subtitle
- Author 1 and 2
- Document-ID
- Document type
- Department
- Version
- Template (PDF)
- Table of Contents (Only article titles, or Embed article TOCs)

Adding a cover image

To add a cover photo for the book, add a metadata item *Bookshelf image*. Select this option from the dropdown and click *Add*. Once the meta data is added enter the name of the image in the value field. Any image currently uploaded to the wiki can be used. Type the name without the "File:" prefix (enter the image name and file extension).

Exporting books

You can export an entire book, individual chapters or single pages as PDF:

- Open the book in the book editor.
- Select all pages or chapters you want to export by clicking the associated checkboxes. Subchapters will be automatically selected.
- Clicking on the "Export selection" dropdown menu opens a list of available formats. By clicking on one of the formats offered the book export starts.
Configuration

Display options

- **Show book chapter pager after content**: Displays previous/next book page navigation at the end of each book page. (1)
- **Show book chapter pager before content**: Displays previous/next book page navigation at the beginning of each book page. (2)

- **Use the display title from book source on article**: Shows the title from the book navigation as page title instead of the page name.
Note: If the page additionally contains a {{DISPLAYTITLE}} tag, the display title of the page is shown instead of the book title.

- Prepend article table of contents and headlines with book numberation
- Supress namespace prefix of book articles in output

Export options

Extension: DynamicPageList (DPL), version 3.3.2: Warning: No results.

Configuring the file size limits (server)

By default, the book export is limited to 50MB in file size. To adjust this value, complete the following steps:

1. In Apache Tomcat, open the file `web.xml`:

   ```bash
   sudo -s
   nano /opt/tomcat/webapps/manager/WEB-INF/web.xml
   ```

2. Look for the following lines and adjust the value (e.g. for 250MB=26214400)

   ```xml
   <max-file-size>262144000</max-file-size>
   <max-request-size>262144000</max-request-size>
   ```

3. The web app BShtml2PDF also has a setting that needs to be adjusted:

   ```bash
   nano /opt/tomcat/webapps/BShtml2PDF/WEB-INF
   ```

4. Enter your values in the following lines:

   ```xml
   <param-name>maxMemSize</param-name> <param-value>26214400</param-value>
   <param-name>maxFileize</param-name> <param-value>26214400</param-value>
   ```

5. Apache Tomcat neu starten

   ```bash
   service tomcat restart
   ```
Deleting a book

When you delete a book, you only remove the book page in the namespace Book from the Book manager. The wiki pages in the book, however, are not deleted. Before you delete the book, you are informed in a pop-up menu that the bookshelf tag is not automatically removed from the pages:

The bookshelf tags have no effect on the wiki pages after deleting the book. If you want to remove them manually, you can go to the page Special:ReplaceText and do a find and replace to delete the booktag from the pages.

Duplicating a book

You can create an entire copy of the book by duplicating it:

To duplicate a book:

1. **Enter** a target name: The default value is the book name with the suffix (copy). Change this to create a different book title.
2. **Select** a namespace: Choose a namespace that is different from the original namespace.

If you are not careful, you might experience some unintended consequences. By creating a new book, you also create copies of all the wiki pages in the original book. Since a namespace cannot contain the same page twice, you have to copy the files to a different namespace.
About the duplicated files:

- **Book page:** A new page in the namespace book. If you don't enter a new title, the book will be created with the same title and the suffix (*Copy*). E.g. *Employee Manual (Copy)*. This file includes a copy of the structure of your original book with the corresponding links to the duplicated pages in the new copy.
- **Wiki pages:** All pages contained in the original book are duplicated. The following scenarios are possible:
  - **Same namespace:** If you duplicate a book in the same namespace, no actual duplicates of the actual wiki are created. Instead, the bookshelf tag is updated to point to the copy of the book. For example, if your original book contains the page *HR:Quality assurance* (the book is in the namespace HR), the *Quality assurance* page now contains the bookshelf tag `<bs:bookshelf src="Book:Employee Manual (Copy)" />`.
  - **Different namespace:** If you create the book copy in a different namespace, the bookshelf tag in the original files remains unchanged. The new pages in the different namespace are created with a bookshelf tag for the new book copy. This is most likely the scenario you want.

Permissions

To create and edit books, users need *edit* rights in Book namespace. Additionally, a user can only add pages to the book that that user can read. If a user tries to export a book to PDF that contains pages for which the user does not have permissions, the user will get an error message.

Tips for working with books

- Use a competent team to decide on the content that should be transferred into an online book.
- Decide on how to handle existing numerations or references.
- Seize the opportunity: Get rid of unnecessary content (or don’t include it in your book).
- Decide on standards for documents: When does it make sense to link documents in the wiki? When is it sensible to include the document's content into a wiki article?
Decide on a fitting course of action: Do you want to create the articles in the wiki first, and compile them in a book structure afterwards, or do you want to create the book structure first, and create and edit the articles contained gradually?

Related info

- Reference:BlueSpiceBookshelf
- Reference:BlueSpiceBookshelfUI
- Customizing page breaks
# 7 Quality assurance

## Contents

1. The importance of content quality ................................................................. 203
2. Page information ........................................................................................................... 203
3. Page assignments ........................................................................................................... 204
4. Reminder ....................................................................................................................... 204
5. Expiry ............................................................................................................................ 204
6. Review ............................................................................................................................ 205
7. Acceptance ..................................................................................................................... 205
8. Permissions overview ................................................................................................. 206
9. Related info .................................................................................................................... 209
The importance of content quality

For many companies, the quality of the information they produce and share is of great importance. At the same time, they want to capture all the knowledge of their employees without creating any unnecessary barriers.

In BlueSpice, many users can contribute their knowledge. Ideally, anyone can contribute information right away and specialists can then review and approve the content. This ensures that the quality of the content meets the standards of the company. You should always weigh the benefits and drawbacks of individual quality management features so that you don’t create unnecessary roadblocks for users who are eager to contribute.

To access these features, you open the QM tools (with the checkbox icon) in the Page tools panel.

For quality assurance purposes, each content page has the following built-in tools:

- Page information
- Page assignments
- Reminder (BlueSpice pro)
- Expiry (BlueSpice pro)
- Review (BlueSpice pro)
- Acceptance (BlueSpice pro - if FlaggedRevs is activated for the namespace)

Page information

The page information gives you some very interesting statistics about the page. Based on this information, you can decide what quality management measures are necessary to improve the page.

The information that is listed on this page is:

- time of last edit and last editor
- number of views
- templates used on this page
- similar pages
- categories
- readers of this page
- authors of this page
Page assignments

Page assignments are a quick way of giving one or more users informal responsibility and ownership of a page. They are very similar to a watchlist. A user can add a page to their watchlist themselves, but assignments are made by other users.

Page assignments do not change the behavior of the page or grant special rights on a page. For example, the page does not get locked for editing when it is assigned to another user. It is rather a simple mechanism to have users "take a look" at a page. If the feature Read confirmation is activated for a namespace, assigned users have to confirm with a checkbox on the page that they have read the page.

Characteristics

- **Notifications** are sent to assigned users when their page assignment is changed. (This can be deactivated in the user preferences.)
- **Transparency:** Assigned users are listed in the QM tools panel of the page
- **Assignment management:** ([Special:ManagePageAssignments](#))
- **Quick access** from the user profile menu
- **Read confirmation:** page shows a read confirmation checkbox for assigned users (optional)

More about page assignments

Reminder

A user can create a reminder for a page by selecting a reminder date and by adding an optional comment. Reminders can also be created for other users by administrators and are a quick and informal way of setting due dates for page-related tasks.

Characteristics

- The user with the reminder receives a notification. (This can be deactivated in the user preferences.)
- Users with reminders are listed on the reminders for the page in the QM tools.
- The page is listed on the Reminders special page under "Global actions" ([Special:Reminder](#)).
- The page is listed on the user's Reminders page, which is easy to access from the user profile menu.

Expiry

If a page contains content with a known lifecycle, the page can be set to expire on a particular date. On the expiration date, a watermark "Outdated" is added to the page if the corresponding option is set in the ConfigManager. In addition, a reminder can be set so that the user will receive a notification when the page expires. The expiration can be deleted from the page at any time.

Characteristics
Watermark on page background and in PDF (can be configured)
Management list: Special:Expiry
Reminder possible
Duration: Expiry can be removed at any time

Review

When a more formal review process is necessary, users can create a review workflow. The review workflow has an end date and is the only quality management tool that can lock the page for editing during the review phase. Each user casts a vote whether the page is acceptable or not.

The page is listed on the special page "Review" under "Global actions" (Special:Review) and on the reviewers' personal Review page.

Characteristics of the review feature

- **One active review process** per page
- **Types:** Sequential or parallel review
- **Acceptance** or rejection by participants
- **Page is locked** for editing (Exception: depending on the configuration, reviewers can get edit rights)
- **Automatic restart** possible
- **Revisions-based:** Entries in the version history
- **Acceptance:** can be combined with the Acceptance feature

Acceptance

If the pages in a namespace should have a published and a draft version, the setting FlaggedRevs needs to be activated for that namespace. This activates the Acceptance feature of the quality management tools.

All changes to a page are collected in a draft version until any user with review rights accepts the page. The pages in this namespace are in draft mode until a user with the right to publish content accepts the page.

There is a global option in the ConfigManager to define which user groups are allowed to read unpublished content. By default, all logged-in users can view drafts.

Characteristics of the acceptance feature

- **Revisions-based:** First draft, draft, accepted
- **External files:** "Freezes" embedded media and templates
- **Automatic acceptance:** Often the result of a review process
- **Permissions:** Read permissions can (cautiously) be limited
## Permissions overview

This permissions table shows which roles have the necessary right to perform different quality assurance actions. The name of the right that grants a certain permission is shown in parentheses:

<table>
<thead>
<tr>
<th>QA action</th>
<th>user (read)</th>
<th>editor</th>
<th>reviewer</th>
<th>admin</th>
<th>maintenance-admin</th>
<th>bot</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can create and manage</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>page assignments</strong></td>
<td>for any user</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(pageassignments)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can be assigned to a page</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(pageassigneable)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can create and</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Permissions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage reminders for any user (remindereditall)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can create and manage their own reminders (read)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can set and manage page expiration dates (expirearticle)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can create and manage review workflows (workflowedit)</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can be assigned to a <strong>review workflow</strong> <em>(read)</em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can view the <strong>review workflow</strong> on the page <em>(workflowview)</em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can view the complete <strong>list of reviews</strong> <em>(workflowlist)</em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Can <strong>approve</strong> a page <em>(review)</em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Related info

- Working with drafts (Flagged revisions)
- The review workflow
7.1 Page information

**BlueSpiceArticleInfo** contains meta information about a content page.

| Contents |
|-------------------------|-----------------------------------------------|
| 1 View the page information | ......................................................................... 211 |
| 2 Configuration          | ......................................................................... 211 |
| 2.1 Output               | ......................................................................... 212 |
| 3 Related info           | ......................................................................... 212 |
Viewing the page information

The lists of meta information about a page are displayed in the page information flyout of the quality management tools.

The following information is available:

- Time of the last edit
- Last editor
- Number of views
- The categories the page belongs to. These can be edited directly from here.
- Templates used on the page
- Subpages of a page (visible only when the page actually has subpages)

Configuration

In Config manager, you can change the update frequency for this information. Here, you choose Extension from the select menu and then BlueSpiceArticleInfo.
Output

BlueSpiceArticleInfo, together with BlueSpiceAuthors, BlueSpiceReaders, and BlueSpiceExtendedSearch is part of the Page information in the quality management tools.

- **Update interval in seconds**: Sets the refresh rate for the "Last edit" value. By default, this date is updated every 10 seconds via JavaScript.

Related info

- Reference:BlueSpiceArticleInfo
7.2 Page assignments

The extension **PageAssignments** allows users with assignment rights to assign other users to a page.

### Contents

1. What are page assignments? ................................................................. 214
1.1 Characteristics ................................................................................. 214
2 Assigning a page ................................................................................ 214
3 Assignment management .................................................................. 215
4 Secured page assignments ................................................................. 216
5 My assignments ................................................................................. 216
6 Related info ....................................................................................... 216
What are page assignments?

Page assignments are a quick way of giving one or more users informal responsibility and ownership of a page. They are very similar to a watchlist. A user can add a page to their watchlist themselves, but assignments are made by other users.

Page assignments do not change the behavior of the page or grant special rights on a page. For example, the page does not get locked for editing when it is assigned to another user. It is rather a simple mechanism to have users "take a look" at a page. If the feature Read confirmation is activated for a namespace, assigned users have to confirm with a checkbox on the page that they have read the page.

Characteristics

- **Notifications** are sent to assigned users when their page assignment is changed. (This can be deactivated in the user preferences.)
- **Transparency**: Assigned users are listed in the QM tools panel of the page
- **Assignment management**: (Special:ManagePageAssignments)
- **Quick access** from the user profile menu
- **Read confirmation**: page shows a read confirmation checkbox for assigned users (optional)

Assigning a page

To assign pages to other users, you need the appropriate rights. These are assigned via the roles reviewer and maintenanceadmin. Although users with read permissions can be assigned to a page, they cannot make changes to the page.

To assign a user or a group to a page:

1. Click on Page assignments in the Quality management toolbar.
2. Type a user or group name in the assignments text box. You will get automatic suggestions based on your entry.
3. Click the Add button.
4. Add more users or groups (optional).
Assignment management

Users with assignment rights can see a list of all pages that have assignments. This page (Special: ManagePageAssignments) can be loaded from the navigation menu under Global actions > Management > Assignment management
Secured page assignments

In the namespace manager you can configure that page assignments are secured. If a page is created in such a namespace, the page is only editable for users that are assigned to this page. This means that every new page should be created by a user with reviewer or admin rights, because only these roles have the necessary rights to make the assignment. If a page is created in this namespace by a user with edit rights, this page cannot be edited further by this user, unless he/she is assigned by a to the page.

My assignments

Every user can view the pages they are assigned to by clicking on "Assignments" in their personal menu (by clicking on their image in the upper right corner).

Related info

- Reference page
7.3 Reminders

The extension **Reminder** allows users to keep track of pages by creating reminders for a particular date.

## Contents

1. Setting a reminder .................................................................................................................. 218
2. Manage reminders ............................................................................................................... 218
3. My reminders ....................................................................................................................... 219
4. Related info ......................................................................................................................... 219
Setting a reminder

Reminders are set in the quality management tab of the page tools. The date can be set as a recurring event. It is a good idea to add some text in the comments page so that the list of all reminders on the wiki provides some context for each reminder. If other users have also set a reminder for the page, they are shown on the reminder flyout as well.

From the bottom of the page, users can load the pages Manage reminders and My reminders.

Manage reminders

Available only for wiki admins, the page Special:Reminder shows a list of all reminders for all pages and all users. Wiki admins can delete reminders or edit the due date and other details.
Reminder manager for wiki admins

My reminders

The page `Special:Reminder/USER_NAME` shows the reminders for the currently logged-in user. It has the same functionality as "Manage reminders", just in the scope of the current user.

Related info

- Reference:BlueSpiceReminder
7.4 Review workflows

If you have a page that has to be reviewed by others before it should be published, you can use the review workflow of the page. The review can be started for pages with or without the revisions feature. If the revisions feature is turned on for the namespace in which the page is located, the page will be in draft mode and locked for editing until the review end date has been reached.

During the review phase, assigned reviewers will "vote" on the page and either accept or reject the page. If the extension BlueSpiceReviewExended is installed, the workflow can run sequentially or parallel for the reviewers and the reviewers can be allowed to edit the page. A reviewer also has the option to delegate a review task to a different user.

Use case: A basic review workflow

Anna and Phil are responsible for all content of the IT department of their company. They have many responsibilities and are not always able to create their IT wiki pages. They task Laila, the company’s intern, to write the draft for the new holiday policy. They tell Laila that she can include images on the page to make the page more eye-catching. Laila is happy about this task and gets to work right away. Anna reminds Laila to keep Phil in the loop and to have any images on the page reviewed by someone in marketing.
The review workflow consists of the following steps:

1. **Laila (author):** After finishing the changes to a page, Laila starts the review cycle for that page. Laila decides that Phil needs to proofread the page first, then Malik in Marketing will approve the images. Finally, Anna gives the okay to publish the page. Since Anna is very busy, Laila has set the workflow to run for 14 days. She sets the workflow so that all reviewers have to review the page in sequential order.

2. **Phil (first reviewer):** Phil proofreads the page and adds the correct categories to the page (IT, Policy). He then closes his review task by accepting the page.

3. **Malik (second reviewer):** Malik adds some professional graphics to the page and accepts the page.

4. **Anna (third reviewer):** Anna doesn't have time to review the document, since it is not one of her priorities. She delegates the final vote to Phil.

During the review period, the page has the following characteristics:

- It is **locked for editing** for the entire duration of the review period. Exception: The extension `BlueSpiceReviewExtended` allows the option to have the reviewers edit the page during the review period. In our example, the reviewers can make changes.
- It displays an alert message: "Page is currently being reviewed."
- The Review menu item in the QM tools shows "Review in progress".
- When a reviewer opens the QM tools, he is alerted by a "Vote!" notice on the Review menu item.
- For each reviewer who has completed their review, their action is shown under "recent workflow steps" on the review page.
- It is listed on the special page `Special:Review`.

**Technical requirements**

The following extensions and configurations are part of the review functionality:

- Extension: `BlueSpiceReview`
- Extension: `BlueSpiceReviewExtended`
- Config manager > Extension > `BlueSpiceReview` / `BlueSpiceReviewExtended`
7.5 Expiry

**Expiry** marks a wiki page as "obsolete". The page can be updated by editing or by confirming that the page is still up-to-date. Expiry is the ideal basis for an archiving system. Outdated articles can be moved to an archive after being queried. Expiry can be set on any content page of the wiki.

## Contents

1 Expiring a page ................................................................................................................................. 224
2 Overview of expired wiki pages ....................................................................................................... 225
3 Configuration ..................................................................................................................................... 226
4 Related info ...................................................................................................................................... 226
Expiring a page

Expiry for a page can be set from the *Quality management* tab in the page tools. After clicking on "Expiry", a form opens in a fly-out layer.

If the page has already been expired, the expiration date is shown. In this case, a user can remove the expiration from the page by clicking on *Unexpire the page*.

If no expiration date is set, users can set an expiration date and enter a short comment: In addition, the user can create a *reminder* for the page. After saving the form, the page is reloaded and updated information is displayed.
Overview of expired wiki pages

Users can see all of the pages set to expire, along with expiry information for those pages on `Special:Expiry` page. This page can be accessed from the Expiry flyout described above, by clicking on Expiry manager at the bottom of the flyout. All expiration dates can be deleted or edited from this page.
Configuration

In the Config manager, you can change the following settings:

- **Show watermark for expired pages in PDF**: Shows the watermark for expired pages in PDFs.
- **Show watermark for expired pages in print version**: Shows the watermark for expired pages when a page is printed.
- **Show watermark for expired pages**: Shows a watermark on the page itself.

Related info

- Quality assurance
- Reference:BlueSpiceExpiry
7.6 Acceptance

The extension **FlaggedRevs** is a MediaWiki extension that activates an approval mechanism.
New versions of a page are initially marked as drafts and remain so until a user with review rights approves the page.

## Contents

1. What are page drafts? .................................................................................................................. 228
2. Activating the acceptance feature ............................................................................................ 228
   2.1 Existing pages .................................................................................................................. 228
   2.2 New pages ......................................................................................................................... 229
3. Accepting a page ...................................................................................................................... 229
4. Setting read permissions for drafts .......................................................................................... 231
5. Changes to embedded templates and files .................................................................................. 233
   5.1 Approving a resource ......................................................................................................... 234
6. Settings for resources on approved pages ................................................................................ 234
7. Effects on Semantic MediaWiki properties ............................................................................... 235
8. Quality management overview ................................................................................................. 236
9. Related info ................................................................................................................................ 236
What are page drafts?

In BlueSpice, you can create draft versions of a page. After a page has been edited and saved in draft mode readers of the page will, by default, see the most recently accepted version of the page. This allows editors to work on a draft version until all changes "fit". The changes can then be approved by users with reviewer rights.

By default, all users can see the latest draft version by clicking on the status information of a page or by switching to the version history. It is possible to limit view permissions of drafts to specific user groups.

Activating the acceptance feature

Activating the acceptance feature is done on the namespace level. A user with admin permissions activates the feature in Global actions > Management > Namespace manager for individual namespaces. The dialog window opens after clicking the edit icon (wrench) in the Actions column. Select Approval and click Done.

Existing pages

After activating Approvals for a namespace, all pages in the namespace are set into first draft mode.
Draft banner notice (1) and page status information in the status bar (2).

Each page in the namespace now displays a banner at the top of the page with the acceptance status (1) and a quick link to publish the page (2).

**New pages**

When a new page is created and first saved, it will automatically be visible to all users. Subsequent page edits will be collected in the draft version of the page. If a page is edited and saved multiple times while in draft mode, each edit gets logged in the version history:

The revisions in draft status have a dotted border and are highlighted in orange. In addition, they are marked as *pending review*. These revisions can be compared before the pending changes of the page are accepted.

**Accepting a page**

Users with *review* rights can accept a draft page any time they save a page (*Accept this unreviewed page*):
Accepting pending changes

If the page is not accepted at this point, it can be accepted independently from the editing process.

A user with *review* rights can accept the page quickly with the review feature in the title section of the page. The draft message will display an arrow which includes the *accept* function:

Accepting a draft from the title section

Alternatively, the reviewer can go to the Acceptance page in the Quality Management toolbar instead:

Accepting a draft from the QM-Tools
In both cases, the reviewer can leave a comment. This comment will then be shown in the version history of the page.

The page now shows the page version as accepted.

Setting read permissions for drafts

By default, all users can see the drafts of a page, even readers.

To hide drafts from readers, the group `user` has to be removed from the configuration. An administrator deletes the group user form "Show unstable pages for the following groups" in *Global actions > Management > Config manager*.
**Warning:** If the group *user* is removed from the *BlueSpiceFlaggedRevs* configuration, users in this group will not be able to see draft versions when they are added as reviewers in a review process.

When the group user is removed, only *sysop* and *reviewer* users can access drafts. If you want other groups, for example *editor*, to see draft versions, you need to add them to the configuration and save it:
The two checkboxes *Automatically set the page to stable*... (checkbox is available until version 3.1.) and *Automatically delete the workflow*... determine what happens at the end of a workflow, if there is an active Review for a page. A page can be set to accepted status by a workflow and the workflow can be deleted after the page is marked as stable.

**Note:** If no user groups are specified in the configuration field, not even reviewers and sysops users will see a visual status indication of a page. They will have access to drafts through the revision history of a page instead.

Anyone with edit permissions will receive a notification that there are pending changes for the page when they access the page in edit mode:

**Changes to embedded templates and files**

If a page includes templates or files such as images or PDFs and there is a change to these files after the page has been approved, this will also be reflected in the status banner (1) and the QM status information in the title area (2).
If the embedded resources are located in a namespace without its own approval function, the version of the resource at the time of page approval is displayed in the approved version of the page. The draft version accordingly shows the most current version of the embedded resource. To approve the resource change, the page has to be approved again. This creates a new page version.

**Approving a resource**

Before approving the changed resource(s), you should check which resources are affected.

1. **Open** the quality management tools (1). Here you can see under Approval that there are changes to resources (2).
2. **Click** on a changed resource (3) to display the changes between the last two versions of the resource.
3. **Click** “Review now” (4) under Unapproved changes. This will take you to the draft version of the page. From there you can approve the page in the title area. **Note**: If there are several changed resources, they can only be approved together.

**Settings for resources on approved pages**

It is possible via server configuration to show embedded resources (i.e., files, templates or transcluded content) that were changed after the page has been released, in a certain version. The following options exist:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Shows the resource version that was valid when the page was approved.</td>
</tr>
</tbody>
</table>
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FR_INCLUDES_FREEZE</td>
<td><strong>Warning:</strong> The setting FR_INCLUDES_FREEZE for handling the state of included files of an approved wikipage has no long term support by and should not be introduced in a new wiki for that reason.</td>
</tr>
<tr>
<td>FR_INCLUDES_STABLE</td>
<td>Always shows the latest approved (stable) version of a resource, even if it was approved after the page was approved (this works only if the resource is located in a namespace with active approval feature).</td>
</tr>
<tr>
<td>FR_INCLUDES_CURRENT</td>
<td>Always shows the latest version of the included resource.</td>
</tr>
</tbody>
</table>

### Important!

Results of a semantic query, unlike attribute values cannot be "frozen", even if FR_INCLUDES_FREEZE has been set. The query results do not persist in the source text of a page, but are generated dynamically at the time of the query. As a consequence, they are not available for versioning.

### Effects on Semantic MediaWiki properties

Wenn in einem Namensraum gleichzeitig mit der Seitenfreigabe auch Semantic MediaWiki aktiviert ist, sind je nach Freigabestatus der Seite folgende Attribute für SMW-Abfragen verfügbar:

<table>
<thead>
<tr>
<th>Document state</th>
<th>Available properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>First draft</td>
<td>Current values</td>
</tr>
<tr>
<td>Approved</td>
<td>Values of the approved (stable) version</td>
</tr>
<tr>
<td>Draft</td>
<td>Values of the approved (stable) version (default setting)</td>
</tr>
<tr>
<td>Implicit draft</td>
<td>Values of the approved (stable) version</td>
</tr>
</tbody>
</table>

The availability of the semantic properties is determined by the following configuration setting:

```php
$bsgFlaggedRevsConnectorStabilizeSMWPropertyValues = true;
```

The value for this setting can be set to `false` in the `LocalSettings.php` of the server file system. If set to `false`, the property values of the draft version are used for semantic queries instead of the values for the stable version.
Quality management overview

The Special page `Special:Quality_management_overview` allows users with `admin` or `reviewer` rights to view and filter a list of wiki pages and their review status.

Special page Quality management overview

Related info

- Quality management tools
- Reference:FlaggedRevs
- Reference:BlueSpiceFlaggedRevsConnector
- Manual:Semantic MediaWiki

1. An approved page has an implicit draft, if there have been changes to embedded resources (e.g., a template or an image) since the last page approval.
7.7 Category check

Contents

1 Using the category check ................................................................. 238
2 Related info ................................................................................. 239
The extension **CategoryCheck** reminds users to assign a category to a page before saving it.

### Using the category check

To use this feature, it must first be enabled for individual namespaces in the **Namespace manager**.

![Namespace manager](image)

When saving a page in a namespace that has the category check enabled, the user is reminded to assign a category before saving. This message only appears if the page does not have at least one category assigned. The page can still be saved without assigning a category, but the user must explicitly check the "Ignore" checkbox.
Warning notice when saving the page

Related info

- Reference:BlueSpiceCategoryCheck
7.8 Read confirmation

The extension **ReadConfirmation** allows to request read confirmations from users. If a user is assigned to a page, a mandatory read confirmation can be added to the page.

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Enabling read confirmations</td>
<td>241</td>
</tr>
<tr>
<td>2 Display</td>
<td>241</td>
</tr>
<tr>
<td>3 Administration of read confirmations</td>
<td>242</td>
</tr>
<tr>
<td>4 Read confirmation in connection with page approval</td>
<td>242</td>
</tr>
<tr>
<td>5 Related info</td>
<td>242</td>
</tr>
</tbody>
</table>
Enabling read confirmations

An administrator must enable read confirmations for the namespace the page belongs to. This can be set using the **Namespace manager**:

![Namespace manager](image)

**Activating read confirmations in a namespace**

Display

![Read confirmation checkbox](image)

**Read confirmation checkbox**
When read confirmations are active on a namespace, assigned users see a confirmation prompt. After checking the checkbox *Yes, I have completely read this article* and clicking *Confirm*, the page will be marked as read by that user.

**Administration of read confirmations**

Wiki admins can see an overview of all read confirmations by navigating to *Global actions > Management > Assignment management*. Read confirmation information is shown in the column *Read on*. A page can have multiple states:

- **Read confirmation not enabled**: BlueSpiceReadConfirmation is not enabled for the namespace to which the page belongs.
- **Not read**: BlueSpiceReadConfirmation is enabled, but the assigned users have not yet read the page.
- **Actions**: In the columns for actions, there are two items related to read confirmations.
  - *Read confirmation log*: Link to the read confirmation log for the page.
  - *Request read confirmation*: Users get a reminder for their read confirmation.

**Read confirmation in connection with page approval**

If the approval feature is activated in a namespace at the same time, the read confirmation is triggered when a new draft is created. This can be changed via server configuration so that the read confirmation is required after the draft page has been approved.

**Related info**

- Reference: BlueSpiceReadConfirmation
### 7.9 Page signatures

The extension **BlueSpiceSignHere** allows you to quickly sign off a wiki article. It enhances and automatizes built-in MediaWiki functions that allow users to leave their signature on the page.

#### Contents

1. Inserting the tag ........................................................................................................................................ 245
2. Restrictions ........................................................................................................................................ 246
3. Related info .......................................................................................................................................... 246
Inserting the tag

While in edit mode, add (usually on the bottom), the following tag in source edit mode.

<bs:signhere />

Alternatively, you can insert the tag in visual editing mode with VisualEditor. Select Insert > Magic Word and select signhere:

Once the page is saved, every user who visits the page sees the field for Signatures.
Signatures line

By clicking on this field, the user's signature is automatically inserted. The signature shows the username as defined in the user's preferences as well as the timestamp of the signing. Signatures appear in chronological order of signing.

**Restrictions**

Every user's signature is added to the page in plain text, as it would be when using the built-in MediaWiki signature function. While it may not be obvious to users reading the page, all users with edit rights can add or remove signatures. As a safe-guard against such actions, the page history log shows when signatures were added.

**Related info**

- Reference:BlueSpiceSignHere
7.10 Watchlist

With the watchlist, you can monitor all wiki pages that are important to you. In your preferences, you can customize when and how to be notified about different types of changes related to the pages on your watchlist. Your watchlist is only visible to you. Administrators can see a report of which pages are not on any watchlist.

Contents

1 Watching and unwatching pages ................................................................. 248
1.1 Automatic additions .............................................................................. 248
2 Settings .................................................................................................. 249
3 Watchlist quick view .............................................................................. 249
4 Classic watchlist .................................................................................... 250
5 Notifications .......................................................................................... 251
6 Sidebar widget ....................................................................................... 251
7 The watchlist tag ................................................................................... 252
8 Related info ............................................................................................. 252
Watching and unwatching pages

In the title section of a page, you can add the page to your watchlist. Click *Watch* to add the page to the watchlist. The link description switches to Unwatch. Click *Unwatch* to remove the list from your watchlist.

**Automatic additions**

In addition to manually marking a page watched, there are several ways a page can be added automatically. For example, whenever you create or edit a page, that page can be added to the watchlist. You can change the options for this in the *Watchlist settings* in your Preferences.

**Important!** If you have deactivated the setting *Add pages and files I edit to my watchlist* in the settings, the check box *Watch this page* in the save dialog is not automatically activated. If you do not manually activate this checkbox when saving a page, a page that was on your watch list will be removed from the watch list when you save. Conversely, each page is automatically added to your watch list if this check box is selected by default. When saving, always check whether the edited page should (still) be on your watchlist.

A page is removed from the watchlist
Settings

Go to your user menu. Click Preferences and select the tab Watchlist to access the following settings:

- **Edit watchlist**: Links to the maintenance pages for the watchlist.
- **Display options**: Default settings for showing pages in your watchlist that have recently changed.
  - You can set 3-90 days of page changes.
  - You can set 250-1000 watchlist results.
- **Advanced options**: Settings for automatically adding pages to the watchlist or hiding page changes from the watchlist.
- **Watchlist token**: The token can be used to create a public RSS feed to your watchlist. Anyone who knows this token can access the feed. The syntax for the feed URL is: https://[YourWikiDomain]/w/api.php?action=feedwatchlist&wloowner=[USERNAME]&wltoken=[TOKEN]

Watchlist quick view

You can open a quick view of your watchlist from the user profile menu.

This opens an overlay with a filterable and sortable view of your watchlist directly on the current page. The watchlist indicates what pages on your pages have changes that are unread by you. Clicking on the icon for unread changes leads to the version comparison page so that you can quickly review the changes you haven't seen yet.
Watchlist overlay

**Classic watchlist**

From this overlay display, you can switch to the classic view of the watchlist. This loads the page *Special:Watchlist*:

At the top of the Watchlist page are some important edit links and information about your watchlist settings:

- **View relevant changes**: This is the default watchlist page. It displays the filter menu with the legend.
- **View and edit watchlist**: Here you can delete entries from your watchlist.
- **Edit raw watchlist**: Loads an editable list of the page names on your watchlist.
- **Clear the watchlist**: Loads a page that clears your watchlist in the next step. Clicking this link will not clear the watchlist yet.
**Classic view of the watchlist page**

**Note:** Since many social entities are created automatically by the system, changes to pages in the namespace SocialEntity are filtered out by default. You can remove the filter to view changes to pages in this namespace.

**Notifications**

You can get notifications about all changes on that page.

To receive notifications, go to your *Preferences* and open the *Notifications* tab. You can select to get notifications about the following changes:

- **Actions on pages in watchlist:** A page was edited or deleted.
- **Entity actions on watched pages:** A discussion topic or an attachment was added, edited, or deleted.

**Sidebar widget**

The watchlist is, by default, included in the **user sidebar**. It can be removed by deleting the entry `*WATCHLIST*`.

---

09.01.2022 This document was created with BlueSpice Page 251 of 331
The watchlist tag

You can include the watchlist in the page content by adding the tag `<bs:watchlist />`.

Example:

```html
<bs:watchlist count="4" maxtitlelength="20" order="time" />
```

Output:

Related info

- Reference:BlueSpiceWatchList
7.11 QR Codes

The extension **QrCode** creates a QR code on each content page of the wiki. A QR Code (also Quick Response code) is a technology that was developed for the logistics needs of Toyota.

**Using the QR code**

Users can open a wiki page quickly on their mobile device by simply scanning the QR code on their desktop page. In addition, the QR code for a wiki page can be attached to a product or included on a printed page. Scanning the QR code on the product or the page leads directly to the wiki page.

The QR Code added by this extension is located in the page tools menu under **QR Code**. To open the current wiki page with a mobile phone, simply scan it directly from the screen or from a printed page or packaging:

![QR Code](image)

**Related info**

- Reference: BlueSpiceQrCode
8 Maintenance

Contents

1 Wiki maintenance made easy ........................................................................................................ 255
2 Permissions ................................................................................................................................... 255
3 Content monitoring ........................................................................................................................ 255
4 Accessing the maintenance pages ................................................................................................ 256
Wiki maintenance made easy

Hopefully, your wiki content grows quickly and your users are busy adding and editing content. The faster your wiki grows, the more it becomes necessary to ensure that both your wiki content and its organization meet the requirements of your wiki audience. After all, the hard work everyone has put into the wiki so far should be reflected adequately. Your users don't want to waste any time when looking for information about a particular topic.

Luckily, the search engine is powerful enough to find the best matches to a user's search term. So even if you are falling a little behind with your wiki maintenance, users should still find their way around the wiki. But you can do a lot to make the user experience even better.

If you are tasked with maintaining the usability and content quality of your wiki, there are several types of tools to help you with this task.

Permissions

Any user with edit rights can view the special pages that are relevant for wiki maintenance. An exception is the special page Quality management overview. This page lists all pages that are in draft or accepted status and requires reviewer rights. This page only has entries if the FlaggedRevs feature is activated for at least one namespace and the user has access to that namespace.

Content monitoring

The quality management tools make the life of a wiki maintaner much easier. All wiki users can take advantage of the built-in features such as the watchlist, reminders, page assignments and the review workflow, for example. This helps users to take ownership of the wiki content right from the beginning. This works well on a page-by-page level.

As users link, move and delete pages, it becomes necessary, however, to monitor these changes. Over time, some pages might become neglected and add to the outdated content on your wiki.

To keep your content fresh, you should regularly take advantage of the maintance pages of the wiki. The majority of these pages are part of MediaWiki and documented on MediaWiki.org. Use the searchbox on their website to find out more. Some maintance pages are exclusive to BlueSpice, such as WikiExplorer, Assignment management and Quality management overview.
Accessing the maintenance pages

To view the most important maintenance pages, switch to the *Global actions* navigation. This navigation view contains the two menus *Global actions* and *Management*. Both menus contain useful links to the most common special pages. Click on *Special pages* to access the complete list of maintenance and reports pages:
8.1 Special pages

Manual:Special pages
8.2 Redirects

Contents

1 What is a redirect? ......................................................................................................................... 259
2 When to use a redirect .................................................................................................................. 259
3 How to redirect a page .................................................................................................................. 259
  3.1 With visual editing .................................................................................................................... 259
  3.2 With source editing .................................................................................................................... 260
4 Managing page redirects ............................................................................................................ 260
5 Resolving double redirects ........................................................................................................ 260
6 Related info ................................................................................................................................... 262
What is a redirect?

A redirect is a technique to automatically forward users from one page to another. If you redirect a page that has content, the user will not see the content of the redirected page, but only the content of the target page.

When to use a redirect

Pages are usually redirected in the following cases:

- abbreviations
- synonyms
- duplicate content
- spelling variants
- plural/singular
- renaming/moving a page

How to redirect a page

With visual editing

1. Go to Page settings:

   ![Page settings dialog]

2. In the dialog window, activate the checkbox "Redirect this page to" and enter the name of the target page:

   ![Redirect page settings]

3. Click "Apply changes"
**With source editing**

At the beginning of the page, insert the redirect instruction and save the page:

```
#REDIRECT [[pagename of target page]]
```

There is no need to delete the content of the page. The content is simply no longer visible to readers as long as the redirect is included on the page. If you remove the code for redirecting the page, the original content will be loaded again.

**Managing page redirects**

All redirected pages on the wiki are listed on the special page **Special:ListRedirects**. In addition, there are pages for broken redirects as well as double redirects in the maintenance reports on the Special pages.

You can navigate to them from *Global actions > Special pages*.

To maintain the quality of your wiki, you should review these pages on a regular basis and fix any broken and double redirects.

If you navigate to a redirected page, it shows the redirect. A rounded arrow points to the target file:

---

**Resolving double redirects**

The page *Special:DoubleRedirects* lists all pages that are redirected from an already redirected page:
Double redirects

This page lists pages that redirect to other redirect pages. Each row contains links to the first and second redirect, as well as the target of the second redirect, which is usually the "real" target page to which the first redirect should point. Crossed-out entries have been solved.

Showing below up to 50 results in range #1 to #50.

View (previous 50 | next 50) (20 | 50 | 100 | 250 | 500)

1. Get creative - Working with information (edit) → Create pages → Manual Create pages
2. Edit existing articles (edit) → Create pages → Manual Create pages

Let's look at the page Edit existing articles in the BlueSpice helpdesk. This page is redirected to a page Create pages that is again redirected to Manual: Create pages. The double redirect was caused by moving the page Create pages to the namespace Manual.

To resolve the double redirect, we open the page Edit existing articles in source view:

```
#REDIRECT [[Create pages]]

==Edit existing articles==
Every existing article in a wiki should be modifiable. Simply switch into edit mode, change the contents, and save. Easy!

---Entering edit mode---
You have two options to edit an article:
```

The page is not only redirected to the page Create pages but also contains a bookshelf tag. Therefore, we first check if the page is still part of the book. If it is, we need to decide if the book should include this page or the actual final target page of the redirect instead.

We now have some options to fix the redirect:

- Redirect to the final target page
- Redirect to a completely different page
- Delete the page

Since the helpdesk actually has an updated page about editing, we redirect to the page Manual: Edit pages:

```
#REDIRECT [[Manual:Edit pages]]

==Edit existing articles==
```

09.01.2022 This document was created with BlueSpice  Page 261 of 331
Sometimes, it might make more sense to simply delete the page. Before deleting an article, always check what other pages link to the page by reviewing the info under [Special:WhatLinksHere/Redirects].

**Related info**

- Rename and move pages
- Delete an article
- Creating subpages
8.3 WikiExplorer

The extension WikiExplorer allows to quickly filter and sort all Wiki pages based on your own filter criteria. WikiExplorer combines the functionality of many maintenance pages. By combining different filters, you can quickly find matching pages.

Contents

1 Accessing WikiExplorer ................................................................. 264
2 Choosing the sorting criteria ....................................................... 264
3 Sorting sequence ................................................................. 264
4 Using filters ......................................................................... 264
5 Related info ......................................................................... 265
Accessing WikiExplorer

To access Wiki Explorer, go to *Global actions* and select *WikiExplorer*. This opens the special page *Special:WikiExplorer*.

Choosing the sorting criteria

Sorting criteria and visible columns can be changed by clicking on the arrow icon in the header of any list column.

Sorting sequence

Clicking on the header of any column (not on the arrow) sorts the table based on the values of that column. Changing the sorting order (ascending, descending) can be switched by clicking on the header multiple times.

Using filters

For some content, there are specially adapted filters available which can be used to sort the list. Filters can be accessed by clicking on the "arrow" icon in the column that should be filtered.

The following columns support filtering:

<table>
<thead>
<tr>
<th>Content</th>
<th>Possible filters</th>
<th>Sortable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title (Page name)</td>
<td>starts with, ends with, contains, contains not, equals, equals not</td>
<td>Yes</td>
</tr>
<tr>
<td>Namespace</td>
<td>starts with, ends with, contains, contains not, equals, equals not</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Possible filters

<table>
<thead>
<tr>
<th>Content</th>
<th>Possible filters</th>
<th>Sortable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accesses</td>
<td>less than, greater than, equals</td>
<td>Yes</td>
</tr>
<tr>
<td>Creation date</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Is redirect</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Last comment</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Last edit date</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Size</td>
<td>less than, greater than, equals</td>
<td>Yes</td>
</tr>
<tr>
<td>Last editor</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Categories</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Linked files</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Linked pages</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Links to this page</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Assigned editors</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Released</td>
<td>yes, no</td>
<td>Yes</td>
</tr>
<tr>
<td>Release date</td>
<td>less than, greater than, equals</td>
<td>Yes</td>
</tr>
<tr>
<td>New version waits for release</td>
<td>None</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Related info

- [Reference:BlueSpiceWikiExplorer](#)
9 Social wiki

Contents

1 User profile .............................................................................................................................................. 273
2 Timeline .................................................................................................................................................. 273
  2.1 Creating new entries .................................................................................................................. 273
  2.2 Interacting with social entities .................................................................................................. 273
  2.3 Editing and deleting entities ..................................................................................................... 274
3 Blog ...................................................................................................................................................... 274
4 Page attachments .................................................................................................................................. 274
5 Page discussions .................................................................................................................................... 275
6 Rights ..................................................................................................................................................... 275
7 Deactivating the comments feature ................................................................................................. 276
8 Related info .......................................................................................................................................... 276
**BlueSpiceSocial** is a set of extensions that add social features around a wiki page. It allows users to quickly communicate on the wiki and to express their opinion on pages.

## User profile

Every user has a profile on the wiki. It is displayed on the user page (`User:Username`). Users can access their user profiles by clicking on *My profile* in the user menu which is located in the header toolbar.

The user profile shows the user's basic information (depending on the wiki setup) and the user's profile image. Below the user info, the user's wiki activities are listed: Comments the user made, actions on pages, and in general the user's activity on the wiki. It also allows other users to leave comments on the user's profile page.

## Timeline

Timeline is a special page that provides an overview of all social conversations on the wiki.

By default, it is listed on the *Main navigation*. You can also access the page directly at [Special:Timeline]. On this page, users can sort and filter existing social entries or create new entries.

### Creating new entries

To create a new entry, click on the "Plus" icon to add a new timeline entry:

- **Blog entry**: Blog is used for topics to be shared with other users on the wiki
- **Microblog**: Like a blog entry, but without titles. It should be used for a short entry, e.g., a quick announcement.
- **Discussion topic**: Adds a discussion entry to a particular wiki page.

### Interacting with social entities

Every entry in the timeline is called a social entity. Depending on the type of social entity, the following interaction options exist:

- **Comments**: Number of comments related to the entity. Clicking on *Comments* opens all current comments and allows users to add a comment (if user has the necessary permissions).
- **Recommend**: Number of users that recommended the entity. Users can add a recommendation by clicking on *Recommend*.
• **Linked articles:** Number of articles linked to this entity. Clicking on *Linked articles* shows the list of linked articles.

• **Watch/Unwatched:** Shows if the user is currently watching the entity (the user receives notifications when the entity is changed). Clicking on Watch or Unwatch changes the state of watching.

• **Resolved/Unresolved:** The status of the entity. Some entities, like discussions on a question, can have a status attached to them, so that other users know if the question is answered.

**Editing and deleting entities**

Users can edit and delete their own entities (created by them) by clicking on the "3 dots" icon in the top right corner of the entity.

---

**Blog**

*Blog* is a special page showing an overview of all blog entities available on the wiki. By default, it is listed on the *Main navigation*. You can also access the page directly at *Special: Blog*. Users can sort and filter the list entries by clicking on the icons above the list.

Learn how to [include the blog on any wiki page](#).

---

**Page attachments**
For every content page on the wiki, BlueSpiceSocial integrates an attachments section. This section shows the files that are related to the particular page. Users can add or remove files to and from this section by clicking on the "..." icon at the bottom of the section. Clicking on this icon links to Special: Attachments/Page_name, which allows managing the files attached to a particular page.

Users can attach files that are already uploaded to the wiki by clicking on the "Plus" button and selecting a file. Or, users can upload new files to be attached by dropping files into the marked area or by clicking the same area to select the files to upload.

This page also shows the history of file attachments for the page.

Page attachments can be disabled in the Page by adding the MagicWord __NOSTASH__ to the page in source editing mode.

Page discussions

Like page attachments, BlueSpiceSocial integrates a discussion section at the bottom of every wiki page. This section allows users to create comments directly on a wiki page without having to switch to the discussions page. If it is the first entry in a discussion, the discussion page is automatically created at this time.

The discussion section can be disabled in the Page by adding the MagicWord __NODISCUSSION__ to the page in source editing mode.

Rights

From BlueSpice version 3.2.7 the following roles have associated "social" permissions. Earlier versions have no option to limit the creation and editing of blog entries by using the role commenter.

<table>
<thead>
<tr>
<th>Rechte/Rolle</th>
<th>commenter</th>
<th>editor</th>
<th>admin</th>
<th>maintenance-admin</th>
<th>Berechtigung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and edit blog entry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>social-blog</td>
</tr>
<tr>
<td>Comment on blog entry</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td>social-blog-comment</td>
</tr>
<tr>
<td>Rechte/Rolle</td>
<td>commenter</td>
<td>editor</td>
<td>admin</td>
<td>maintenance-admin</td>
<td>Berechtigung</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------</td>
<td>--------</td>
<td>-------</td>
<td>-------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Create and edit microblog entry</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>social-microblog</td>
</tr>
<tr>
<td>Comment on microblog entry</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>social-microblog-comment</td>
</tr>
<tr>
<td>Create discussion entry</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>social-topics</td>
</tr>
<tr>
<td>Comment on discussion entry</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>social-topics-comment</td>
</tr>
<tr>
<td>Create and edit attachments</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>social-stash</td>
</tr>
</tbody>
</table>

The comments function for blog, microblog and discussion entries can be deactivated in the LocalSettings file on the server.

### Deactivating the comments feature

The comment function for comments on blog, microblog and discussion entries can be deactivated in the LocalSettings file on the server.

```
$bsgSocialCanHaveChildrenBlacklist = [
    'blog', // disable comments on blog
    'topic', // disable comments on discussion topics
    'microblog' // disable comments on microblogs
];
```

**Related info**

- Blog
- Discussions and Attachments
- Social comments
- User Profile
- Reference: BlueSpiceSocial
# 9.1 Overview

## Contents

1. User profile .................................................................................................................. 273  
2. Timeline ....................................................................................................................... 273  
   2.1 Creating new entries ............................................................................................... 273  
   2.2 Interacting with social entities ............................................................................... 273  
   2.3 Editing and deleting entities ................................................................................... 274  
3. Blog .................................................................................................................................. 274  
4. Page attachments ......................................................................................................... 274  
5. Page discussions ........................................................................................................... 275  
6. Rights ............................................................................................................................. 275  
7. Deactivating the comments feature ............................................................................. 276  
8. Related info .................................................................................................................... 276
BlueSpiceSocial is a set of extensions that add social features around a wiki page. It allows users to quickly communicate on the wiki and to express their opinion on pages.

User profile

Every user has a profile on the wiki. It is displayed on the user page (User:Username). Users can access their user profiles by clicking on My profile in the user menu which is located in the header toolbar.

The user profile shows the user's basic information (depending on the wiki setup) and the user's profile image. Below the user info, the user's wiki activities are listed: Comments the user made, actions on pages, and in general the user's activity on the wiki. It also allows other users to leave comments on the user's profile page.

Timeline

Timeline is a special page that provides an overview of all social conversations on the wiki.

By default, it is listed on the Main navigation. You can also access the page directly at Special:Timeline. On this page, users can sort and filter existing social entries or create new entries.

Creating new entries

To create a new entry, click on the "Plus" icon to add a new timeline entry:

- **Blog entry**: Blog is used for topics to be shared with other users on the wiki
- **Microblog**: Like a blog entry, but without titles. It should be used for a short entry, e.g., a quick announcement.
- **Discussion topic**: Adds a discussion entry to a particular wiki page.

Interacting with social entities

Every entry in the timeline is called a social entity. Depending on the type of social entity, the following interaction options exist:

- **Comments**: Number of comments related to the entity. Clicking on Comments opens all current comments and allows users to add a comment (if user has the necessary permissions).
- **Recommend**: Number of users that recommended the entity. Users can add a recommendation by clicking on Recommend.
- **Linked articles:** Number of articles linked to this entity. Clicking on *Linked articles* shows the list of linked articles.
- **Watch/Unwatched:** Shows if the user is currently watching the entity (the user receives notifications when the entity is changed). Clicking on Watch or Unwatch changes the state of watching.
- **Resolved/Unresolved:** The status of the entity. Some entities, like discussions on a question, can have a status attached to them, so that other users know if the question is answered.

### Editing and deleting entities

Users can edit and delete their own entities (created by them) by clicking on the "3 dots" icon in the top right corner of the entity.

![Adding new entries](image)

### Blog

**Blog** is a special page showing an overview of all blog entities available on the wiki. By default, it is listed on the *Main navigation*. You can also access the page directly at [Special:Blog](Special:Blog). Users can sort and filter the list entries by clicking on the icons above the list.

Learn how to [include the blog on any wiki page](include-the-blog-on-any-wiki-page).
For every content page on the wiki, BlueSpiceSocial integrates an attachments section. This section shows the files that are related to the particular page. Users can add or remove files to and from this section by clicking on the "..." icon at the bottom of the section. Clicking on this icon links to Special:Attachments/Page_name, which allows managing the files attached to a particular page.

Users can attach files that are already uploaded to the wiki by clicking on the "Plus" button and selecting a file. Or, users can upload new files to be attached by dropping files into the marked area or by clicking the same area to select the files to upload.

This page also shows the history of file attachments for the page.

Page attachments can be disabled in the Page by adding the MagicWord __NOSTASH__ to the page in source editing mode.

Page discussions

Like page attachments, BlueSpiceSocial integrates a discussion section at the bottom of every wiki page. This section allows users to create comments directly on a wiki page without having to switch to the discussions page. If it is the first entry in a discussion, the discussion page is automatically created at this time.

The discussion section can be disabled in the Page by adding the MagicWord __NODISCUSSION__ to the page in source editing mode.

Rights

From BlueSpice version 3.2.7 the following roles have associated "social" permissions. Earlier versions have no option to limit the creation and editing of blog entries by using the role commenter.

<table>
<thead>
<tr>
<th>Rechte/Rolle</th>
<th>commenter</th>
<th>editor</th>
<th>admin</th>
<th>maintenance-admin</th>
<th>Berechtigung</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and edit blog entry</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>social-blog</td>
</tr>
<tr>
<td>Comment on blog entry</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>social-blog-comment</td>
</tr>
</tbody>
</table>
The comments function for blog, microblog and discussion entries can be deactivated in the LocalSettings file on the server.

**Deactivating the comments feature**

The comment function for comments on blog, microblog and discussion entries can be deactivated in the LocalSettings file on the server.

```php
$bsgSocialCanHaveChildrenBlacklist = [
    'blog', // disable comments on blog
    'topic', // disable comments on discussion topics
    'microblog' // disable comments on microblogs
];
```

**Related info**

- Blog
- Discussions and Attachments
- Social comments
- User Profile
- Reference: BlueSpiceSocial
9.2 Blog

The extension `BlueSpiceSocialBlog` is part of `BlueSpiceSocial`, the communication module of BlueSpice. In addition to the type blog, there are other types of so-called social entities, such as *comment*, *discussion topic*, *attachment*, or *microblog*.

**Contents**

1. About the blog ........................................................................................................................................... 278
2. Adding the blog to a page ......................................................................................................................... 278
3. Blog parameters .......................................................................................................................................... 279
   3.1 Output format .......................................................................................................................................... 279
   3.2 Sorting ..................................................................................................................................................... 282
      3.2.1 Syntax ................................................................................................................................................ 282
      3.2.2 Properties ......................................................................................................................................... 282
      3.2.3 Direction .......................................................................................................................................... 282
   3.3 Filtering ................................................................................................................................................... 283
4. Output type examples .................................................................................................................................... 283
   4.1 Default ................................................................................................................................................... 283
   4.2 Short ....................................................................................................................................................... 283
   4.3 Page ....................................................................................................................................................... 284
   4.4 List ......................................................................................................................................................... 285
5. Configuration ................................................................................................................................................ 285
6. Related info .................................................................................................................................................. 286
About the blog

Basically, a blog is a list of comments, questions, or feedback from different users. The blog is often sorted chronologically downwards, in the sense of a public journal. A lively communication can arise when the contributions are further commented, recommended, linked with related articles or placed on a personal watchlist.

The blog function is ready for use on the special page `Special:Blog`. This page is linked directly from the main navigation in every new wiki installation. So you can start using the blog right away.

It is also possible to include the blog functionality on any wiki page. Social contributions of many types can be consolidated and displayed chronologically in a timeline and filtered and sorted as needed.

Adding the blog to a page

If you want to include a view of your blog on another page of your wiki, for example your homepage, you need to insert the necessary codeblock in the source code of your page.

To include a blog view:

1. Go to the page where you want to insert the blog or create a new page.
2. Open the page in `Source editing` mode.

3. Copy the following code block to the section in your page where you want to show the blog.

```xml
<bs:timeline>
{
    "showentitylistmenu": true,
    "preloadtitles": {
        "blog": "Vorlage:Blog"
    },
    "preloadedentities": [{
        "type": "blog"
    }],
    "headlinemessagekey": "Community-Blog",
    "showheadline": true,
    "usemorescroll": false,
    "morelink": "Special:Blog",
    "limit": 5,
    ...
```
After saving the page, you will see a list of existing blog entries based on the filter and sorting criteria you provided.

Blog parameters

Output format

The following table shows the blog elements and the necessary parameters to create the output:

<table>
<thead>
<tr>
<th>Element</th>
<th>Parameters</th>
<th>Parameter and element description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - header</td>
<td>headlinemessagekey</td>
<td>Header text</td>
</tr>
<tr>
<td></td>
<td>showheadline</td>
<td>Show the header text</td>
</tr>
<tr>
<td>Element</td>
<td>Parameters</td>
<td>Parameter and element description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>showentitylistmenu</td>
<td>Show or hide the blog menu</td>
<td></td>
</tr>
<tr>
<td>showentitiespawner</td>
<td>Show the menu item for creating a blog entry</td>
<td></td>
</tr>
<tr>
<td>availablesorterfields</td>
<td>Determines which data fields are included as sorting options in the sort menu</td>
<td>&quot;availablesorterfields&quot;: [&quot;timestampcreated&quot;, &quot;ownerid&quot;]</td>
</tr>
<tr>
<td>lockedoptionnames</td>
<td>Determines which settings for sorting the user cannot change.</td>
<td></td>
</tr>
<tr>
<td>availablefilterfields</td>
<td>Determines which data fields are included as filter options in the filter menu</td>
<td>&quot;availablefilterfields&quot;: [&quot;timestampcreated&quot;, &quot;tags&quot;]</td>
</tr>
<tr>
<td>lockedfilenames</td>
<td>Determines which settings for filtering the user cannot change.</td>
<td>&quot;lockedfilenames&quot;: [&quot;tags&quot;]</td>
</tr>
<tr>
<td>2 - blog menu</td>
<td>Initial settings and custom sort and filter settings are included in the page url to create a link to the page with the same filter and sort settings.</td>
<td>&quot;persistsettings&quot;: true</td>
</tr>
<tr>
<td>Element</td>
<td>Parameters</td>
<td>Parameter and element description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>persistsettings</td>
<td></td>
<td>Shows the text field for creating a new blog entry. If it is not set, the text field is not available. To show the text field:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;preloadedentities&quot;: [&quot;type&quot;:&quot;blog&quot;]</td>
</tr>
<tr>
<td>3 - new blog entry</td>
<td>preloadentities</td>
<td></td>
</tr>
<tr>
<td>4 - existing blog entry</td>
<td>outputtypes</td>
<td>It defines the display format of the blog entry. Standard types are: <em>List</em>, <em>Short</em>, <em>Default</em>, <em>Page</em>. <em>(see examples)</em> Each blog entry is a &quot;social entity&quot;.</td>
</tr>
<tr>
<td></td>
<td>limit</td>
<td>Defines how many social entities are loaded initially.</td>
</tr>
<tr>
<td>4a - avatar</td>
<td></td>
<td>Shows the avatar of the user who created the blog entry or comment. It is only displayed in all output types except <em>List</em>.</td>
</tr>
<tr>
<td>4b - title bar</td>
<td></td>
<td>In the output type <em>List</em>, the username is not displayed in the title bar.</td>
</tr>
<tr>
<td>4c - blog entry content</td>
<td></td>
<td>Shows the text body of a blog entry. The output type <em>Default</em> collapses the first paragraph with a &quot;More&quot; link.</td>
</tr>
<tr>
<td>4d - social tags</td>
<td></td>
<td>Blog entries always include the social tags <em>Comments</em>, <em>Recommend</em>, <em>Linked Page</em>, <em>Watch/Unwatch</em>.</td>
</tr>
<tr>
<td>4e - user menu</td>
<td></td>
<td>Users can edit or delete their own blog entries or comments at any time. They can edit their own entries:</td>
</tr>
<tr>
<td>5 - new comment</td>
<td></td>
<td>Text field for creating a new comment.</td>
</tr>
<tr>
<td>6 - existing comment</td>
<td></td>
<td>Comments include the social tag <em>Recommend</em>. Each comment is a &quot;social entity&quot;.</td>
</tr>
</tbody>
</table>
Table: Element Parameters
<table>
<thead>
<tr>
<th>Element</th>
<th>Parameters</th>
<th>Parameter and element description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 - &quot;more&quot; button</td>
<td>morelink</td>
<td>Link target of the &quot;more&quot; button. For blogs, it makes sense to link to the page Special:Blog.</td>
</tr>
<tr>
<td></td>
<td>useendlessscroll</td>
<td>More blog entries are automatically loaded after the user scrolls to the end.</td>
</tr>
<tr>
<td></td>
<td>showentitylistmore</td>
<td>Shows a &quot;more&quot; button below the blog which loads more blog entries on click if useendlessscroll is set to false.</td>
</tr>
</tbody>
</table>

**Sorting**

Most commonly, a blog shows the latest blog entries first. However, there are many different options for sorting the list of blog entries.

**Syntax**

```json
[{  
  "property": "timestamptouched",
  "direction": "DESC"
}]
```

**Properties**

There are some common properties of a blog entry that are useful for sorting:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>timestampcreated</td>
<td>creation date</td>
</tr>
<tr>
<td>timestamptouched</td>
<td>last edit date</td>
</tr>
<tr>
<td>commentcount</td>
<td>number of comments</td>
</tr>
<tr>
<td>ratingcount</td>
<td>number of ratings</td>
</tr>
<tr>
<td>ownerid</td>
<td>username of the creator of a blog entry</td>
</tr>
<tr>
<td>ownerrealname</td>
<td>real name of the user</td>
</tr>
</tbody>
</table>

**Direction**

Blog entries can be sorted in descending and ascending order. Descending is the default order.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESC</td>
<td>sorts the blog entries in descending order</td>
</tr>
<tr>
<td>ASC</td>
<td>sorts the blog entries in ascending order</td>
</tr>
</tbody>
</table>
Filtering

Without setting the filter parameter, there will be no output on the page.

To show the blog entries of your wiki, include the following codeblock like shown in the code example above:

```
"filter": [ {
  "type": "list",
  "property": "type",
  "value": [ "blog" ],
  "comparison": "ct"
}]
```

This filter includes all social entities which match the type blog. Since we only want to show social entities of type blog, we only include blog entries in our filter. If you want to create a social timeline rather than a blog view, you can also add other types of social entities. The following example shows a timeline view that includes blog entries, discussion entries from wiki pages, and user profile information:

```
"filter": [ {
  "type": "list",
  "property": "type",
  "value": ["blog","topic","profile"],
  "comparison": "ct"
}]
```

Output type examples

The output type for a blog is added using the outputtypes parameter. Don't forget to include a comma before and after this parameter (unless this is the last parameter in your code):

```
"outputtypes": {
  "blog": "Default"
}
```

Default

The output type Default shows the content of a blog entry truncated after the first paragraph. To view the full text, users can click on the More link.
The output type *Short* does not show the content of the blog entry. To view the content, a user has to click on the title of a blog entry. This loads the actual page for the selected blog entity.

The output type *Page* shows all blog elements, including the comments, in an expanded view.
List

The output type *List* only shows the title and the timestamp.

- **Suggestion for improving search results** Created one hour and 56 minutes ago by Testuser

- **Greg Rundlett über BlueSpice** Created 2 months ago

Configuration

In the Config manager, you can change the following settings:

- **Use teaser text for blog entries in the timeline**: When you create a blog entry, you can create a teaser text for it by clicking the cogwheel symbol in the blog entry form. If this setting is active, the teaser text will be shown on the page *Special:Timeline* instead of the first part of the content.
Related info

- Micro-Blog
- Discussions and Attachments
- Discussion topics
- Social comments
- User Profile
- Linked pages
- Reference: BlueSpiceSocial
9.3 Microblog

Microblogs work exactly like regular blogs. Unlike blogs, however, they do not have a separate title field. Users simply provide a quick message in a single text field.

**Microblog syntax**

To include a microblog on a page, copy the following tag. An explanation of the individual parameters is available on the help page for blogs:

```html
{{#tag:bs:timeline|
  
  "showentitylistmenu": false,  
  "preloadedentities": [{  
    "type": "microblog"
  }],
  "headlinemessagekey": "Letzte Kurznachrichten",  
  "showheadline": false,  
  "limit": 3,  
  "sort": [{  
    "property": "timestampcreated",  
    "direction": "DESC"
  }],
  "lockedfilternames": [  
    "type"
  ],
  "outputtypes": {  
    "microblog": "Default"
  },
  "filter": [  
    {  
      "type": "list",  
      "property": "type",  
      "value": [ "microblog" ],  
      "comparison": "ct"
    },  
    {  
      "type": "boolean",  
      "property": "archived",  
      "value": false,  
      "comparison": "eq"
    }
  ]
}}
```

This produces a microblog that looks like this:
Microblog with open text input field

**Related Info**

- Blog
- Discussions and Attachments
- Discussion topics
- Social comments
- User Profile
- Reference:BlueSpiceSocial
9.4 Attachments

The extension SocialWikiPage allows users to attach a file directly to a wiki page.

Contents

1 Characteristics of file attachments .................................................................................................................. 290
2 Attaching a file .................................................................................................................................................. 290
3 Deleting an attachment ..................................................................................................................................... 291
4 Grouped attachments ......................................................................................................................................... 292
5 Styling ............................................................................................................................................................ 292
6 Related info ..................................................................................................................................................... 293
Characteristics of file attachments

- The attachment process simply creates an association between a file in your wiki and the page to which it is attached.
- File attachments don't show up in the version history of a page.
- Clicking on an attachment, for example a PDF file, opens the file directly (if possible). If the file type is docx or xlsx, the file is downloaded since it cannot be opened in the browser.
- Administrators can still see attachments that have been deleted from a page. These attachments are marked with a red background and can be reactivated if needed.
- The Timeline can list all attachments in the wiki.

Attaching a file

To create the first attachment at the bottom of a wiki page, open the attachments area by clicking on the "plus" button.

If the attachments area already exists, click the "more"-button to switch to the attachments page.

On the attachments page you can add a new attachment:

1. **Add existing file**: Click the plus button to add a file that has already been uploaded to the wiki.
(2) **Upload a new attachment**: Click the upload area or drag the file into the upload field to upload a new attachment to the wiki.

![Attachments](image)

**Deleting an attachment**

To delete an attachment, go to the attachments page and click on the Delete button in the actions menu of the attachment. Deleting an attachment on a page does not delete the file itself from the wiki.

![Delete attachment](image)
Grouped attachments

Clicking the Edit button in the actions menu of an attachment allows you to group more attachments with it. When you group attachments, they are:

- displayed together on the page
- considered one entity for commenting, recommending, linking, and watching (as social entity)

Styling

By default, the icons for the attachments are shown in grey with a small label and a large icon. By updating the file `MediaWiki:Common.css`, the styles for the attachments can be adjusted as needed. This requires administrator rights.

Add the following styles:

```css
/* Anhänge */
.bs-social-entity-attachment-wrapper {background: transparent;}
.bs-social-entity-content-attachments div.bs-social-entity-attachment-file a span::before {line-height: inherit; font-size: 80px; color: #e12025;}
.bs-social-entity-content-attachments div.bs-social-entityattachment-unknown a span::before {font-family: fontawesome; content: "\f016"; color: #695f5c;}
.bs-social-entity-content-attachments div.bs-social-entityattachment-pdf a span::before {font-family: fontawesome; content: "\f1c1"; color: #695f5c;}
.bs-social-entity-content-attachments div.bs-social-entityattachment-excel a span::before {font-family: fontawesome; content: "\f1c3"; color: #1d8f50;}
.bs-social-entity-content-attachments div.bs-social-entityattachment-pptx a span::before {font-family: fontawesome; content: "\f1c4"; color: #d04727;}
.bs-social-entity-content-attachments div.bs-social-entityattachment-word a span::before {font-family: fontawesome; content: "\f1c2"; color: #1565c0;}
.bs-social-entity-attachment-wrapper p.attachment-name, .bs-social-entity-content-attachments div a p, .bs-social-entity-content-attachments div span p {font-size: 100% !important; word-break: break-word;}
.bs-social-entity-content-attachments div, .bs-social-entity-content-attachments div a, .bs-social-entity-content-attachments div span {color: #444 !important; background-color: #ffffff;}
.bs-social-entity-attachment-wrapper img { border: 5px solid #766d6b;}
.bs-social-entity-content-attachments div a img, .bs-social-entity-content-attachments div span img {height: 80px; width: 75px; margin-top: 16px; margin-bottom: 18px; border-radius: 5px;}
.bs-social-entity-content-attachments div a p, .bs-social-entity-content-attachments div span p {height: 4em}
```

You will get:
Custom css styles for attachments

Related info

- Blog
- Micro-Blog
- Social comments
- User Profile
- Reference:BlueSpiceSocial
The extension **BlueSpiceRating** allows users to rate a page with up to five stars or to recommend the page.

### Contents

1. Rating or recommending a page  ................................................................. 295  
2. Special pages  ............................................................................................. 295  
3. Disabling rating on a page  ......................................................................... 295  
4. Disabling rating in a namespace  ................................................................. 295  
5. Related info  ............................................................................................... 296
Rating or recommending a page

A user simply selects the amount of stars for a rating. The number of stars are then highlighted in yellow during the selection process. A mouse-click confirms the rating.

Only one rating per user is counted. New votes only change the average evaluation, but not the number of ratings.

Users can change their rating at any time by choosing less or more stars. The average evaluation, as well as the number of ratings is shown next to the page title:

To recommend a page, a user clicks on the link "Recommend". To retract the recommendation, the user clicks on the link again.

Special pages

The special page [Special:Rating](Special:Rating) lists all pages that have been rated.

The special page [Special:Recommendations](Special:Recommendations) lists all pages that have been recommended.

Disabling rating on a page

You can also exclude pages from the rating system. You can do this with a so-called "Behaviour Switch". Insert the switch at the bottom of the page in source view: __NORATING__

Disabling rating in a namespace

Administrators can turn on the rating feature for individual namespaces. To enable or disable ratings, go to Global actions > Namespace manager and edit the namespaces:
Namespace manager

<table>
<thead>
<tr>
<th>ID</th>
<th>Namespace</th>
<th>Pages</th>
<th>Subpages</th>
<th>Current</th>
<th>Group/Chat</th>
<th>Secured page assignments</th>
<th>Page template</th>
<th>Visual editor</th>
<th>Rating</th>
<th>Recommended</th>
<th>Icon</th>
<th>Fixed</th>
<th>Confirmation</th>
<th>MediaWiki</th>
<th>Flagged</th>
<th>Box</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Pages</td>
<td>357</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>1</td>
<td>Talk</td>
<td>77</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>2</td>
<td>User</td>
<td>16</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>3</td>
<td>User_talk</td>
<td>6</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Related info

- Reference: BlueSpiceRating
9.6 Track user actions

Each time a page is created or edited in the wiki, this action is automatically documented as a separate page in the SocialEntity namespace. Its purpose is to track all actions on a wiki page and communicate it in various change lists for users to comment on the changes.

Contents

1 Characteristics of SocialEntity pages ................................................................. 298
2 Special pages that list actions on wiki pages .................................................... 298
2.1 User profile ........................................................................................................ 298
2.2 Contributions ..................................................................................................... 298
2.3 Recent changes ................................................................................................. 299
2.4 Special page "Activities" .................................................................................. 300
3 Related info ......................................................................................................... 300
Characteristics of SocialEntity pages

(1) **Numeric page names**: The page names in this namespace are generated as numbers.

(2) **Watchlist**: These pages are automatically placed on the watchlist of the editor. By default, a notification is sent when a comment is created on this page or when another change is made on this SocialEntity page. These notifications can be turned off in the Preferences on the Notifications tab (*Comments on watched entities*).

(3) **Comments**: Other users have the option to comment on the original action. For example, if a user edited a page, another user could comment that the page now looks much better. Adding a comment to the SocialEntity page is sometimes better than adding a discussion topic directly on the edited page to avoid cluttering up the wiki page with casual social comments.

(4) **Page link**: The SocialEntity page has a link that leads to its associated content page.

**Special pages that list actions on wiki pages**

**User profile**

The user profile pages lists the actions of the current user.

**Contributions**

The page *Special:Contributions/*<username>* shows the SocialEntity pages for actions of the user <username>.
The SocialEntity entries start with parentheses describing the type of change, e.g. (Article edit). Hovering over the link shows the numeric page name in the namespace SocialEntity.

**SocialEntities on the Contributions page**

**These pages can be filtered out by setting the filter to:**
- Namespace:SocialEntity
- Invert selection

After clicking *Search*, the page returns the contributions of the user without social entities.

**Filtering SocialEntity pages**

**Recent changes**

The page *Special:RecentChanges* (classic view) by default filters out SocialEntity pages. The filter can be deactivated on the page.
Special page "Activities"

The page Special:Activities shows a list of all page actions in the wiki. The filter can be adjusted as needed. Using the timeline tag, the (custom) filtered list can be embedded in any wiki page.

Related info

- Blog
- Discussions and Attachments
- Discussion topics
- Social comments
- User Profile
- Reference:BlueSpiceSocial
10 Search

ExtendedSearch replaces the default MediaWiki search engine. It is based on the Elasticsearch engine and provides many improvements over standard MediaWiki search both in terms of quality of indexed content and user interface. Pages and files are indexed immediately and available for searching in real-time.

## Contents

1 Usage ........................................................................................................................................... 312
2 Autocomplete ................................................................................................................................... 312
  2.1 Namespace and subpage "pills" .......................................................................................... 313
  2.2 Configuration ....................................................................................................................... 313
  2.3 Search operators ................................................................................................................... 313
  2.4 Dates as search terms ............................................................................................................ 314
3 Search Center (extended search) .......................................................................................... 314
  3.1 Search operators ................................................................................................................... 315
  3.2 Elements .................................................................................................................................. 315
    3.2.1 Results relevance ............................................................................................................ 317
    3.2.2 Exporting search results ................................................................................................ 317
4 Configuration .......................................................................................................................... 318
5 SearchAdmin ............................................................................................................................. 319
6 Related info ............................................................................................................................... 320
Usage

Extended search offers two ways of searching for content:

1. **Title search** using the quick search
2. **Fulltext search** using the search center

By default, the search indexes:

- wiki pages: all content pages, except for pages in the MediaWiki namespace
- special pages: all pages in the namespace `Special`
- repo files: files uploaded to the wiki - for text files like Word documents and PDFs, this includes content and metadata
- external files: files from arbitrary locations from accessible storage paths (e.g., mounted drives)
- social entities: entities (pages) created by the BlueSpiceSocial extension, like blog posts and user profiles

**Autocomplete**

The search box in the main toolbar offers with autocomplete functionality is available from any page on the wiki. Autocomplete matches only page and file titles, but does not provide a full-text search.

After typing in the search bar, an autocomplete popup appears:

![Autocomplete popup](image)

This popup is divided in two columns.

- **Left column:**
  - **Primary results:** These are the results that are direct matches for the search term. The exact matches are shown in bold letters.
- When looking for the term "quality management", it is also possible to type in "qual man" and the search starts looking for matches
- The best match is often shown with a thumbnail preview as a top search result

**Right column:**

- **Tools and secondary results:** Tools are displayed in the top portion of the right column and contain:
  - a button to create the page with the current search term as the title (only if user has permission to create new pages)
  - a button to execute full-text search for the current term. Selecting this option leads to the Search Center.

In the bottom portion of the right column, secondary results are displayed. Secondary results are matches that do not directly match the given term, but might be relevant for the user. These show up only in certain contexts:

- If there are significantly more matches for a similar term than the term actually searched for (in a situation of a typo for example)
- If the namespace or subpage pill is present (see next section). In this case, secondary results will show direct matches in other namespaces/pages.

**Namespace and subpage "pills"**

Autocomplete search bar supports pills for namespaces and subpages.

![Namespace "pill"](image)

If a user types `Manual:` , a pill for the namespace "Manual" appears and the search for the following term is limited to this namespace. Subpage pills work in the same way. If the user types in `PageName/`, any term after that is matched in the context of that page. If you search for "TestPage/Te", for example, the search will match only subpages of "TestPage" that contain "Te" in the title, like "TestPage/Test" and "TestPage/TestSubpage".

**Configuration**

Previously explained is the full version of the autocomplete popup. Wiki admins can also choose to use "Simple autocomplete", which contains only one column with primary results and tools, without secondary results. This type of autocomplete is also more compact. This setting is available from BlueSpiceConfigManager, under Extension > BlueSpiceExtendedSearch > Use simple autocomplete.

**Search operators**

Since the autocomplete search only searches for titles, search operators such as AND or OR are not supported. However, they are supported using the Search Center.
Dates as search terms

The search recognizes certain date formats. In the search center, these date formats are treated with surrounding quotation marks.

Date format 1

Date format 2

Search Center (extended search)

As soon as you trigger the full-search with the magnifying glass symbol or the Enter key, the wiki switches to the Search Center. This is a special page that offers the full functionality of the search. The search in the Search Center is carried out using the same search bar that is also used for autocomplete.

Here, the search engine carries out a full text search, which also includes the metadata of documents. It does not index the wikitext of a wiki page, but rather the rendered content, that is the output by the browser.
Search operators

To use search operators in the full-text search, the following syntax can be used:

- **Sandbox AND Widgets** - returns pages that contain both the term sandbox and the term widgets
- **Sandbox OR Widgets** - returns pages that contain either the term sandbox or the term widgets.
- **(Sandbox) NOT (Widgets)** - returns pages that contain the term sandbox but not the term widgets.

The search operators have to be written in uppercase letters.

Elements

- **Hit count** - shows how many matches a search has returned. It may be exact or approximate. Approximation is due to dynamic check for permissions to view each page in the results, some results may not be shown to the user with no adequate permissions event if it matches the search term.

- **Tools** - these are located in the top right as a set of buttons:
  - Create a page - represented by a “plus” button - will create a page with current search term as a title (only visible if user has permission to create pages)
  - Add filters - represented by a “funnel” icon - opens a dialog where users can select the type of filter to apply to the search.
Adding filters

- Search options - represented by a "gear" icon - opens a dialog where users can change settings for the current search. It provides options like the number of results per page, sorting field and order.

- Export search - represented by the "export" icon - opens a dialog to export current search results to a dedicated page (only visible to authorized users, by default admin users).

- **Filter**: Filters are displayed in form of pills below the results counter. Each filter pill represents a different attribute. Filter values can be changed by clicking on the filter pill and selecting the desired options from the popup that will open. Filter can be removed by clicking on the "x" button in each pill.
• **Results:** If current search criteria yield any results, a list of results is displayed. The information available in the results is depending on the result type):
  ○ Main title of the result (page title, file name...)
  ○ Result type
  ○ Size and extension (for files)
  ○ Thumb image (for images) or file type icon (for other file types)
  ○ Redirect information
  ○ Original name (for wikipages, if the page display title is different than the actual page title)
  ○ Secondary information like page categories, modification and creation date, author, etc.
  ○ Snippet of the matches in the content of the page (if there are matches in the page content),
  ○ Sections with matches in the content (for wikipages)

In case there is an exact match for a given search term, the result that matches exactly is displayed as a "featured" result. Such a result displays a preview image of the page and always displays the content snippet, regardless of whether there are matches in the content or not.

**Results relevance**

All logged-in users can mark certain results as "favorites" by clicking on the star symbol in the right corner of each result. Files marked as "favorite" will score higher in future searches - this is not visible immediately, however, but happens over time. One user's relevance settings won't affect other user's searches. Results can be unmarked as "favorite" by clicking on the "star" symbol again.

**Exporting search results**

After executing the search, administrators can export (save) the results to a specific page using the "Export" command from the "Tools" menu. The list is exported to MediaWiki:PageCollection LISTENNAME.
Only valid wikipages are exported. The pages contained in a list can be included in a book in the book function via Mass add > Source: Page collection.

Configuration

In the BlueSpiceConfigManager, under settings for the extension BlueSpiceExtendedSearch, the following configuration options are available:

- **External file paths**: External locations to scan for and index files from. These locations are entered in key/value pairs of Physical path and URL prefix.
  - **Physical path**: Storage path. For mounted drives, for example: `X:\Documents`
  - **URL prefix**: All files indexed from the indexed physical location are prefixed in the search results. It should be used if files are available from a web server. By default, the URL prefix is set to the same value as Physical path.

### Examples for external file paths

<table>
<thead>
<tr>
<th>Example file</th>
<th>Phys. Path</th>
<th>URL Prefix</th>
<th>Link in results list</th>
</tr>
</thead>
<tbody>
<tr>
<td>S:\Sales\Info\glossary.pdf</td>
<td>S:\</td>
<td>file:///S:/</td>
<td>file:///S/Sales/Info/glossary.pdf</td>
</tr>
<tr>
<td>URL Prefix</td>
<td>Link in results list</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>----------------------</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Use simple autocomplete:** forces a more compact autocomplete (1-column Sales thumbnail preview).

- **Automatically set language filter:** This setting applies to multi-language. It returns search results for a user only in the user's language. Users can set their language in their preferences.

- **Exclude patterns:** Files at external file locations can be excluded from search based on regular expression patterns.

---

**SearchAdmin**

*Special:SearchAdmin* is a special page for wiki admins. This page provides stats on documents indexed in the search.
Related info

- Reference:BlueSpiceExtendedSearch
10.1 Extended search

ExtendedSearch replaces the default MediaWiki search engine. It is based on the Elasticsearch engine and provides many improvements over standard MediaWiki search both in terms of quality of indexed content and user interface. Pages and files are indexed immediately and available for searching in real-time.

Contents

1 Usage ............................................................................................................................................ 312
2 Autocomplete ................................................................................................................................ 312
  2.1 Namespace and subpage "pills" ................................................................................................ 313
  2.2 Configuration ............................................................................................................................ 313
  2.3 Search operators ....................................................................................................................... 313
  2.4 Dates as search terms ................................................................................................................ 314
3 Search Center (extended search) ..................................................................................................... 314
  3.1 Search operators ....................................................................................................................... 315
  3.2 Elements .................................................................................................................................... 315
    3.2.1 Results relevance .................................................................................................................. 317
    3.2.2 Exporting search results ..................................................................................................... 317
4 Configuration .................................................................................................................................. 318
5 SearchAdmin .................................................................................................................................. 319
6 Related info .................................................................................................................................... 320
Usage

Extended search offers two ways of searching for content:

1. **Title search** using the quick search
2. **Fulltext search** using the search center

By default, the search indexes:

- wiki pages: all content pages, except for pages in the MediaWiki namespace
- special pages: all pages in the namespace *Special*
- repo files: files uploaded to the wiki - for text files like Word documents and PDFs, this includes content and metadata
- external files: files from arbitrary locations from accessible storage paths (e.g., mounted drives)
- social entities: entities (pages) created by the BlueSpiceSocial extension, like blog posts and user profiles

Autocomplete

The search box in the main toolbar offers with autocomplete functionality is available from any page on the wiki. Autocomplete matches only page and file titles, but does not provide a full-text search.

After typing in the search bar, an autocomplete popup appears:

This popup is divided in two columns.

**Left column:**

- **Primary results:** These are the results that are direct matches for the search term. The exact matches are shown in bold letters.
When looking for the term "quality management", it is also possible to type in "qual man" and the search starts looking for matches.

The best match is often shown with a thumbnail preview as a top search result.

Right column:

Tools and secondary results: Tools are displayed in the top portion of the right column and contain:
- a button to create the page with the current search term as the title (only if user has permission to create new pages)
- a button to execute full-text search for the current term. Selecting this option leads to the Search Center.

In the bottom portion of the right column, secondary results are displayed. Secondary results are matches that do not directly match the given term, but might be relevant for the user. These show up only in certain contexts:

- If there are significantly more matches for a similar term than the term actually searched for (in a situation of a typo for example)
- If the namespace or subpage pill is present (see next section). In this case, secondary results will show direct matches in other namespaces/pages.

Namespace and subpage "pills"

Autocomplete search bar supports pills for namespaces and subpages.

If a user types _Manual:, a pill for the namespace "Manual" appears and the search for the following term is limited to this namespace. Subpage pills work in the same way. If the user types in _PageName/, any term after that is matched in the context of that page. If you search for "TestPage/Te", for example, the search will match only subpages of "TestPage" that contain "Te" in the title, like "TestPage/Test" and "TestPage/TestSubpage".

Configuration

Previously explained is the full version of the autocomplete popup. Wiki admins can also choose to use "Simple autocomplete", which contains only one column with primary results and tools, without secondary results. This type of autocomplete is also more compact. This setting is available from BlueSpiceConfigManager, under Extension > BlueSpiceExtendedSearch > Use simple autocomplete.

Search operators

Since the autocomplete search only searches for titles, search operators such as AND or OR are not supported. However, they are supported using the Search Center.
**Dates as search terms**

The search recognizes certain date formats. In the search center, these date formats are treated with surrounding quotation marks.

**Date format 1**

**Date format 2**

**Search Center (extended search)**

As soon as you trigger the full-search with the magnifying glass symbol or the *Enter* key, the wiki switches to the Search Center. This is a special page that offers the full functionality of the search. The search in the Search Center is carried out using the same search bar that is also used for autocomplete.

Here, the search engine carries out a full text search, which also includes the metadata of documents. It does not index the wikitext of a wiki page, but rather the rendered content, that is the output by the browser.
Search operators

To use search operators in the full-text search, the following syntax can be used:

- Sandbox **AND** Widgets - returns pages that contain both the term sandbox and the term widgets
- Sandbox **OR** Widgets - returns pages that contain either the term sandbox or the term widgets.
- (Sandbox) **NOT** (Widgets) - returns pages that contain the term sandbox but not the term widgets.

The search operators have to be written in uppercase letters.

Elements

- **Hit count** - shows how many matches a search has returned. It may be exact or approximate. Approximation is due to dynamic check for permissions to view each page in the results, some results may not be shown to the user with no adequate permissions event if it matches the search term.
- **Tools** - these are located in the top right as a set of buttons:
  - Create a page - represented by a "plus" button - will create a page with current search term as a title (only visible if user has permission to create pages)
  - Add filters - represented by a "funnel" icon - opens a dialog where users can select the type of filter to apply to the search.
Adding filters

- **Search options** - represented by a "gear" icon - opens a dialog where users can change settings for the current search. It provides options like the number of results per page, sorting field and order.

- **Export search** - represented by the "export" icon - opens a dialog to export current search results to a dedicated page (only visible to authorized users, by default admin users).

- **Filter**: Filters are displayed in form of pills below the results counter. Each filter pill represents a different attribute. Filter values can be changed by clicking on the filter pill and selecting the desired options from the popup that will open. Filter can be removed by clicking on the "x" button in each pill.
• **Results**: If current search criteria yield any results, a list of results is displayed. The information available in the results is depending on the result type):
  ○ Main title of the result (page title, file name...)
  ○ Result type
  ○ Size and extension (for files)
  ○ Thumb image (for images) or file type icon (for other file types)
  ○ Redirect information
  ○ Original name (for wikispages, if the page display title is different than the actual page title)
  ○ Secondary information like page categories, modification and creation date, author, etc.
  ○ Snippet of the matches in the content of the page (if there are matches in the page content),
  ○ Sections with matches in the content (for wikispages)

In case there is an exact match for a given search term, the result that matches exactly is displayed as a "featured" result. Such a result displays a preview image of the page and always displays the content snippet, regardless of whether there are matches in the content or not.

**Results relevance**

All logged-in users can mark certain results as "favorites" by clicking on the star symbol in the right corner of each result. Files marked as "favorite" will score higher in future searches - this is not visible immediately, however, but happens over time. One user's relevance settings won't affect other user's searches. Results can be unmarked as "favorite" by clicking on the "star" symbol again.

**Exporting search results**

After executing the search, administrators can export (save) the results to a specific page using the "Export" command from the "Tools" menu. The list is exported to `MediaWiki:PageCollection /LISTENNAME`. 
Only valid wikipages are exported. The pages contained in a list can be included in a book in the book function via Mass add> Source: Page collection.

### Configuration

In the BlueSpiceConfigManager, under settings for the extension BlueSpiceExtendedSearch, the following configuration options are available:

- **External file paths**: External locations to scan for and index files from. These locations are entered in key/value pairs of Physical path and URL prefix.
  - **Physical path**: Storage path. For mounted drives, for example: `X:\Documents`
  - **URL prefix**: All files indexed from the indexed physical location are prefixed in the search results. It should be used if files are available from a web server. By default, the URL prefix is set to the same value as **Physical path**.

#### Examples for external file paths

<table>
<thead>
<tr>
<th>Example file</th>
<th>Phys. Path</th>
<th>URL Prefix</th>
<th>Link in results list</th>
</tr>
</thead>
<tbody>
<tr>
<td>S:\Sales\Info\glossary.pdf</td>
<td>S:\</td>
<td>file:///S:/</td>
<td>file:///S/Sales/Info/glossary.pdf</td>
</tr>
</tbody>
</table>
**Use simple autocomplete:** forces a more compact autocomplete (1-column Sales thumbnail preview).

**Automatically set language filter:** This setting applies to multi-languageSalest it returns sear ch results for a user only in the user’s language. Users can set their language in their preferences.

**Exclude patterns:** Files at external file locations can be excluded from search based on regular expression patterns.

**SearchAdmin**

*Special:SearchAdmin* is a special page for wiki admins. This page provides stats on documents indexed in the search.
Related info

- Reference:BlueSpiceExtendedSearch
10.2 Inline search

**TagSearch** allows the integration of a configurable search field in content pages. This search field relies on **BlueSpiceExtendedSearch**.

### Inserting the tag

The tag `<bs:tagsearch />` can be inserted and configured directly in visual editing mode.

Go to **Insert > Magic word** in the **VisualEditor** menu. Select tagsearch from the dialog and click done. This opens the configuration options dialog on the page.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Display name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>placeholder</td>
<td>Placeholder</td>
<td>Text to be shown in the search field when nothing is typed in</td>
</tr>
<tr>
<td>Type</td>
<td></td>
<td>List of types of search entities to search. By default search entities availble are: wikipage, specialpages, repofile (internal files), externalfile, socialentity. Multiple values can be entered separated by pipe (</td>
</tr>
<tr>
<td>Parameter</td>
<td>Display name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>type</td>
<td>Type</td>
<td><strong>Note:</strong> If a particular namespace is selected, then type &quot;repofile&quot; returns uploaded files that have the associated namespace prefix.</td>
</tr>
<tr>
<td>namespace</td>
<td>Namespace(s)</td>
<td>List of namespaces in which to search. Namespaces can be entered by using their IDs or names, separated by a pipe (</td>
</tr>
<tr>
<td>category</td>
<td>Category(ies)</td>
<td>List of categories in which to search. Multiple categories must be separated by a pipe (</td>
</tr>
<tr>
<td>operator</td>
<td>Search operator</td>
<td>Applies only to categories. Operator &quot;AND&quot; will only find results that are in all of the given categories, while operator &quot;OR&quot; will show results in any of the given categories.</td>
</tr>
</tbody>
</table>

Multiple tags can be added to a single page using the same or different configurations.

**Using the search field**

Once the page is saved, the code for the search field is inserted in the page source where it was inserted.

**Example:**

```xml
<bs:tagsearch type="wikipage" operator="AND" namespace=" |Template" category="Editing" />
```

The search is looking for wiki pages in the namespaces (Main) and Template that belong to the category Editing.

Clicking on search icon to the left or pressing Return loads the full-text search in the Search-Center.
Related info

- Reference:BlueSpiceTagSearch
11 Appendix A: Extensions

This is a list of the BlueSpice extensions that are referenced in this User manual. For a complete list of extensions, visit the software catalogue:

- BlueSpiceArticleInfo
- BlueSpiceBookshelf
- BlueSpiceCategoryCheck
- BlueSpiceConfigManager
- BlueSpiceExpiry
- BlueSpiceExtendedSearch
- BlueSpiceGroupManager
- BlueSpiceHideTitle
- BlueSpiceInsertLink
- BlueSpiceInterWikiLinks
- BlueSpiceInterWikiLinks (Admin)
- BlueSpiceNamespaceManager
- BlueSpicePageAssignments
- BlueSpicePageTemplates
- BlueSpicePageTemplates (Admin)
- BlueSpicePermissionManager
- BlueSpicePrivacy
- BlueSpiceQrCode
- BlueSpiceRating
- BlueSpiceReadConfirmation
- BlueSpiceReminder
- BlueSpiceSignHere
- BlueSpiceSocial
- BlueSpiceSocialArticleActions
- BlueSpiceSocialBlog
- BlueSpiceSocialMicroBlog
- BlueSpiceSocialProfile
- BlueSpiceSocialWikiPage
- BlueSpiceTagCloud
- BlueSpiceTagSearch
- BlueSpiceUniversalExport
- BlueSpiceUserManager
- BlueSpiceUserSidebar
- BlueSpiceVisualDiff
- BlueSpiceWatchList
- BlueSpiceWikiExplorer
- BookshelfUI
- DrawioEditor
- EmbedVideo
- FlaggedRevisions
- FlaggedRevs
- InterWikiLinks2
- Player
# 12 Appendix B: Tags

This is a list of BlueSpice parser functions. Some of these tags can be inserted using VisualEditor. Go to *Insert > Magic words* and select the magic word you want to use. If you don't see the tag listed, switch to source editing mode and manually insert the tag there. You can always find the list of all parser tags (both MediaWiki and BlueSpice) in your BlueSpice installation on the page *Special:Version*, in the section *Parser Extension Tags*.

## Contents

<table>
<thead>
<tr>
<th>Tag</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>activitystream</td>
<td>327</td>
</tr>
<tr>
<td>booklist</td>
<td>327</td>
</tr>
<tr>
<td>bookmeta</td>
<td>327</td>
</tr>
<tr>
<td>bookshelf</td>
<td>327</td>
</tr>
<tr>
<td>checklist</td>
<td>327</td>
</tr>
<tr>
<td>countarticles</td>
<td>327</td>
</tr>
<tr>
<td>countcharacters</td>
<td>328</td>
</tr>
<tr>
<td>countfiles</td>
<td>328</td>
</tr>
<tr>
<td>countusers</td>
<td>328</td>
</tr>
<tr>
<td>drawio</td>
<td>328</td>
</tr>
<tr>
<td>newbies</td>
<td>328</td>
</tr>
<tr>
<td>pageaccess</td>
<td>328</td>
</tr>
<tr>
<td>pagesvisited</td>
<td>328</td>
</tr>
<tr>
<td>pagetemplates</td>
<td>329</td>
</tr>
<tr>
<td>pdfpagebreak</td>
<td>329</td>
</tr>
<tr>
<td>profileimage</td>
<td>329</td>
</tr>
<tr>
<td>showtime</td>
<td>329</td>
</tr>
<tr>
<td>signhere</td>
<td>329</td>
</tr>
<tr>
<td>smartlist</td>
<td>329</td>
</tr>
<tr>
<td>tagcloud</td>
<td>329</td>
</tr>
<tr>
<td>tagsearch</td>
<td>330</td>
</tr>
<tr>
<td>timeline</td>
<td>330</td>
</tr>
<tr>
<td>toplist</td>
<td>330</td>
</tr>
<tr>
<td>universalexportexcludearticle</td>
<td>330</td>
</tr>
<tr>
<td>universalexporthidetitle</td>
<td>330</td>
</tr>
<tr>
<td>universalexportmeta</td>
<td>330</td>
</tr>
<tr>
<td>universalexportnoexport</td>
<td>330</td>
</tr>
<tr>
<td>universalexportpagebreak</td>
<td>331</td>
</tr>
<tr>
<td>universalexportparams</td>
<td>331</td>
</tr>
<tr>
<td>watchlist</td>
<td>331</td>
</tr>
<tr>
<td>whoisonlinecount</td>
<td>331</td>
</tr>
<tr>
<td>whoisonlinepopup</td>
<td>331</td>
</tr>
<tr>
<td>Related info</td>
<td>331</td>
</tr>
</tbody>
</table>
activitystream

**Description:** Generates lists of recently changed social entities of a user, such as comments or blog entries.

**Example:** `<bs:activitystream user="WikiSysop" />`  

booklist

**Description:** Generates lists of articles from the namespace "book" and can be filtered. The indication of the filter ist mandatory.

**Example:** `<bs:booklist filter="title:handbook|responsible:Testuser" />`  

**Extension:** BlueSpiceBookshelf

bookmeta

**Description:** Tag for saving various meta data on book articles. These are included in the book. The attributes of this tag have to correlate with the meta data of the book article.

**Example:** `<bs:bookmetatitle="Installation manual"subtitle="BlueSpice pro" author1="Hallo Welt!" version="1.0" />`  

**Extension:** BlueSpiceBookshelf

bookshelf

**Description:** Inserts the chapter navigation of a book in a page that is not part of a book. Numbering is automatically created according to the table of contents.

**Example:** `<bs:bookshelf src="Book:Installation manual" width="200" height="100" float="left" />`  

**Extension:** BlueSpiceBookshelf

checklist

**Description:** Generates a checkbox or a select menu. The checklist can be modified by various parameters.

**Example:** `<bs:checklist type="list" value="false" list="Status" /><option>-</option><option>-</option></select>`  

**Extension:** BlueSpiceChecklist

countarticles

**Description:** Displays the number of articles in the wiki.

**Example:** `<bs:countarticles />`  

**Extension:** BlueSpiceCountThings
**countcharacters**

**Description:** Generates metadata about the number of characters, words or number of printed pages for the page.

**Example:** `<bs:countcharacters mode="chars">ARTICLENAME</bs:countcharacters>`

**Extension:** BlueSpiceCountThings

**countfiles**

**Description:** Shows the number of all uploaded files

**Example:** `<bs:countfiles />`

**Extension:** BlueSpiceCountThings

**countusers**

**Description:** Shows the number of registered users.

**Example:** `<bs:countusers />`

**Extension:** BlueSpiceCountThings

**drawio**

**Description:** Inserts the draw.io flow chart editor and allows inline editing of charts and diagrams.

**Example:** `<bs:drawio name="Diagram.png" />`

**Extension:** DrawioEditor

**newbies**

**Description:** Shows the new users of the wiki. The list can be restricted to a certain number.

**Example:** `<bs:newbies count="3" />`

**Extension:** BlueSpiceSmartList

**pageaccess**

**Description:** Defines the groups which have exclusive access to a page. Several groups are separated by commas.

**Example:** `<bs:pageaccess groups="sysop"/>`

**Extension:** BlueSpicePageAccess

**pagesvisited**

**Description:** Shows a list of recently visited pages. This list can be restricted by parameters.

**Example:** `<bs:pagesvisited count="7" maxtitlelength="40" />`

**Extension:** BlueSpicePagesVisited
**pagetemplates**

**Description:** Shows a list of the wiki's page templates.
**Example:** `<bs:pagetemplates />`
**Extension:** BlueSpicePageTemplates

**pdfpagebreak**

**Description:** Inserts a page break when the page is exported to PDF.
**Example:** `<bs:pdfpagebreak />`

**profileimage**

**Description:** Inserts the profile picture of the user on a page.
**Example:** `<bs:profileimage username="WikiSysop" />`
**Extension:** BlueSpiceAvatars

**showtime**

**Description:** Embeds a video that was uploaded to the wiki on a wiki page.
**Example:** `<bs:showtime width="960" height="760">myvideo.mp4</bs:showtime>`
**Extension:** BlueSpicePlayer

**signhere**

**Description:** Embeds a visual signature function on a regular wiki page.
**Tag:** `<bs:signhere />`
**Extension:** BlueSpiceSignHere

**smartlist**

**Description:** Shows a list of pages. The configuration works through several modi and parameters.
**Example:** `<bs:smartlist mode="whatlinkshere" traget="ARTICLENAME" />`
**Extension:** BlueSpiceSmartList

**tagcloud**

**Description:** Shows a tag cloud on a page.
**Example:** `<bs:tagcloud count="10" minsize="12" maxsize="34" exclude="Imported vocabulary, Project" />`
**Extension:** BlueSpiceTagCloud
tagsearch

**Description:** This function integrates the search form in an article. Search can be configured by parameters.
**Example:** `<bs:tagsearch cat="Help" ns="BlueSpice" operator="OR" />`
**Extension:** BlueSpiceTagSearch

timeline

**Description:** Shows a list of latest social contributions, such as discussion topics, blog entries, or user profile changes.
**Example:** `<bs:toplist count="4" cat="Wiki" period="month" />`
**Extension:** BlueSpiceSocial

toplist

**Description:** Shows the most visited pages. Can be limited by several parameters.
**Example:** `<bs:toplist count="4" cat="Wiki" period="month" />`
**Extension:** BlueSpiceSmartList

universalexportexcludearticle

**Description:** Excludes an article from a PDF export.
**Example:** `<bs:ueexcludearticle" />
**Extension:** BlueSpiceUniversalExport

universalexporthidetitle

**Description:** Allows to add arbitrary meta data to an exported document.
**Example:** `<bs:uemeta department="IT" security="high" />`
**Extension:** BlueSpiceUniversalExport

universalexportmeta

**Description:** Allows to add arbitrary meta data to an exported document.
**Example:** `<bs:uemeta department="IT" security="high" />`
**Extension:** BlueSpiceUniversalExport

universalexportnoexport

**Description:** Content inside this tag will not be exported.
**Example:** `<bs:uenoexport>Not included in export</bs:uenoexport>`
**Extension:** BlueSpiceUniversalExport
**universalexportpagebreak**

**Description:** If supported by chosen export module, this tag forces a page break in the export document.

**Tag:** `<bs:uepagebreak />`

**Extension:** BlueSpiceUniversalExport

**universalexportparams**

**Description:** Allows to set special parameters for export, whether the parameter will be evaluated depends on the chosen export module.

**Example:** `<bs:ueparams template="BlueSpice Landscape" />`

**Extension:** UniversalExport

**watchlist**

**Description:** Shows the articles which have most recent changes and are on your watchlist.

**Tag:** `<bs:watchlist />`

**Extension:** BlueSpiceWatchList

**whoisonlinecount**

**Description:** Shows the number of users who have logged in within the last 10 minutes.

**Example:** `<bs:whoisonlinecount />`

**Extension:** BlueSpiceWhoIsOnline

**whoisonlinepopup**

**Description:** Shows all users who have been logged in within the last 10 minutes. The output is a speech bubble when a user hovers over the related link.

**Example:** `<bs:whoisonlinepopup anchortext="Online users" />`

**Extension:** BlueSpiceWhoIsOnline

**Related info**

- [mediawiki.org/wiki/Help:Magic_words](http://mediawiki.org/wiki/Help:Magic_words)